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Introduction

Introduction

Thank you for purchasing the YSI 5400. The YSI 5400 is a fully programmable aquatic
control monitor with alarming capability. A key feature of the 5400 monitor is the
ability to independently operate four dissolved oxygen (DO) inputs and six auxiliary
(Aux) inputs. This allows control of multiple water systems from one 5400 control-
ler. Peripheral devices wired to the 5400 respond to user-defined configurations to
ensure that stable water conditions are maintained. The 5400’s on-site and remote
access capability are suitable for a variety of applications.

5400 features:

- four (4) independent DO systems

- six (6) independent Aux I/O systems - (digital, analog (0-1VDC, 0-5VDC,
4-20mA, and/or temperature )

- eight (8) onboard relays - 240VAC@5AMPs; 110VAC@10AMPs

- universal AC power with power fail alarm (only available on AC instru-
ments)

- optional DC power with low battery alarm

- four (4) ten event daily timers

- four (4) feed timers

- two (2) 32-bit processors

- non-volatile memory of sensor, event, and calibration data logs

- 1000 data set memory for sensor data

- field upgradable software and firmware

- backlit LCD with timer function - input and output data displayed continu-
ously

- menu-driven programming with four (4) softkeys

- networking capability - connect up to (32) 5400s and/or 5200As on one net-
work via RS485 protocol

- optional AquaManager® PC software* serves as monitor management tool via
direct (RS232) or TCP/IP connection

- email alarming via TCP/IP or local AquaManager connection

- NEMA 4X, IP65 enclosure

See Product Specifications this chapter for complete details on all 5400 features.
*AquaManager displays real time data from monitors and provides data logging,

graphing, autopolling, mapping, and system configuration control from a PC.
AquaManager is a valuable tool for remote and local access applications.

YSI 5400
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Product Description

The 5400 system manages aquatic environments by automating control and alarm
devices to maintain stable water conditions.

A 5400 system is configurable by the user; therefore, each system setup is unique to
the application. An example of a 5400 system could include*:

- 5400 instrument(s)

- 5400 components such as power, communication, and network devices
- input peripheral devices (i.e. float switch, probe assembly)

- output peripheral devices (i.e. aerator)

- 5400 user-defined configuration

- AquaManager PC interface (optional)

*All of the items listed are not included with the purchase of a 5400 instrument.

Input devices send data to the 5400. This data is processed based on the 5400 con-
figuration. For example, a DO sensor (input) reports a 5.4 mg/L value and relay #3
(output) is configured to activate an aerator when value is < 5.5 mg/L. The aerator
wired to relay #3 will energize until the 5400 receives a DO sensor reading > set
point value.

Figure 1.1 shows the 5400 front panel and enclosure. The front panel includes an
LCD which continuously displays current system conditions. Front Panel Keys are
used to navigate screens and program configurations. Compression fittings located
at the bottom of the enclosure provide liquid-tight connections for wiring peripheral
devices and 5400 components.

YSI 5400
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@ This icon is used throughout the manual to indicate helpful information for Aqua-
Manager users.

Chapter 6 “Maintenance” provides information on maintaining the 5400 system
including monitor and sensor service.

“Notes” at the end of each manual section provide additional information to help
clarify certain 5400 operations and features.

The appendices include Unpacking & Inspection, Troubleshooting, Menu Maps,
Declaration of Conformity, Warranty information, and SMS Messaging.

An index is provided starting on page 218.

Product Specifications

To ensure accurate and reliable performance, operate the 5400 system according
to the specifications provided in the following tables. Damage and/or incorrect
operation could result if these specifications are not followed.

Figure 1.1
Product specifications are subject to change without notice. Visit www.ysi.com to

view the most recent product specifications.

Preview of User Manual
Environmental Specifications

This manual includes information on installing, configuring, operating, and main-
taining a 5400 system.

Environmental Category Operating Range
Read Chapter 2 “Safety Information” before installing or configuring a 5400 sys- Temperature 1510 70°C (5 to 158°F)
tem. Enclosure Rating NEMA 4X (direct exposure to outside conditions) IP65
Chapter 3 “Installation” provides information on how to install the 5400, 5400 com- Compression Fitting Rating | IP 68/NEMA 6 (liquid tight)
ponents, and peripheral devices. Only qualified people should install a 5400 system. Electrical Safety IEC compliant*
Do not attempt to install or configure this device if you are not qualified to do so. Other RoHS compliant
If information is not clear, DO NOT PROCEED until clarification can be obtained.
All wiring involving connections to main power must be performed by a qualified *See Appendix 4 Declaration of Conformity - page 208.

licensed electrician and must conform to all locally applicable electrical codes.

Chapter 4 “Configuring 5400 Systems” provides information on configuring 5400
instruments.

Chapter 5 “AquaManager” provides general information regarding the PC software
program. The AquaManager program includes an extensive on-line help system
which contains detailed information that is not provided in this manual.

YSI 5400 YSI5400
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Input System Specifications

Aux Systems

There are 6 Aux input systems that allow digital or analog (0-
1.0VDC, 0-5.0VDC, or 4-20mA) configuration. In addition, four
of the Aux systems can be configured as temperature systems see
Temperature Systems - page 15.

Flow require-
ments

minimum flow rate of 3 inches 6 inches per second or 15.24
per second or 7.62 cm/second for | cm/second for 2.0 mil Teflon
2.0 mil PE membrane; 6 inches membrane

per second or 15.24 cm/second
for 2.0 mil Teflon membrane

Aux System Type | Digital Analog
Range dry contact open/close | 0-1.0 VDC, 0-5.0 VDC, or 4-20mA
Accuracy n/a 0-1.0VDC: £3% £ 10 mV
0-5.0VDC: £3% 15 mV
4-20 mA: + 3% +100pA
Resolution n/a user selectable (0), (0 .0), or (0.00)
DO Systems There are 4 independent DO systems. Each DO system has 2 con-

trol Pranges, 2 control\ ranges, and high and low alarming.

Sensor Type

Polarographic (mA)

Galvanic (mV)

Other manual salinity compensation for | manual salinity compensation
DO mg/L readings for DO mg/L readings

Temperature | Thereare 4 independent temperature systems. Auxiliary inputs 3, 4,

Systems 5, & 6 can be configured as temperature systems. Each temperature
system has 1 control Mrange, 1 control \ range, and high and low
alarming. Temperature systems can be configured as the tempera-
ture source for DO measurements or as stand alone systems.

Sensor type 10,000 ohm @ 25°C thermistor

Range 0-45°C; 32-113°F

Accuracy +0.2°C

Resolution 0.1°C

Membrane Type

Teflon (TE), 2 mil (gray)
Polyethylene (PE), 2 mil (blue)

Teflon (TE), 2 mil (gray)

Component and System (non input) Specifications

0.01 mg/L (0-10 mg/L); 0.1 mg/L
(10-60 mg/L)

Range 0 to 500% air saturation 0 to 500% air saturation
0 to 60 mg/L 0 to 60 mg/L
Accuracy +2% or + 0.2 mg/L, whicheveris | £2% or + 0.2 mg/L, whichever
greater for 0-200% is greater for 0-200%
+6% of reading for 200-500% +6% of reading for 200-500%
Resolution 0.1% (0.0-99.9%); 1% (> 99.9) 0.1% (0.0-99.9%); 1% (> 99.9)

0.01 mg/L (0-10 mg/L); 0.1
mg/L (10-60 mg/L)

Response Time

95% of reading in 17 seconds for
2.0 mil PE membrane;

95% of reading in 36 seconds for
2.0 mil Teflon membrane.

Allow approximately 10-15
minutes after 5400 is powered on,
or after the DO sensor is serviced,
for the polarographic sensor to
stabilize.

95% of reading in 36 seconds
for 2.0 mil Teflon membrane.

Hardware

System | System Feature | Specification

Display/LEDs backlit graphic LCD (320X240) | readings updated 2 times a
with timer second
diagnostic troubleshooting
LEDs

Outputs 8 on-board relays 240VAC@ 5AMPs switching

capacity; 110VAC@10AMPS;
type: SPDT

Timer Systems

4 timers

10 daily events per timer system

Cable lengths

4,10, 20 m (special order up to
100m)

4,10, 20 m (special order up to
100m)

4 feed timers

includes sensor & FCR control

YSI 5400
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Component and System (non input) Specifications continued

Instrument to Instrument Networking

Feature

Specification

Network 2 to 32 isolated 5400
and/or 5200A instruments

RS485 up to 4000 ft (1220m)
entire network distance

AquaManager

Feature

Other PC Requirements

Runs on Windows 2000/XP/
Vista/Windows 7 operating
systems

PC capable of running Windows
2000
VGA display card
CD-ROM Drive
Total RAM Installed 16
Megs or greater
100 MB free hard-disk space

Power: There are two 5400 versions available. The DC version can only be powered by
DC power. The AC version can be powered by AC or DC power.
Power for DC external 12VDC power source | 9-16.5VDC; 800 mA
Version:
Power for AC internal AC switching power 100-240VAC; 50-60Hz; 300 mA
Version: supply
Both AC and DC | lithium battery (for real time 2032 lithium ion
versions: clock)
Electronics ARM?7 embedded microproces-
sor
DSP (digital signal processing) | Digital processing of 5400 in-
formation ensures accurate and
repeatable readings.
Firmware
Feature Specification
Flash Memory Firmware field upgradable with
local PC connection
Data Logging non-volatile data log memory
storage of 3750 records
sensor log (1000 records)
event log (1250 records)
calibration log (500 records)
Configurationlog (1000 records)
Security password protection
Data filtering reads 2-3 times per second; read-
ings are averaged
Communication
Feature Specification
RS232 up to 100 ft (30m)
OR Optional serial to ethernet remote TCP/IP PC access and/or
device email alarming

YSI 5400
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Safety

THIS IS IMPORTANT

Take time to be safe when working on electrical circuits and equipment. It could
save your life. Avoid unsafe acts and conditions. Do not operate or install the 5400
before reading this chapter. Installing the 5400 involves wiring high voltage equip-
ment. Follow all provided safety information. Installation must be performed by
someone who understand the dangers of, and is qualified to, wire electrical devices.
If information or instructions are not clear, DO NOT PROCEED until clarification
can be obtained.

ALWAYS:

Follow basic safety rules when working with or near high voltage circuits. The
5400 is a high voltage instrument using 110v. Peripheral devices may also be
high voltage devices.

Consider the result of each act. Keep away from live circuits. Do not change
parts or make adjustments inside the equipment with high voltages on.

Do not service alone.

Do not tamper with interlocks. Safety devices such as interlocks, overload re-
lays, and fuses should never be altered or disconnected except for replacement.
Safety protection devices should never be changed or modified without a clear
understanding of what effect the modification will have on the system.

Do not ground yourself.

Do not energize equipment if there is any evidence of water leakage.

Warnings and Cautions
Safety information is presented in this manual in one of two ways:

A - WARNING - RISK OF ELECTRIC SHOCK This symbol identifies
installation and operation procedures that can result in personal injury
or death if safety information is not followed.

A - AVERTISSEMENT - RISQUE DE CHOC ELECTRIQUE. Ce symbole
identifie les procédures d’installation et dopération pouvant entrainer des
blessures ou la mort si les consignes de sécurité ne sont pas suivies.

YSI 5400
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f - CAUTION - RISK OF DANGER This symbol identifies installation and
operation procedures that can result in personal injury or damage to
equipment if safety information is not followed.

These symbols (A) (A) appear in the left margin of the page to highlight

safety information as it applies to a particular installation or operation step.

A complete list of all safety cautions is provided below. Warnings are provided in
both English and French.

Install and use the 5400 only in accordance with information documented in this
manual.

Warnings

WARNINGS are used when personal injury or death can result when safety infor-
mation is not followed.

WARNING: All wiring involving connections to mains power must be performed
by a qualified licensed electrician, and must conform to all locally applicable
electrical codes.

AVERTISSEMENT: tous les cablages comportant une connexion a l'alimentation
secteur doivent étre réalisés par un électricien qualifié et doivent étre conformes
aux codes électriques applicables.

WARNING: Do not make connections while power is applied. Turn off power
and assure power “Lockout” before installing or servicing to avoid contact with
electrically powered circuits. This includes working on devices connected to the
relay outputs and auxiliary input systems. Disconnect external power to the 5400
before connecting or disconnecting components and/or peripheral devices.

AVERTISSEMENT : neffectuez aucune connexion alors que le circuit est sous

A tension. Coupez l'alimentation et assurez l'interdiction du courant avant toute
installation ou tache dentretien afin déviter dentrer en contact avec des circuits
sous tension. Cela comprend tout travail sur des appareils connectés a des sorties
de relais et des systémes dentrée auxiliaires. Déconnectez I'alimentation externe
du modéle 5400 avant de connecter ou de déconnecter des composants et/ou
des appareils périphériques.

WARNING: A switch or circuit breaker shall be included in the building where
the 5400 is installed. The disconnecting device should be in close proximity to

YSI 5400
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the equipment and within easy reach of the operator. The disconnecting device
shall be marked for the equipment.

AVERTISSEMENT : un commutateur ou disjoncteur doit étre installé dans le
batiment ot le modeéle 5400 est installé. Le dispositif de déconnexion doit se
trouver a proximité de Iéquipement et a portée de lopérateur. Le dispositif de
déconnexion doit indiquer Iéquipement auquel il se rapporte.

WARNING: The covers of fuse boxes and junction boxes should be kept securely
closed except when service is being done.

AVERTISSEMENT : le couvercle des boites a fusibles et des boites de dérivation
doit étre maintenu fermé sauf lors des taches dentretien.

WARNING: Electric sparks and chemical exposure are potential dangers when
working with batteries. Use necessary precautions and follow all manufacturer’s
directions.

AVERTISSEMENT : lexposition a des étincelles ou produits chimiques est un
danger potentiel inhérent a tout travail sur des batteries. Observez les précautions
nécessaires et suivez les consignes du fabricant.

WARNING: Ground the 5400. See Ground 5400 - page 42. The sensitivity and
stability of the 5400 will be impaired if the 5400 is not grounded. To avoid pos-
sible electrical shock or damage to the equipment, connect earth ground to the
5400 I/0O control board. In addition to grounding the 5400, all tanks should be
electrically grounded using a ground probe.

AVERTISSEMENT : mettez le modeéle 5400 a la terre. Voir Mise a la terre du modeéle
5400. La sensibilité et la stabilité du modéle 5400 seront affectées s'il nest pas mis
ala terre. Pour éviter toute possibilité de choc électrique ou dendommagement de
Iéquipement, connectez le fil de terre a la carte I’E/S du modéle 5400. En plus de
la mise a la terre du modele 5400, tous les réservoirs doivent étre mis a la terre.

WARNING: Do not overload relays. Verify that the surge current at startup does
not exceed the relay load ratings. Be familiar with all safety information regarding
installing and servicing peripheral devices.

AVERTISSEMENT : ne surchargez pas les relais. Vérifiez que la surtension de
démarrage ne dépasse pas la capacité de charge nominale du relais. Prenez con-
naissance de toutes les consignes de sécurité concernant 'installation et Ientretien
des appareils périphériques.

YSI 5400
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WARNING: The 5400 is not fused. Fuses used in any peripheral equipment should
be removed and replaced only after the circuit has been de-energized. When a
fuse blows, it should be replaced only with a fuse of the same current and voltage
ratings. Circuits should be carefully checked before fuse replacement. A burned
out fuse is often the result of circuit fault.

AVERTISSEMENT : le modéle 5400 ne contient pas de fusible. Les fusibles utilisés
par les équipements périphériques doivent étre retirés et remplacés uniquement
apres que le circuit a été mis hors tension. Lorsqu’un fusible est grillé, il doit étre
remplacé uniquement par un fusible d’'une tension et d'un ampérage nominaux
identiques. Les circuits doivent étre soigneusement vérifiés avant le remplacement
d’un fusible. Un fusible grillé est souvent le résultat d’'une défaillance de circuit.

WARNING: Do not apply power to the 5400 until all electrical connections are
verified and secured.

AVERTISSEMENT : ne mettez pas le modéle 5400 sous tension tant que les con-
nexions électriques nont pas été vérifiées et sécurisées.

Cautions

CAUTIONS are used when personal injury or damage to equipment can result if
safety information is not followed.

é CAUTION: The 5400 utilizes sensitive solid state devices that can be damaged
by static shock. Installers must observe accepted ESD (Electro-Static Discharge)
procedures while connecting wires to the 5400 control board.

A CAUTION: Sensors are powered by the 5400 instrument and use a “floating”
ground reference. This requires that the probe not be individually grounded.

CAUTION: Power supply voltage above 16.5 VDC may permanently damage the
5400. See Wire DC Power - page 45.

CAUTION: Surge protectors are strongly recommended to protect from second-
ary surges and lightning. Surge suppression devices should be located on the AC
line supplying power to the 5400 and any signal lines connecting the 5400. See
Lightning and Surge Protection - page 65.

CAUTION: It is essential that all sensor wiring be run in a separate cable or
conduit from power wiring.

YSI 5400
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Installation & Wiring

-Installing & wiring 5400 components and peripheral devices
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Installation and Wiring

Hardware Installation

Correctly install 5400 system components to ensure accurate data collection and
reliable operation. First, determine what monitor, control, and alarm functions the
5400 system will perform. Because system components are wired to the 5400 instru-
ment, it is important to determine where and how components will be installed and
configured. Preparing a system schematic (figure 3.1) is helpful.

Figure 3.1
Hardware installation steps (not all steps required for all applications):

Step 1 - install 5400 instrument

Step 2 - locate and install sensor(s)

Step 3 - ground 5400

Step 4 - wire power

Step 5 - wire sensors(s)

Step 6 - wire relays (output devices)

Step 7 - wire aux input devices (excluding temperature probes)
Step 8 - wire a network of 2 - 32 instruments

Step 9 - install and wire communication equipment

See Chapter 4 Configuring 5400 Systems - page 68 for directions on programming
5400 systems.

YSI 5400
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Tools and supplies needed for hardware installation:

Phillips-head screwdriver to remove 5400 fro panel to access I/O board and
lower board assembly

necessary tools for cutting mounting holes in mounting brackets (rail mount)
and/or control panel (panel mount)

5/32” Allen wrench (panel mount only)

electric drill and bits for mounting 5400 (panel or rail) and for drilling rub-
ber grommets in bulkhead fittings

small flat-head screwdriver to terminate wires on I/O board pluggable
terminal strips

wrench to tighten bulkhead fittings following system component wiring
tweezers to replace the membrane gasket on the YSI 5422 sensor

wire strippers

distilled water for DO membrane installation

contactors may be required for relay wiring; see contactor wiring - page 52

Optional accessories for hardware installation:

surface mount hardware (included)

rail mount hardware

panel mount hardware

weather shield hardware

serial to ethernet device

wiring for network wiring

wiring not supplied with components and/or peripheral devices

Step 1 Install 5400
Select a mounting location and method to mount the 5400.
Location Considerations

The 5400 must be located:

above any level where water damage can occur

away from extremely high or low temperature sources

away from vibrating surfaces

at least two 2 feet (~.7 m) from any high voltage conduit

away from electromagnetic, radio, AC motor, transformer, or antennas

so the front panel can be fully opened and serviced

so system component wires are run as specified in this manual and according
to local applicable electrical code

YSI 5400
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Mount the 5400

Select surface, rail, or panel mount option. Install the weather shield for outdoor
installations.

Surface Mount

Mount 5400 to any flat surface using mounting brackets. Mounting brackets and
screws are included with the 5400.

1.  Fasten the mounting brackets to the back of the 5400 with the mounting
screws - figure 3.2.

2. Tighten the screws, securing the brackets to the back of the 5400 enclo-
sure.

3. Fasten the 5400 mounting brackets to the mounting surface with the mount-
ing screws provided - figure 3.2. Make sure screws adequately secure 5400
to surface.

4.  Tighten the screws, securing the 5400 to the surface.

Figure 3.2
Rail Mount
Mount 5400 to handrail or pipe 1 to 1.5” (2.5 to 3.8cm) in diameter. The rail mount

kit (YSI model number 6509) includes u-bolts, a pre-drilled metal plate, washers,
and nuts.
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1. Drill holes in the mounting brackets to fit the u-bolts. Use the pre-drilled
metal plate as a template.

2. Fasten the mounting brackets to the back of the 5400 with the mounting
screws as shown in figure 3.2.

3.  Tighten the screws, securing the brackets to the 5400.

4.  Place the u-bolts around the rail securing the 5400 to the pipe or rail by
feeding through the pre-drilled holes on the mounting brackets as shown
in figure 3.3.

5. Secure the metal plate over the u-bolts and around the rail or pipe using
washers and nuts provided.

6. Tighten the screws, securing the 5400 to the rail.

Figure 3.3
Panel Mount

Panel mount the 5400 if the 5400’s front panel is to be mounted on a control panel or
any vertical surface where only the front panel will be accessible from the mounting
surface. The panel mount kit (YSI model number 6510) includes the standoffs and
frame necessary to mount the 5400 to any panel 9.5” 1 x 7.5” w (~24x19cm). The
space behind the panel must be at least 5.5” (14cm) deep.

A WARNING: Disconnect external power to the unit before opening the front
panel.

@ AVERTISSEMENT: déconnectez I'alimentation externe de I'unité avant douvrir
le panneau avant.
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Installation and Wiring

1. See Open Front Panel to Access I/O Board - page 40 to remove front panel
from enclosure.

Figure 3.4

2. Disconnect front panel ribbon cable by pressing the two IDC header con-
nectors located on the front panel out (away from the IDC header) - figure
3.5.

Figure 3.5

3. Remove and retain four screws that secure display board into top panel en-
closure - figure 3.6. (Display board is mounted on panel attached to 5400 top
panel. I/O Board wiring diagram is located on the display board panel.)

Figure 3.6

4. Carefullylift out the display board and remove the lanyard from the display
board panel - figure 3.7. Set display board panel and top panel aside.
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Figure 3.7

5.  Fasten the mounting brackets to the back of the 5400 enclosure with the
mounting screws - figure 3.2, page 28.
6. Tighten the screws, securing the brackets to the 5400.

7. Drill hole in panel for 5400 enclosure (dimensions provided with kit).
8.  Place standoffs between 5400 mounting brackets and panel surface - figure
3.8.
YSI 5400
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9. Secure 5400 to panel with frame using washers and bolts provided.

Figure 3.8

10. Reattach lanyard by placing lanyard at proper location of display board
panel. Make sure lanyard is fully seated on display panel boss to ensure
proper clearance when front panel is closed- figure 3.7.

11. Replace four screws to reattach display board panel to front panel enclosure
- figure 3.6.

12. Connect 5400 display board to ribbon cable - figure 3.5.

13. Secure the 5400 front panel to the frame using mounting screws. Follow
procedures provided at Close Front Panel - page 40 to secure 5400 and
protect internal electronics.

14. Tighten the screws, securing the 5400 to the panel.

Install the Weather Shield

Install the weather shield for outdoor installations. The weather shield can be used
with either a surface or rail mount. The weather shield kit (model number 6505)
includes a weather shield, u-bolts, pre-drilled metal plate, washers, and nuts.

1. First complete steps 1-2 under Surface Mount or steps 1-3 under Rail
Mount depending on the type of installation. Note: You may need to
modify the pre-drilled holes in the weather shield depending on the
mounting location.

2. At step 3 (surface mount) or step 4 (rail mount), attach the weather shield
with the metal plate installed securely to the surface or rail. Figure 3.9 shows
the weather shield installed for a rail mounted 5400.
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3. Tighten the screws, securing the weather shield.

Figure 3.9

Step 2 Locate and Install Sensor(s)

The 5400 can be configured with 1, 2, 3, or 4 dissolved oxygen (DO) sensors and
1, 2, 3, or 4 temperature sensors. Temperature sensors are configured as auxiliary
(Aux) inputs 3, 4, 5, and/or 6. Select a YSI 5422 DO (polarographic)/temperature,
a YSI 5421 DO (galvanic)/temperature, and/or a YSI 5420 DO (galvanic) sensor
assembly. All DO sensors require a properly installed membrane. The 5422 DO
(polarographic) sensor can use either a blue (PE 2.0 mil) or gray (Teflon 2.0mil)
membrane. The Galvanic sensor can only use a probe-specific Teflon membrane.
Temperature sensor(s) must be a thermistor with 10K at 25°C. See Appendix 6
Alpha A Curve - page 214.

For accurate DO measurements, ensure that the temperature reading for each DO
channel is representative of the temperature at that DO sensor’s location. This is
important when using the same temperature input source for multiple DO sensors.
Example - if the temperature source for DO1 and DO2 is the temperature sensor
connected to Aux 3 at the DO1 sensor location, it is important that the temperature
at the DO2 sensor location is the same as at DO1 sensor location.

See Chapter 4 Sensor Setup - page 127, for information on configuring 5400 sensor
systems. User defined sensor configuration items include:

- Display format (i.e. units of measure. For example, mg/L or % saturation,
°C or °F)
- Temperature source (aux input 3, 4, 5, or 6, or user defined)
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- Salinity input value (user entered salinity value of the water being moni-
tored)

- Elevation monitoring system

- Setpoint, control, and alarm values and ranges

- Control and alarm relay assignments

Location Considerations

Readings gathered at the sensor location(s) are data logged and processed by the
5400 instrument. Output control and alarm devices are configured to respond to
sensor values. Therefore, it is essential to have accurate readings at the sensor loca-
tion. Locate sensors according to the below specifications.

Locate sensor end of probe assembly:

o inalocation that represents the entire system

o where the water flow is at least 3 inches per second (7.6 cm/sec) if using the
2.0 mil PE membrane or at least 6 inches per second (15.24 cm/sec) for 2.0
mil Teflon membrane

o inalocation that is free from debris (e.g. algae); ideally at a 45° angle from
vertical position and directed with the flow - figure 3.10

Figure 3.10

o inawell mixed, free-flowing area; midstream and mid-depth typically gives
representative readings; the probe assembly and cable are fully submersible
up to the cable connector

o submersed at all times so liquid level fluctuations do not expose the sensors
to the atmosphere

o so the sensor/probe cabling is not routed near rotating machinery and/or
equipment involving electrical switching or regulation
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o so that the sensor assembly and cabling are located away from sources of
electrical interference such as UV sterilizers, florescent lighting, ballasts,
pumps, any high voltage peripheral devices, etc.

CAUTION: run high and low voltage cabling through separate bulkhead and
conduit

o where regular maintenance, including calibration can easily be done. Cali-
brations are performed using the 5400 front panel.

Note:
- TheYSI 5422 DO sensor is field replaceable and can be replaced without replac-
ing the probe cabling. The 5420 and 5421 DO sensors are not replaceable. If
a 5420 or 5421 sensor requires replacement, the entire probe/cable assembly
will have to be replaced.

In addition to the above considerations, locate the temperature sensor(s):

o in alocation that accurately reflects the temperature of the DO sensor it
is monitoring.

YSI 5422 Polarographic DO/Temperature Probe Assembly

The YSI 5422 probe assembly includes a polarographic DO and temperature sensor.
Install the DO sensor on the cable. The DO sensor is shipped with a red protective
cap. Remove the red cap and install a new membrane with fresh electrolyte onto
the DO sensor prior to use. Complete instructions are provided with the sensor
and membrane kit.

Figure 3.11 shows the external parts of the YSI 5422 probe assembly.

After installing the probe in its monitoring location, see Wire Sensors - page 47 for
wiring directions.

Probes should be serviced on a regular basis. See DO Probe Maintenance - page 6.
Allow approximately 10 to 15 minutes after the 5400 is powered on, or after servic-
ing the DO sensor, for the polarographic sensor to stabilize.
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Figure 3.11

YSI 5420 (Galvanic DO) and YSI 5421 (Galvanic DO/Tempera-
ture) probe assembly

The YSI 5420 probe/cable assembly includes a galvanic DO sensor. The YSI 5421
includes a galvanic DO and temperature sensor. The DO sensor on both of these
cables is shipped with a dry membrane. A new membrane with fresh electrolyte
must be installed on the DO sensor prior to use. Complete instructions are provided
with the sensor and membrane kit.

Figure 3.12 shows the external parts of the YSI 5420 probe/cable assembly.

After installing the probe in its monitoring location, see Wire Sensors - page 47 for
wiring directions.

Probes should be serviced on a regular basis. See DO Probe Maintenance - page 6.
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Figure 3.12

Install Temperature Sensors

The 5400 system will support 4 Temperature/Aux Analog inputs. Temperature
sensors are included on YSI 5421 and 5422 probe/cable assemblies. Alternate
temperature sensors can be used but must be thermistors with 10K at 25°C . See
Appendix 6 Alpha Curve - page 214.

After installing the temperature in its monitoring location, see Wire Temperature
Sensors - page 50.

Probes should be serviced on a regular basis. See Probe Maintenance - page 6.

Wiring Information

System components must be wired correctly to ensure reliable performance and
accurate data collection. Directions are provided on the following pages for wiring
all components and peripheral devices.

PCBs

There are four printed circuit boards (PCBs) inside the 5400 enclosure. They are:

- Display board (mounted in the front panel)
- I/O board (visible when front panel is removed)
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- DO daughter board mounted to the I/O Board
- Control board (connected to the under side of the I/O Board)

Notes:
- 1/O board and control board (including DO daughter board) are attached to
a metal plate and are referred to as the “lower board assembly”. See Control
Board - page 41.
- No 5400 components or peripheral devices are wired to the display or DO
daughter board.

Most components including: power, ground, Aux input, network, relay output, and
RS232 communication components are terminated on the I/O board. The optional
serial to ethernet device is installed on the control board. The front panel must be
removed when wiring 5400 components and peripheral devices. See Accessing the
I/0 Board - page 40. It is recommended that some system configuration and testing
be done in conjunction with hardware installation. This will ensure that the 5400
system is wired correctly. Necessary configuration information (from Chapter 4 -
“Configuration”) is referenced in the applicable test system procedure.

Figure 3.13

& WARNING: Follow all safety information and local electrical codes when wiring Accessing the I/O Board

5400 system components and peripheral devices. Proper wire gauge should be

determined based on voltages and wire/cable length. Incorrect wiring can result The 1/O board is accessible when the 5400 front panel is removed. The letters on

in damage to you or equipment. Ground loops can also result due to improper the metal plate attached to the I/O board identify pluggable terminal strips on the

wiring. I/0 board. Letters on the metal plate correspond to the wiring diagram located on

the inside of the top panel - figure 3.14. A ribbon cable connects the display board

A AVERTISSEMENT : suivez toutes les consignes de sécurité et les codes électriques (mounted in the top P?nel) to the [/O bogr d. When the 5400 top panel is removed,

en vigueur lors du cablage des composants du systéme 5400 et des appareils a lanyard protects against stress on the ribbon cable. See Open Top Panel to Access
périphériques. Le calibre correct des cables doit étre déterminé en fonction des I/0 Board - page 40.

tensions et de lalongueur des cables/fils. Un cablage incorrect peut entrainer des
blessures et endommager léquipement. Des boucles de mise a la terre peuvent
également étre provoquées par un cablage incorrect.

5400 Bulkhead Fittings

Five bulkhead fittings [5@ 3/8”(.9525cm), 2 @ 3/4” (1.905cm), and 3@ 1/2” (1.27cm)]
located at the bottom of the 5400 enclosure provide watertight connections for 5400
system component wiring. Rubber grommets must be “pushed out” of the com-
pression fitting housing and drilled for wiring installation. The drill bit diameter
should be slightly smaller than the wire diameter so that a watertight seal can be
made. Rubber grommets can be frozen (put in a freezer for 1 hour) and then easily
drilled to the required diameter. Some pre-drilled rubber grommets are supplied
with the 5400.

YSI 5400 YSI 5400
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Figure 3.14

Open Front Panel to Access I/O Board

A WARNING: Disconnect external power to the unit before doing any wiring.

AVERTISSEMENT : déconnectez I'alimentation externe de I'unité avant deffectuer

un cablage quelconque.

1. Loosen the 4 mounting screws connecting the front panel to back enclo-
sure. Captive screws remain in front panel after loosening.

2. Carefully lift the 5400 front panel from the back enclosure. The front
panel should be placed to the left of enclosure. Allow the lanyard to
hold the weight of the front panel. The rubber gasket seated in the front
panel should remain in the front panel lid.

Close Front Panel

1. Tighten bulkhead fittings after connecting all 5400 wiring. (Hand tighten
fittings around rubber grommet. Tighten bulkhead fittings into 5400
enclosure with wrench being careful to not overtighten.)

2. Follow information in Sealants, Desiccants and Securing the Monitor
Section - page 66 to safeguard against damage to internal electronic

YSI 5400
40

Installation and Wiring

A

A

components.

Make certain the gasket in front panel lid is in place and not twisted or
damaged.

Replace front panel making sure that ribbon cable is not trapped in the
gasket channel before inserting mounting screws.

Tighten mounting screws, making sure not to cross thread. The screws
are stainless steel, and the receiving threads are brass. Do not over-
tighten!

WARNING: The 5400 utilizes sensitive solid-state devices that can be damaged
by static shock. Installers must observe accepted ESD (Electro-Static Discharge)
procedures while connecting cabling to the 5400 I/O plate or to any other internal
component or damage may result.

AVERTISSEMENT : le modeéle 5400 utilise des appareils transistorisés sensibles
pouvant étre endommagés par des décharges délectricité statique. Les installateurs
doivent observer les procédures de protection acceptées contre les décharges
électrostatiques lors du cablage a la carte d'E/S du modele 5400 ou a tout autre
composant interne afin déviter tout risque de dommage.

Control Board

The control board is mounted underneath the I/O Board. The serial to ethernet
device and lithium battery are installed on the control board. Complete installation
instructions, including accessing control board, are provided with the optional serial
to ethernet device. Figure 3.15 shows the control board and I/O Board removed
from the 5400 enclosure.
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Figure 3.15

Step 3 Ground 5400

@ WARNING: Ground the 5400 to avoid possible electrical shock or damage to
the equipment.

@ AVERTISSEMENT : mettez le modeéle 5400 a la terre afin déviter tout risque de
choc électrique ou dendommagement de léquipement.

Ground the 5400 at location @ on I/O Board - figure 3.16. Other 5400 system
components can be grounded at locations @ and @. Titanium ground rods can
also be used to ground peripheral equipment.

In addition to grounding the 5400, all tanks should be electrically grounded via a
ground probe.

Directions to Ground 5400

A

A AVERTISSEMENT : déconnectez l'alimentation externe de l'unité avant deffectuer
un cablage quelconque.

WARNING: Disconnect external power to the unit before wiring.

YSI 5400
42

Installation and Wiring

Perform steps 1 - 2 of 5400 installation.

Open front panel - page 40.

Remove screw from location @.

Feed ground wire through drilled hole in rubber grommet and to loca-
tion @ on metal plate covering I/O Board. Ground wire gauge must
conform to all locally applicable electrical codes.

Lol 2

/N\ CAUTION: Run high and low voltage cables through separate bulkhead and
conduit.

5. Terminate ground wire by returning screw at @ over terminal connec-
tion of ground wire.

Do not connect or disconnect IDC ribbon cable
when 5400 is powered. Serious damage can occur.

®
VAN

(A] (A

Figure 3.16

6.  Terminate other end of the earth ground wire to a cold water pipe, steel
rod, copper pipe, or earth ground.

7. Complete other wiring to configure 5400 system.

8.  Close front panel - page 40.

Step 4 Wire Power

The 5400 is available as an AC or DC instrument. The DC version can only be
powered by DC power. The AC version can be powered by either AC or DC power.
If an AC version is properly wired and configured for both AC and DC power, and
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AC power fails, the power switches to 12VDC. If DC voltage drops below a user
defined safe operating range, an alarm occurs.

CAUTION: At 120VAC, the 5400 draws 25 watts (~0.2 amps). Use wiring suitable
for that load following all safety information and local electrical codes.

Back up power is recommended when operating with AC power. Backup power
can be supplied by 12VDC or UPS battery source.

Wire AC Power

The AC power option includes an integrated universal (worldwide) AC switching
power supply allowing AC power from any AC receptacle 100-240VAC. AC power
wires are terminated at location @ on I/O Board - 3.17.

Directions to Wire AC Power
A WARNING: Disconnect external power to the unit before wiring.

AVERTISSEMENT : déconnectez l'alimentation externe de l'unité avant deffectuer
un cablage quelconque.

1.  Perform steps 1-3 of 5400 installation.
. Open front panel - page 40
3. Feed AC power cable through drilled hole in rubber grommet to location
©. The terminal strip is removable.

/N CAUTION: Run high and low voltage cables through separate bulkhead and
conduit.

4. Terminate AC power wires to pins “G” (ground), “L1”, and/or “L2/N”
according to applicable local electrical codes. Use minimum 18 gauge
3 wire power cord.

/N CAUTION: Itis recommended to power only the 5400 instrument with the power
cord to prevent exceeding the current draw of the AC power supply.
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Do not connect or disconnect IDC ribbon cable
when 5400 is powered. Serious damage can occur.

@
VAN

(A] (A

Figure 3.17

5.  Complete other wiring to 5400.
6. Close front panel - page 40.
7.  Test AC power.

Test AC Power

Turn on main power. The enabled system values display on the Run Screen after
initial YSI splash screen. If applicable, install and configure DC power backup on
this page. Verify AC power at the Menus -> System ->Version menu - page 125.

See power fail menu - page 117 for AC power event log information.

Wire DC Power and Backup Power

The 5400 may be powered by most regulated 9.0-16.5 VDC source that provides
800mA of current and is isolated from mains supply by double or reinforced insula-
tion. The DC power source is user supplied and could be lead acid, gel cell, or UPS
(with 12VDC transformer) external batteries. DC power wires are terminated at
location @ on the I/O Board - 3.18.

Notes:
- The 5400 does not charge batteries. Quality assurance maintenance proce-
dures should be established if batteries are to be fully powered when used as
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back-up power source.

- Power supply voltage above 16.5 VDC may permanently damage the 5400.

- When back up voltage falls below 9.0 volts, the 5400 ceases to operate prop-
erly.

- Some switching DC power supplies not supplied by YSI may result in noisy
readings.

Directions to Wire DC Power/DC Backup Power

A WARNING: Disconnect external power to the unit before wiring. Follow all manu-
facturer’s safety and installation instructions when providing power to the 5400
via a DC power supply.

A AVERTISSEMENT : déconnectez l'alimentation externe de 'unité avant deffectuer
le cablage. Suivez toutes les consignes de sécurité et d’installation du fabricant lor-
sque vous fournissez de l'alimentation au modeéle 5400 par un bloc d'alimentation
a courant continu.

1. Perform steps 1-3 of 5400 installation.

2. Open front panel - page 40.

3. Feed DC power cable through drilled hole in rubber grommet to location
®. Terminal strip is removable.

/N\ CAUTION: Run high and low voltage cables through separate bulkhead and
conduit.

4. Terminate DC power wires to pins (-) and (+) according to manufacturer
instructions and any applicable local electrical codes.
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Do not connect or disconnect IDC ribbon cable
when 5400 is powered. Serious damage can occur.

@
VAN
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Figure 3.18

5.  Complete other wiring to 5400.
6. Close front panel - page 40
7.  Test DC power.

Test DC Power

Connect DC power cable to power source. The enabled system values will display
on Run Screen after initial YSI splash screen. Verify DC power at the Menus >
System ->Version menu - page 125.

See Power Fail Menu - page 117 for DC low battery trigger monitor and alarm
information.

Note:
- The 5400 will not power up if DC power supply wires are terminated incor-
rectly.

Step 5 Wire Sensor(s)

Up to four DO sensors and four temperature sensors can be wired to the 5400. All
sensors are wired to the I/O Board - figure 3.19. YSI probe assembly 5422 has one
polarographic DO sensor and one temperature sensor. YSI probe assembly 5421
has one galvanic DO sensor and one temperature sensor. YSI probe assembly 5420
has one galvanic DO sensor. The probe assemblies are shipped bare wire. YSI 5421
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and 5422 probe assemblies have five wires. Two wires are for the DO sensor and are
terminated at location H on the I/O board. Two wires are for the temperature sensor
and are terminated at location L on the I/O board. The fifth wire is a ground and
is not used. The YSI 5420 probe assembly has two wires for the DO sensor. Follow
the wiring instructions below to ensure proper sensor operation.

Note:
- The ground wire (clear in color) should not be used and can be cut back to
the black cable sheathing.

Wire DO Sensors
Directions to Wire DO Sensor(s)

WARNING: Disconnect external power to the unit before wiring.
1.  Perform steps 1 - 4 of 5400 installation.
2. Open front panel - page 40
3. Feed DO cable through drilled hole in rubber grommet to location @.
The terminal strip is removable.

/N\ CAUTION: Run high and low voltage cables through separate bulkhead and
conduit.

4. Terminate the DO sensor wires for the DO1, DO2, DO3, and/or DO4
system. Wire the DO sensor cathode wire to (+) terminals and the DO
sensor anode wire to (-) terminals. Follow the coloring scheme described
below when wiring the DO sensor.

o YSI 5422 polarographic DO sensor wires are green and white.
-Terminate green wire to “A Polarographic”.
-Terminate white wire to “C Polarographic”

o YSI 5420 & 5421 galvanic DO sensor wires are white and black.
-Terminate white wire to “C Galvanic”.
-Terminate black wire to “A Galvanic”.

5. Wire temperature sensors if temperature is to be monitored, controlled,
and/or alarmed. Temperature sensors are wired as auxiliary inputs. See
Temperature Sensor(s) - page 50
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Do not connect or disconnect IDC ribbon cable
when 5400 is powered. Serious damage can occur.

@
VAN
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Figure 3.19

6.  Complete other wiring to configure 5400 system.
7. Close Front panel -page 40.
8. Test DO sensor.

AN\ CAUTION: Do not ground the probe body.

Test DO/Temperature Sensors

Apply power to 5400. See DO Sensor Setup - page 139, to configure DO sensor inputs.
See Temperature Setup - pagel138. Calibrate the DO sensor, see DO calibration - page
78. Verify changes in sensor values occur when the sensor is placed in environments
of different oxygen concentration and temperature. For example, the DO reading
in saturated air for calibration versus the DO reading when the sensor is placed in
a zero oxygen environment (mix 1 gram sodium sulfite in 0.5 liter of water).

Wire Temperature Sensor(s)

The 5400 system will support four Temperature/Aux Analog inputs. Temperature
sensors should have 2 wires and are terminated at location @ on I/O Board - figure
3.20. Temperature sensor(s) must be thermistors with 10K at 25°C, see Appendix
6 Alpha A Curve - page 214
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Directions to Wire Temperature Sensor(s)
A WARNING: Disconnect external power to the unit before wiring.

AVERTISSEMENT : déconnectez I'alimentation externe de I'unité avant deffectuer
un cablage quelconque.

1. Mount and install 5400 and probes.
. Open front panel - page 40.
3. Feed temperature probe cable through drilled hole in rubber grommet
to location @. The terminal strip is removable.

/N CAUTION: Run high and low voltage cables through separate bulkhead and
conduit.

4.  Terminate temperature sensor wires to Aux 3, Aux 4, Aux 5, and/or Aux
6 system. There is no polarity for temperature sensor wire; therefore,
(+) and (-) terminals are interchangeable. Make sure the temperature
sensor wires are wired to the (+) and (-) terminals for the Aux system
(3,4, 5, 6) you are configuring.

Do not connect or disconnect IDC ribbon cable
when 5400 is powered. Serious damage can occur.

AN\

(A] (A

Figure 3.20

5. Complete other wiring to configure 5400 system.
Close front panel - page 40
7. Test temperature sensor.

o
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Note:
- Temperature sensors wired to Aux 3, Aux 4, Aux 5, and Aux 6 are displayed
on the 5400 by default as Temp 1, Temp 2, Temp 3, and Temp 4 respectively.
For instructions on changing the default display settings, see section Name
Devices/Sensors in Chapter 4 Configuring the 5400.

Test Temperature Sensor

Apply power to 5400. See Configure Aux Temperature - page 101 to configure
temperature sensor input. Place the temperature sensor in solutions of varying
temperature and verify the sensor readings with another temperature sensor.

Step 6 Wire Relay outputs

The 5400 has eight (8) on board non-fused relays rated at 240VAC@5AMPs
(110VAC@10AMPs) of switching capacity. Relays energize and de-energize periph-
eral control, alarm and/or timer devices. Terminate relay device wires to Normally
Open (NO), Normally Closed (NC), and Common (C) sockets as required for the
application. (See 5400 I/O Board wiring diagram on inside of front panel for iden-
tification of relay number and pin position.) Relays 1-4 are terminated at location
@ on I/O Board. Relays 5-8 are terminated at location @ on I/O Board - 3.21.

& CAUTION: Do not overload relay(s). Check manufacturer specifications for
inductive current/amp at power up. Use a contactor if necessary - figure 3.22.

Directions to Wire Relay Outputs

A WARNING: Disconnect external power to the unit before wiring. If any of the
relay contacts are connected to a “hazardous-live” circuit, ALL contacts on ALL
relays must be considered “hazardous live” and appropriately protected from user
contact outside the 5400 enclosure.

A AVERTISSEMENT : déconnectez I'alimentation externe de I'unité avant deffectuer
le cablage. Si un contact de relai quelconque est connecté a un circuit sous ten-
sion dangereuse, TOUS les contacts de TOUS les relais doivent étre considérés
comme étant sous tension dangereuse et doivent étre protégés de fagon adéquate
de tout contact de l'utilisateur hors du boitier du modeéle 5400.

1. Perform steps 1-4 of 5400 installation and step 5 as required for ap-
plication.
2. Open front panel -page 40.
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3. Feed relay device wires through drilled hole in rubber grommet and to
locations @ and/or @. The terminal strip is removable.

/N\ CAUTION: Run high and low voltage cables through separate bulkhead and

conduit.

4. Terminate relay device wires to the relay number (1-8) that will be con-
figured for device. Wire devices to NC or NO and C pins depending
on device configuration.

>]
(]
>]

Do not connect or disconnect IDC ribbon cable
when 5400 is powered. Serious damage can occur.

®
VAN

(A] (A

Figure 3.21

5. Complete other wiring to 5400.
6.  Close front panel -page 40
7. Test relays.

Wiring a Contactor

The eight onboard relays are rated at 240VAC@5AMPs (110VAC@10AMPs) switch-
ing capacity. Contactors should be used for devices drawing current loads higher
than relay specification. See figure 3.22 for contactor wiring.

Note:
- Contactor must meet the electrical requirements of the load.
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YSI 5400 contactor wiring

wire contactor power to“C” pin
wire other wire to“NC"/"NO" as required for application

-

0o
Z =z
Contactor
Switched Power
g @ Blower
(~)
Q) )
Power for Contactor Power for Blower
Coil Contacts
Figure 3.22
Test Relay Outputs:

Apply power to 5400. Verify device activates at relay test. See Relay Test - page
123.

Note:

Entering the relay test menu turns off any active relays and disables any sensor, aux,
and timer system relays from energizing regardless of value or condition. Systems
are not reset when the Relay Test menu is exited. To reset systems after exiting the
Relay Test menu, power cycle the 5400.

Step 7 Wire Aux Inputs (Non Temperature)

The 5400 has six (6) auxiliary inputs. All 6 auxiliary inputs can be used for digital
(open/closed dry contacts) or analog (0-1VDC; 0-5VDC, or 4-20ma) inputs. Aux-
iliary inputs 3, 4, 5, and 6 can be configured for a temperature sensor. See Termpera-
ture Probes - page 50 for wiring directions. Aux inputs can be used for a variety of
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applications including: level switch, pressure switch, and/or an external instrument
with an analog recorder output. Aux input wires are terminated at location ® and/
or @ on1/0 Board - figure 3.23. (See 5400 I/O Board wiring diagram on inside of
front panel for identification of aux system number and pin position.) See Digital
Input example - figure 3.24, and Analog Input example - figure 3.25.

Notes:
- All aux inputs have input protection, the maximum input voltage should not
exceed 6 VDC.
- Analog systems will not monitor and/or alarm properly if the device that is
installed and configured operates outside the configured analog range.
- For proper digital input operation, use low impedance switches and wiring.
The total resistance should not exceed 200 Q (ohms).

Directions to Wire Aux Inputs (Non Temperature Inputs)
A WARNING: Disconnect external power to the unit before wiring.

A AVERTISSEMENT : déconnectez l'alimentation externe de I'unité avant deffectuer
un cablage quelconque.

1. Perform steps 1-4 of 5400 installation and steps 5 -6 as required for the
application.

2. Open front panel - page 40 .

3. Feed auxiliary device cable(s) through drilled hole in rubber grommet
to locations @ and/or @. The terminal strip is removable.

/N\ CAUTION: Run high and low voltage cables through separate bulkhead and
conduit.

4. For Aux 3,4, 5, &6 use the terminal strip located at @, using (+) terminal
for one wire and (-) for ground wire. For Aux 1 and 2, use terminal strip
located at @. “G” pin is the common ground for Aux 1 and 2.

See Digital Input example - figure 3.24 and Analog Input example - figure 3.25.

CAUTION: The auxiliary inputs are not isolated. Devices connected must be
electrically isolated from ground and the water.
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Do not connect or disconnect IDC ribbon cable
when 5400 is powered. Serious damage can occur.

AN

(A] (A

Figure 3.23

5.  Complete other wiring to 5400.
6. Close front panel - page 40.
7. Test aux systems.

Test Auxiliary Input Devices

Apply power to 5400. See Aux Setup - beginning on page 132 for configuration
information. Verify display, control, and/or alarm functionality based on user
defined configuration.
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Installation and Wiring

ire Aux Digital Input

1. Install aux digital device according to manufacturer’s instructions.
Connect switch wires to Aux Input 1 - 6. Connect ground wire to (G) at
location @ for aux 1 and 2 or to (-) at ® for aux 3, 4, 5, or 6. Connect the
other wire to (+) @ andtolor2at@.

Auxiliary Input Connector

T
Instrument with
analog voltage
output

/N CAUTION: Do not input external voltage.

Figure 3.24

ire Aux Analog Input

1. Install analog instrument according to manufacturer’ instructions.
Connect analog instrument wires to Aux Input 1 - 6. Connect ground wire
to the (G) at @ for aux 1 and 2 or to (-) at @ for aux 3, 4, 5, or 6. Connect
the other wire to 1 or 2 at @ for aux 1 and 2 or to (+) at @ for aux 3, 4, 5,
or 6.

Auxiliary Input Connector

T
Instrument with
analog voltage
output

A\ CAUTION: Observe correct polarity on analog input.

Figure 3.25
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Step 8 Wire Network

Multiple 5400 and 5200A instruments can be networked using the RS485 network
ports. A node network consists of one master and up to 31 slaves. On a network,
the master is the point of access for the AquaManager PC software program. In
addition, the master sends all serial to ethernet device emails. Communication
hardware (RS232 or serial to ethernet device) is installed on the master instrument
(node) only.

RS485 network wiring can span distances up to 4000 feet (1220m). This maximum
distance (4000 ft) is for the total network distance, not the distance between net-
worked units (*see Notes below). RS485 ports are optically isolated for safety, to re-
duce noise, and to help eliminate ground loops. No further isolation is required.

Network traffic refers to the constant communication between the master and all
slaves on the network. Example - slave node 3 is configured to generate an alarm
if the temperature drops below 70°E. The master node is configured to send email
alarms via TCP/IP using the serial to ethernet device. The master node sends an
email alarm when slave node 3 reports a temperature value below 70° F (for longer
than the alarm hold off time) to the master.

@ AquaManager is a valuable tool for monitoring and controlling node networks.

Notes:

- *Use an RS485 Line Extender/Booster for distances over 4000’ (1220m).
Communication failures may occur without it. Mount the booster in an area
where it is protected from moisture.

- Multiple networks connected to a PC via RS232 require separate PC COM
ports for simultaneous AquaManager mapping and autopolling.

- Legacy 5200s can not be on the same network as 5200As and/or 5400s. How-
ever, Legacy 5200s can communicate with AquaManager and Legacy 5200 data
will be stored in the same database as 5200A and 5400 data.

- Network traffic speed operates at ~ 230 KB and is not user selectable.

- Remove network terminal strip from any networked slave that is not powered.
Network rewiring is required if a stub (*see note below) is created when a slave

is taken off the network. See valid network configuration - see figure 3.30.

Note:
- * Astubis created when the last wired network terminal strip is not connected
to a network slave - figure 3.26.
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Network wire stub

A stub is created when the last wired network terminal strip is not connected to a network slave.

1 thisisastub
| | | | (wired terminal

I_I__I I__I_I — I__I_I strip is not physically

slave slave slave connected to last
master slave physical slave on

network)

Iil I__I_I [ 4 this is not a stub

(wired terminal
master slave slave slave slave strip is physically

connected to last
physical slave on
network)

[ -represents wired network termination strip
-terminal strips located within master/slave image represent terminal strips that are physically
connected to device
-terminal strips that appear outside slave image represent terminal strips not connected to device

Figure 3.26

Directions to Wire Network

Network wiring consists of two pair of twisted pair cable plus a communications
com wire. Category 5 ethernet cable is recommended. Network wires are terminated
at location @ on I/0 Board - figure 3.27.

A WARNING: Disconnect external power to the unit before wiring.

AVERTISSEMENT : déconnectez I'alimentation externe de I'unité avant deffectuer
un cablage quelconque.

1. Perform steps 1-4 of 5400 installation and steps 5 -7 as required for the
application.
2. Open front panel -page 40.
3. Strip five wires to terminate at network termination strip. Use appropri-
ate wire stripper to avoid wire nicks.
4.  Feed networking cable through drilled hole in rubber grommet and to
location @. The terminal strip is removable.
Note:
- Itis essential that wires be terminated cleanly. Nicks (stray wires, not cleanly
terminated) can result in unreliable network communication.
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CAUTION: Run high and low voltage wires/cables through separate bulkhead
and conduit.

Do not connect or disconnect IDC ribbon cable
when 5400 is powered. Serious damage can occur.

®
VAN

(A] (A

Figure 3.27

5. Terminate wires as described using category 5 cable: (color scheme may
be different than described below.)
- Pair #1 wires: solid blue and white with blue stripe
- Pair #2 wires: solid orange and white with orange stripe
- 1 wire green
- Secure unused wires to avoid potential for shorting

Wire the master as follows:

Wire Color Terminal

solid orange T(-)

white with orange stripe T (+)

solid blue R(-)

white with blue stripe R (+)

green Communications Common (C)

Wire all slaves as follows:

Wire Color Terminal
solid blue T(-)
white with blue stripe T (+)
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solid orange R (-)
white with orange stripe R(+)
green Communications Common (C)

Figure 3.28 is a wiring diagram for the most common 5400 network configuration
where a master 5400 is the first physical device in the network. Additional network
diagrams are provided after step 8.

RS485 Wiring Diagram for 3 Networked 5400s
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o
o

3

Master All other slaves All other slaves

Figure 3.28

6. Wire all network terminal strips prior to network testing but only
connect a network terminal strip to the first and last devices on the
network (*see note below). Configure network menu and follow test-
ing procedure as described starting on page 92. Slave devices are tested
one by one as they are added to the network. Network testing cannot
be done if stubs exist (** see note below ).

Notes:

- *If the master is not the first physical device on the network, place network
terminal strip on the master and on the first and last physical devices on the
network. (In this case two slaves will need to be tested at the same time.) -
figure 3.29.

- **Astub is created when the last wired network terminal strip is not connected
to a network slave - figure 3.26.
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Testing network configurations

Follow wiring instructions below to avoid testing network wiring with stubs.

[ -represents wired network termination strip
-terminal strips that appear within master/slave box represent terminal strips that are physically
connected to device
-terminal strips that appear outside slave box represent terminal strips not connected to device

I — — — |
I;_lefler slave slave slave slave
1 2 3 4

When master is first physical device on network, as shown above, connect terminal strip to master and last|
slave (slave 4) to begin network testing. Terminal strips for slaves located between the master and the last
slave are then connected, one, by one beginning with slave device furthest from master and continuing to
slave devices closest to master. Testing in the above graphic would occur first with slave 4, then slave 3,
then slave 2, ending with slave 1.

use above network wiring testing method when master is first physical device on network

[ -represents wired network termination strip
-terminal strips that appear within master/slave box represent terminal strips that are physically
connected to device
-terminal strips that appear outside slave box represent terminal strips not connected to device

I |

slave | __| slave master slave slave

When master is not the first physical device on network, as shown above, connect terminal strip to master
and outer most slaves (slaves 1 and 4) to begin network testing. Testing in above graphic would occur first
with slaves 1 and 4, and then continuing by testing slave device 2, or slave device 3 until all network
wiring is tested.

use above network wiring testing method when master is not first physical device on network

Figure 3.29

7. Close front panel -page 40.

5400 networks must be configured point to point (instrument to instrument). Net-
work wiring cannot contain loops, stars, or stubs - figure 3.30.
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Network configurations

Master || slave slave slave slave
good
/ . slave || slave Master slave slave
goo

follow master/slave wiring directions figure 3.28

\ slave\ slave |— Klave
slave \ slave
ter

Master slave

p

/ |
slave, \ slave l
/ \ slav7_ slave (Iave

4 bad \ y 4 bad \

do not wire “star” network

do not wire “loop” network

Figure 3.30

Test Network Wiring and Configuration

Apply power to only the master and last slave device on the network. If the master
is not the first physical device on the network, apply power to the master and the
first and last physical slave devices on the network. See Network beginning on
page 92.

Step 9 Wire and Install Communication Equipment

Communication equipment must be installed in order to communicate, either locally
or remotely, with the 5400. The communication connection can be made locally
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(RS232) or remotely with a serial to ethernet device. Only 1 connection method
can be used at a time. AquaManager supports both connection methods.

Notes:
- Firmware can only be uploaded to an instrument using a local RS232 connec-
tion. See Downloader - page 109.
- On a network, install and configure RS232 or the serial to ethernet device
(hardware and wiring) on the master node only.

Email Alarming
Email alarming can be configured in 1 of 2 ways:

@ o from PC running AutoPoll Program that is included with AquaManager
software (PC must have internet connection). This is referred to as Aqua-
Manager email.

e  viaa serial to ethernet* device with TCP/IP connection at the master 5400.
This is referred to as 5400 email.

*Serial to ethernet connection requires access to an SMTP server accessible by the
local network.

RS232 Communication

Use Category 5e patch cable from RS232 port at location @ - figure 3.31 of I/O
Board to PC using RJ45 to DB9 adapter.

Directions to Wire Direct RS232 PC Connection
& WARNING: Disconnect external power to the unit before wiring.

AVERTISSEMENT : déconnectez l'alimentation externe de I'unité avant deffectuer
un cablage quelconque.

1. Perform steps 1-4 of 5400 installation and steps 5 -8 as required for the
application.

2. Open front panel - page 40.

3. Feed direct connect cable through drilled hole of rubber grommet and
to location @.

/N\ CAUTION: Run high and low voltage cables through separate bulkhead and
conduit.
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4.  Connect one end of communication cable to RJ45 at location @. Con-
nect other end to RS232 PC com port using RJ45 to DB9 adapter figure
3.31.

>]
(]
®
©
>]

Do not connect or disconnect IDC ribbon cable
when 5400 is powered. Serious damage can occur.

®
VAN

(A] (A

figure 3.31

5. Complete other wiring to configure 5400 system.
Close front panel - page 40.
7. Test RS232 communication.

o

Notes:
@ - When using a USB-Serial Adapter, verify that the port number assigned dur-
ing driver installation is the same port configured when using AquaManager
and/or the Firmware Updater.

- When making RS232 cable runs greater than 100 feet (30.5 m), use an RS232
Line Extender/Booster. Mount the booster in an area where it is protected
from moisture.

- Proper PC com port number must be configured when using AquaManager
or Firmware Updater programs.

Test RS232 Communications

Apply power to 5400. Insert node into AquaManager program. Poll node. If wired
correctly. AquaManager will obtain 5400 configuration and logs.
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Ethernet (TCP/IP) Module Communication

The optional serial to ethernet device must be installed on the 5400 control board
when using TCP/IP for communication. Complete installation instructions are
provided with the optional serial to ethernet device.
Notes:
- See Menus -> System > Communications -> Ethernet beginning on - \ for con-
figuration information.
- An SMTP server accessible by the local network must be provided for eth-
ernet connection.

Consult the network administrator to verify compatibility for ethernet configura-
tion.

Lightning and Surge Protection

ACline voltage surge suppressors protect field equipment on any AC line to ground
from damage due to electrical transients induced in the interconnecting power lines
from lightning discharges and other high voltage surges. Surge protection devices
are strongly recommended to protect your equipment from secondary surges and
lightning on outdoor installations. Follow the recommendations provided when
choosing and incorporating surge protection devices into your operation:

Recommendations:

o Surge suppression devices should be located on the AC line supplying power
to the 5400 and any signal lines connecting the 5400.

o The unit should include noise filtering, common mode, and normal mode
suppression and nanosecond reaction time.

o Surge suppressors should be internally fused to remove the load if the unit
is overloaded or the internal protection fails.

o Signal line suppressors protect low voltage signals and relay outputs from
damage due to electrical transients induced in the signal lines from lightning
discharges or nearby electrical devices.

o Signal line suppressors should be installed at each end of an analog loop.

o Relay outputs should be protected at the receiver end.

o Signal line suppressors should consist of a three-element gas tube followed
by metal oxide varistors and suppressor diodes.

o The protective elements should be matched such that high-energy surge
voltages trigger the gas surge arrester, while low energy or surge voltages
affect the MOV’s and suppressor diodes.

o Lightning protection devices should be located as close to the 5400 as pos-
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AN

sible and wired in accordance with the National Electric Code in approved
watertight enclosures.

CAUTION: This or any other installation procedure cannot protect against a direct
lightning strike. YSI Incorporated cannot accept liability for damage due to lightning
or secondary surges.

Sealants, Desiccants, and Securing 5400

Environmental conditions can promote the formation of condensation in and around
the 5400. It is very important to follow the steps below to prevent damage to the
electronic components and extend the life of the 5400 system.

1.

A\

Place solid rubber grommets in bulkhead fittings that have no electrical
connections.

If using optional conduit fittings (YSI p/n 065926 UL) in place of bulkhead
fittings, industrial encapsulant (YSI p/n 065921 conduit sealer) must be
used to prevent moisture from entering the 5400 enclosure. Apply the
sealant after all wiring and connections are complete. Failure to use
industrial encapsulant may result in damage to the 5400.

Desiccant pack must be replaced whenever the 5400 enclosure is opened
(Desiccant pack, YSI p/n 006506). Desiccant absorbs moisture captured
within the enclosure.

Ensure that the rubber gasket is seated between front panel and enclosure
whenever enclosure is closed.

Replace front panel making sure that ribbon cable is not trapped in the
gasket channel before inserting mounting screws.

Tighten mounting screws, making sure not to cross thread. The screws
are stainless steel and the receiving threads are brass. Do not over-
tighten!

WARNING: The 5400 utilizes sensitive solid-state devices that can be damaged
by static shock. Installers must observe accepted ESD (Electro-Static Discharge)
procedures while connecting cabling to the 5400 I/O plate or any other internal
component or damage may result.

AVERTISSEMENT : le modele 5400 utilise des appareils transistorisés sensibles
pouvant étre endommagés par des décharges délectricité statique. Les installateurs
doivent observer les procédures de protection acceptées contre les décharges
électrostatiques lors du céblage a la carte d'E/S du modeéle 5400 ou a tout autre
composant interne afin déviter tout risque de dommage.
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-Navigating menus

-Menu structure
-Configuring 5400 systems




Configuring the 5400 Configuring the 5400

5400 Confi gu ration and Monitorin g select and enter highlighted submenu item and to hold one of multiple run screens
from scrolling. Hold is not an option when there is only one run screen. Run screens
This chapter provides information on the 5400’ front panel, navigating menus, and can be scrolled when held by pressing A and ¥ keys.
menu functions.
Notes:
The front pgnel - figure 4..1, is the front component of the 5400 encl.osure. The front - Pressand hold & and Y longer than one second for continuous scrolling.
panel contains the 5400 display and seven keys. Use the keys to navigate menus and A v
instrument system information. - Use ™ and " to scroll and view additional menu items when a scroll bar
appears to right of screen.
This icon indicates helpful information for AquaManager users and is used through- - Pressing any of the four bottom keys resets any active alarm system. See
out this chapter. AquaManager provides access to 5400 system information from General Alarm - page 113.
a PC. Most 5400 configuration and monitoring can be done using AquaManager.
See Chapter 5 AquaManager - page 160. Softkeys
Softkey labels appear on the bottom of the display and identify the function of the
buttons below them. Softkey labels change in different menus. Softkey labels and
corresponding softkey functions are listed in table 4.1.
Note:
- Not all menus and screens display four softkey labels. If there is no softkey
label, that softkey has no functionality.
Softkey label Function
Access to Main Menu including:
calibration submenu
system submenu
sensor setup submenu
timers submenus
Display active non timer control & alarm
system(s)
Access to Msg’s (Messages) Menu including:
sensor logs
event logs
calibration logs
Activate Service Hold
Figure 4.1

Exit menu return to Run Screen saving
menu configuration changes.

Front Panel Keys

Exit menu (to previous menu) without sav-
ing configuration changes.

There are seven (7) 5400 front panel keys - figure 4.1. Use A and 'Y keys to scroll
and highlight menu lists and to scroll through multiple Run Screens. Use +! key to
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Softkey label Function

Back to previous menu. Changes to configu-
rations are saved at return to Run Screen.

Prompt to take next action. i.e. enter user
value at calibration menus.

Save alpha and numeric configurations and
calibrations.

Disable/Enable menu option. i.e. buzzer.

Scroll left and right in alpha and numeric
keypad screens.

To acknowledge and save sensor calibration.

Prompt to confirm “Are you sure?” message
when performing certain functions. i.e. reset
to factory and clear data log menus.

T Digital input control configuration from
Open Closed
Sensor Setup Menu.
table 4.1
Run Screen

The Run Screen displays measurements and inputs from enabled sensors and
conditions - figure 4.2. At power up, the Run Screen is displayed immediately after
the YSI splash screen (the YSI splash screen appears for approximately 2 seconds).
Icons displayed at the Run Screen represent individual and systemwide conditions.
See Run Screen Icons - page 71.

Run Screen and sensor display formats are user selectable. See Display Format - page
107, and Sensor Setup Menus - page 127.

Notes:
- The Run Screen must be displayed during normal operation.
- Allalarm functions (5400 email alarms, energizing of enabled alarm relays,
alarm icons, and buzzer) are suspended when in 5400 instrument menus.
Alarm systems are reset when menus are exited to Run Screen.

@ - Always manually poll the 5400 after uploading configuration changes and

verify the uploaded information is retained. When configuration changes
are uploaded using AquaManager at the same time configuration changes are
being made at the instrument, the AquaManager uploads may not be saved
depending on the timing of keystrokes at the 5400.
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@ The Run Screen must be displayed during normal operation. If the 5400

_——

is not at the run screen during AquaManager uploading, pressing Gl at
the 5400 will only save certain configuration changes.

- At power up, 5400 systems have a 30 second hold off allowing sensor values

to stabilize before enabling any control and/or alarm devices.

Figure 4.2

Run Screen Icons

Icons identify control, alarm, timer, power, service, and communication informa-
tion. Icons along the top of the Run Screen indicate 5400 systemwide conditions
- table 4.2. Icons displayed within a sensor window indicate condition(s) specific
to that system - table 4.3.

Notes:

- Control icons display when the control relay(s) is active.

- General alarm icon, buzzer, 5400 emails, and enabled alarm relay(s) [sensor
and general alarm] remain active until one of the bottom four 5400 front panel
keys is pressed, regardless if the alarm condition no longer exists.

- Relays, and corresponding icons, that de-energize for Svr Hold, calibration,
and/or factory resets are restored after 30 seconds of completing Svr hold,
calibration, and/or factory resets. For exceptions, see menu specific informa-
tion in this chapter.

- With alarms enabled, alarm icons appear at the systemwide location and
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individual system location regardless if a relay is assigned to the sensor alarm

or general alarm system.

ICONS Meaning Notes
(systemwide)
RS232 communication blinking icon indicates

“force serial port” is
enabled

TCP/IP communication
ethernet module installed

operating in acceptable DC power range

T
0
b

DC power is < low battery trigger

Configuring the 5400

ICONS Notes
(Sensor & Aux) Meaning
21 sensor system is in alarm

low range control relay is energized ~ control icons do not appear
(to raise sensor value) for aux systems

high range control relay is energized control icons do not appear

¥
B

£
P

(to lower sensor value) for aux systems
2 @ DO lqw range 2‘control relay is
4 energized (to raise sensor value)

5400 is password protected

DO high range 2 control relay is
A energized (to lower sensor value)

sensor (data) logs have information

to view logs

> | B

one or more control systems is active

to view active systems

feed timer is active

one or more 10 event timer is active

probe timer needs to be reset

Fﬂ\.\@ﬁ%

General Alarm is active

table 4.2
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Menus

5400 firmware is structured using menus that enable you to easily configure and
view system status, messages, and logs. The menu structure and screen formats are
very intuitive. Menus are structured in hierarchical fashion. See Appendix 3 “Menu
Maps” - beginning on page 187. Example - figure 4.3 illustrates the menu path to
configure data logging interval.
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Menu Hierarchy

Run Screen - Menus > System Menu = Data Logging-»Logging Interval

Data Logging (Enabled) (1 Hour)

Logging Interval

Time units

Steps to configure data logging interval:

1) select “Menus” at Run Screen

2) select “System” at Main menu

3) select “Data Logging” at System menu

4) select “Data Logging” at Data Logging menu

5) select “Logging Interval” at Data Logging menu

6) input logging interval (1-255) at & (numeric keypad)

after numeric keypad entry and return to “Data Logging” menu

W to save configuration and return to Run Screen

Figure 4.3

Submenu Screen Types

The 5400 includes numeric, alpha/numeric, and pull-down submenus - 4.4. See
Front panel keys page 68, to navigate, enter, configure, and view submenus.

YSI 5400
74

Configuring the 5400

Figure 4.4

This symbol indicates that alpha/numeric or numeric keypad entry is required.

~
| This symbol is used in the menu map appendix starting on page187 and in direc-

tions for menu configuration (this chapter). Use A Y font panel keys to

o
scroll and to select entries.

The remainder of this chapter provides information on 5400 menus and submenus
and their function. Menu structure and information is provided in hierarchical order

,m,andw

starting with the

menus is provided after the menu sections.

Main Menu

Press at the Run Screen to enter the Main Menu.

All system configuration is done through this menu. The four Main Menu submenus
are Calibration, System, Sensor Setup, and Timers.
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Calibration
1M

sor Setup
Timers

Calibration Menu

DO sensors(s) must be user calibrated to ensure accurate measurements. Calibrate
DO sensors at the Calibration Menu. Entering the Calibration Menu de-energizes
control and alarm relays for the DO system being calibrated de-energize. Energized
DO control relays for systems not being calibrated remain energized including any/
all temperature systems regardless if they are the configured temperature (temp)
source for the DO sensor being calibrated. If necessary, disable any temperature
relays for the associated DO sensor in the Sensor Setup menu. There is a 30 second

hold off period for control and alarm relays after pressing m or M at
the calibration menu. The hold off period allows sensors time to stabilize before
processing readings for controlling and alarming purposes.

Youhave calibrated one or
H more systems. The System will
now enterina 30 second warm
up hold

Notes:

- Active Aux and Timer relays do not de-energize at calibration menu.

- A “Check probe” error message during calibration means that the sensor is
unable to calibrate within the 5400’s specifications. This may indicate im-
proper sensor wiring (see page 47), the need to service the sensor, or a failed
Sensor.

- Temperature sensors do not require calibration nor is it available.

- Energized alarm relays for all systems de-energize when a front panel key
is Eressed to enter the calibration menu. Alarm systems are not reset until

is pressed to return the instrument to the run screen.
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Getting Ready to Calibrate

Calibrate DO sensor(s) by performing a one point calibration. Calibration can be
done in % Saturation (Sat) or mg/L. Calibrating in %Sat automatically calibrates
mg/L and vice versa so it is only necessary to calibrate one or the other, not both. For
both ease and accuracy, YSI recommends calibrating in %Sat. Salinity compensation
for the mg/L readings is obtained from the user entered ppt value. This value can
be entered and modified in the DO sensor setup menu.

Figure 4.6 Figure 4.5

Notes:

- A sensor must be enabled in order to calibrate it.

- For the YSI 5422 cable/probe assembly only, keep the sensor guard installed
during the calibration to protect the membrane from possible physical dam-
age - figure 4.6.

- When calibrating to mg/L, use a ring stand and clamp to secure the sensor in
the calibration water sample.

- Older sensors may take longer to calibrate than new ones because the sensor
readings may take longer to stabilize.

Calibration Log

Calibration data is stored in the 5400 calibration log. A calibration data record in-
cludes sensor information, the time and date of the calibration, and the calibration

method. Press at the Run Screen to view the calibration log - page 153.
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Notes:

@ -

DO

Use AquaManager to view and save calibration data on a PC. In addition to
the calibration log information listed above, AquaManager calibration logs

also include user inputs 1 and 2.
Information from cancelled calibrations is not stored.

Menus - Calibration> DO

Directions to Calibrate DO Sensor %Sat

If you have not already done so, locate and install the sensor if using a
YSI 5422, see probe installation instructions included with the sensor.
Next, install a new membrane, see instructions included with membrane
kit and wire the DO probe page 47.
Verify that the sensor type and membrane type are configured correctly
in the DO Sensor Setup menu on the instrument.
Read Getting Ready to Calibrate - page 77.
If using the 5422 polarographic sensor, wait at least 10-15 minutes after
the 5400 is powered on, or after the DO sensor is serviced, before cali-
brating. This allows enough time for the DO sensor to stabilize.
Verify that the configured salinity (ppt) value in the DO Sensor Setup
menu is correct. The entered salinity value should equal the salinity of
the water being monitored (not the calibration solution). If necessary,
enter the correct the salinity value (ppt).

Menus > Sensor Setup-> DO->ppt
Verify that the local elevation in the DO Sensor Setup menu is correct.
If necessary, enter the correct elevation.

Menus > Sensor Setup> DO->Elevation
Create a 100% water-saturated air environment for the DO sensor:

For a YST 5422 polarographic sensor:
o Moisten the sponge in the gray calibration/storage sleeve with a

small amount of clean water. Do not use too much water! The idea
is to create a 100% humid environment.

o With the sensor guard installed, place the cal/storage sleeve over
the sensor guard. Make sure that the DO sensor is not immersed in
water and that there are no water droplets on the membrane.

For a YSI 5520 and 5521 galvanic sensor, there are two options for the
%$at calibration environment:

o For highestaccuracy, place the sensor in a cup that contains a small

Configuring the 5400

amount of clean water. Place the sensor in the cup so the probe
body rests on the sides of the cup but does not touch the water, see
picture below. The idea is to create a 100% humid environment.
Make sure that the DO sensor is not immersed in water and that
there are no water droplets on the membrane.
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o Alternatively, you may choose to calibrate the galvanic sensor in air
by exposing it to air and removing any water droplets from the mem-
brane with a lint free cloth - figure 4.5, page77. While this method
is acceptable, it may introduce a small amount of error to the DO
readings. For highest accuracy, calibrate in a 100% water-saturated
air environment following the directions listed previously.

If the temperature source for the DO sensor being calibrated is not com-

ing from a temperature sensor located on the DO sensor’s probe assembly,

make sure that the temperature value being reported by the source is
equivalent to the temperature at the DO sensor’s calibration location.

Menus > Sensor Setup-> DO->Temp Source (User Defined)

Enter DO calibration menu

Menus > Calibration> DO->Sat

Allow approximately 10 minutes for the air in the calibration envriron-

ment to become completely water saturated and for the temperature to

equilibrate.

YSI 5400
79



Configuring the 5400

DO CAL %Sat

CAL:100%

103.

Waituntilreadingis steady

12. After 10 minutes, verify that the DO reading shows no significant change
for approximatelﬁ 30 seconds. Then press to complete calibration

OR press to abort the calibration without saving.

13. Press WSl to save calibration and return to Run Screen.

14. Remove the probe from its calibration chamber.

15. Rinse sensor in tap or purified water and place the probe assembly back
in its monitoring location.

Directions to Calibrate DO Sensor mg/L

A large bucket can be used when calibrating the DO mg/L reading. Be sure to
provide sample flow across the membrane by physically stirring the probe or using
a stirrer such as a stir bar. The DO sensor requires a sample flow rate of at least 3
inches (~7.62 cm) per second if using the 2.0 mil PE membrane (blue) and at least
6 inches (~15.24 cm) per second if using the 2.0 mil Teflon membrane (gray).

1. Ifyouhave notalready done so, locate and install the sensor, install a new
membrane - page 33, page35, page36 and wire the DO probe page 47.

2. Verify that the sensor type and membrane type are configured correctly
in the DO Sensor Setup menu on the instrument.

3. Read Getting Ready to Calibrate - page 77.

4.  Ifusing the 5422 polarographic sensor, wait at least 10-15 minutes after
the 5200A is powered on, or after the DO sensor is serviced, before
calibrating. This allows enough time for the DO sensor to stabilize.

5. Verify that the configured salinity (ppt) value in the DO Sensor Setup
menu is correct. The entered salinity value should equal the salinity of
the water being monitored (not the calibration solution). If necessary,
enter the correct the salinity value (ppt).

Menus > Sensor Setup-> DO->ppt

6.  Place the DO probe in a water sample with a known DO concentration
(the DO mg/L value can be determined from another recently calibrated
DO instrument or from a Winkler titration).
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9.

If the temperature source for the DO sensor being calibrated is not com-
ing from a temperature sensor located on the DO sensor’s probe assembly,
make sure that the temperature value being reported by the source is
equivalent to the temperature at the DO sensor’s calibration location.
Menus > Sensor Setup-> DO->Temp Source (User Defined)
Enter DO calibration menu

Menus > Calibration> DO->mg/1
Allow the probe to stabilize for approximately one minute.

DO CAL mg/L

10.29:

Waituntilreading is steady

11.

12.

13.
14.

15.

Note:

bration OR press
menu without saving.

<_|
enter the known DO value in mg/L. Press = to confirm each number
selection.

Using the arrow keys to select numbers on the numeric keypad,

Press to confirm the entered value OR press to abort

the calibration without saving any changes.

Press to save the calibration and return to the Run Screen.
Rinse sensor in tap or purified water and place the probe assembly back
in its monitoring location.

Rinse sensor in tap or purified water and place probe assembly in system
stream.

Elevation is not required for mg/L Calibration.
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System Menu
Menus - System

Use Up and Down Arrow Keys
To Adjust Contrast

The System Menu contains 17 submenus. Use System submenus to configure non- Press Enter to Exit

sensor and non-timer systems. System submenus are shown below. Press
at the Run Screen to enter the Main Menu. Use A ¥ to scroll and highlight a Sys-

tem submenu. Press < to select and enter a highlighted menu. Configuration ““

changes are saved when ¥ is pressed.

1.  Enter Adjust Contrast Menu:
Menus > System > Adjust Contrast

SystemMenu SystemMenu

Adjust Contrast Downloader
Buzzer (Enabled)
BackLighting Timer (Enahbled)
Communication
Contfigure AUX
Data Logging
Date/Time
Dizplay Settings

A

General Alarm

Mame DevicesfSensors
Password

Fower Fail

Serial Mumnber (54-1234568)

2. Use®or¥ 1o darken/lighten display.

._l
3. Press™  to confirm new display contrast.

4.  Press

Bl to save configuration and return to Run Screen.

Notes:
- The display contrast will adjust automatically based on the 5400’ internal
System Menu temperature.
@ - Contrast adjustment cannot be performed using AquaManager.
General Alarm
Mame DevicesfSensors
bt BackLight Timer
Serial Mumber (54-1234568) Menus > System > BackLight Timer
Service
Service Hold (Disahled)
— When the backlight timer is enabled, the backlight will turn on when any front panel
w key is pressed and then turn off after the user configured time. If the backlight
timer is disabled, the display backlight will not turn off.
Notes: . .
- See Appendix 3 “Menu Maps” for system defaults and ranges (where applicable) BakbighiNimaRhiEnS
_ i BackLighting Timer (Enablad)
starting on page 187. EEES (3 5953
- Menu configurations are saved to the instrument only after is pressed Time Units (Sec)

and not when the change is made in the menu. If Gl is not pressed, the
changes made to the configuration will not be saved. Exception - Date and
time and clear data logs are updated immediately to the system; however, YSI

1.  Enter BackLight Timer menu
Adjust Contrast . Menus > System >BackLight Timer

recommends pressing P in this instance as well in order to save any
other changes that may have been made to the configuration.

Menus > System > Adjust Contrast 2. Use ™ and ¥ toscrolland highlight submenus.

= .
Use the Adjust Contrast menu to lighten or darken the display contrast. 3. Press ™ to select the submenu you wish to change.
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4. Enable and configure submenus.

Communications Menu

—

SABED 10 save configuration and Ethernet (Hot A

Metwork (Mast

Send Test Email Msg (Not Available)

Email Retry Delay (Not Available)
Time Units (Mot Available)

Buzzer Baud Rate [115200)
Force Serial Port (Disabled)
Menus > System > Buzzer

The 5400 has an audible buzzer that sounds when a general alarm condition oc- I R S R

curs. The buzzer sounds after the alarm hold off period. The General Alarm must

5. After making desired changes, press
return to Run Screen.

be enabled for the buzzer to sound. Use the Buzzer Menu to enable or disable the Note:

audible alarm. @ - AquaManager supports both communication methods.
When enabled, the buzzer will sound until one of the four bottom softkeys on the Email Alarming

5400 front panel is pressed. From the Run Screen, press one of the following softkeys . . .

) G20 @ G (o reset the General Alarm. Resetting the General Email alarming can be configured in 1 of 2 ways:

Alarm silences the buzzer, de-energizes any alarm relay(s), and stops any pendin;
. & Y y(s) ps anyp & 1. A 5400 email is sent from the 5400 serial to ethernet device - See Ethernet
5400 email alarm messages. See General Alarm - page 113 and Sensor Setup - page . . . .
" . ) starting on page 87 for additional information.
127 menus for additional information. o .
System Menu @ 2. An AquaManager email is sent from the PC running the AquaManager

application. AquaManager Autopoller must be running. See Chapter
5 AquaManager - page 160 and AquaManager online help for additional
AquaManager email alarming information.

Adjust Contrast

Buzzer (Disa d
Communication

Configure ALK

Data Logging

Bi‘;’a Ty'gzmngs *Ethernet connection requires access to an SMTP server accessible by the local
Daownloader network.

EMAIL ALARMING DISCLAIMER - There are many factors that can affect deliv-
ery of an email in a timely fashion. Certain SMTP email servers are more reliable
than others. No email alarm message has guaranteed delivery. Use multiple email
addresses and email forwarding as safe guards. Mechanisms, such as spam filters

1.  Enter Buzzer Menu
Menus - System > Buzzer

2. or Gl to turn the buzzer either off or on. used by service providers, evolve constantly and can result in non-delivery. Verify
3 Press ® to save configuration and return to Run Screen with the service provider and/or network administrator to confirm that the 5400

communication configuration ensures the most reliable delivery of alarm emails.

Communication

L Below is a 5400 DO Alarm Low email sent from a serial to ethernet device. As
Menus - System > Communications

shown in the example, all of the alarm information is listed in the subject line. The
user-configured device name is ‘YSI Environmental. The DO system does not have
a user-configured name; therefore, the default system name, ‘DO - 3; is included
in the subject line.

Select the communication method for AquaManager and/or 5400 email alarming.
Only 1 communication method can be used at a time. Hardware changes are required
when the communication method is changed. See Wire Communication Equipment
starting on page 62. Configure remote ethernet communication, network settings,
and RS232 settings in the Communications menu.
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From: myname@xxx-Xxxx.com

Sent: Mon, May 11, 2010 10:24 am

To: myname@xxx-XxXx.com

CC: hot49@xxxx.com

Subject: 05/11/2010 10:23:29 AM YSI Environmental DO - 3 Alarm Low 77%Sat

Notes on 5400 Alarm Emails:

5400 emails contain date, time, device name, system name, alarm condition,
and the sensor reading in the Subject line of the email. When instrument and
sensor names are not user configured, the email includes the serial number
and default system name, i.e. “DO - 3"

On a network, user configured instrument and sensor system names appear
in the alarm emails for the master only. Slave alarm emails will report the
5400 serial number and the default system names regardless if the names are
user configured.

Aux digital closed alarm is reported as 0.00; aux digital open alarm is reported
as 1.00.

Aux analog alarm emails are reported in 0.00 resolution regardless of the
display format resolution.

Aux temperature systems do not report a value. The email message will report
alarm high or alarm low.

See General Alarm- page 113 and Set Points - page 128 for important alarm
configuration information.

Emails are retransmitted based on the Email Retry Delay configuration see
page 95.

Separate emails are sent for each system in alarm.

5400 DO email alarms provide the %Sat value and do not provide mg/L
value.

5400 emails that say “Alarm Both” mean that both a high and low alarm
condition have existed and the alarm has not been cleared by pressing a front
panel key.

5400 alarm emails are not transmitted during a service hold.

5400 slave emails are sent to the configured email addresses in the master.
At power up, the serial to ethernet device may take up to 2 minutes to initialize
before sending alarm emails (if alarm condition exists).

On a network, multiple alarm conditions may exist but only one alarm email
is sent. Master alarm emails have priority over slave alarms. When multiple
slave alarm conditions exist, it’s possible that only one of many 5400 slave
alarms will be sent. Therefore, it is critical that all alarm emails are addressed
locally by the user.

@ Below is an example of a 5400 DO Alarm Low email sent from AquaManager. All
of the information is in the body of the email and not the subject line.
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YSI5400 Alarm

ysi environmental (node name in tree)
54-2345567

DO2 Low Alarm: 77

Notes AquaManager alarm emails:

AquaManager emails are retransmitted based on the Email Retry Delay con-
figuration see page 95.

Multiple system alarms are included in one AquaManager email.
AquaManager DO email alarms provide the %Sat value and not the mg/L
value.

For the AquaManager alarm email to function properly, it may be necessary
to send a test email to each email address configured in the Email Alarm List
in the Node Properties window. Test emails can be sent in the AquaManager
Properties window under the Autopoller tab.

Ethernet
Menus > System > Communications - Ethernet

The serial to ethernet device (TCP/IP connections) must be configured for 5400
email alarming and/or remote access from AquaManager. Device speed and format
are self configured at power up. If the serial to ethernet device is not installed or is
not installed properly, the ethernet menu will display (Not Available).

Notes:

IP Address (192.168.1.100)
Subnet Mask (255.255.255.0)
Gateway (192.165.1.1)

Port (10001)

DNS Address (1392.168.1.1)
Email Address

Email Address

5400 email alarming from ethernet module requires access to an SMTP server
accessible by the local network.
Do not reconfigure internal serial to ethernet device settings.

EthernetMenu

EthernetMenu

Subnet Mask (255.255.255.0)
Gateway (192.168.1.1)

Port (10001)

DNS Address (1392.168.1.1)
Email Address

Email Address

Install serial to ethernet device - page 65.

Dl
The Ethernet icon displays at the Run Screen when the serial to
ethernet device is properly installed.
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3. Enter Ethernet menu
Menus > System > Communications - Ethernet

A

4. Use® and 'Y toscroll and highlight submenus.

“
5. Press to select submenu.
6. Configure submenus as needed.

— N
7. Press GBI to save configuration and return to Run Screen.
Notes:
- The CC/Email address must be configured when using 5400 email alarming.
Specific alarm system information will not be sent if the CC/Email address
menu is not configured with a valid email address.

@ - If Autopoller is being used for AquaManager email alarming on a TCP/IP

connection, it is strongly recommended that the 5400 email alarming using
the serial to ethernet device be disabled. When the ethernet device sends
email alarms, all Autopoller SMS communication is suspended. This could
potentially delay any AquaManager alarm emails from being sent.

@ - To disable the serial to ethernet device from sending alarms, clear all four

email addresses from the Communication > Ethernet menus. Clear the email
addresses by using the “Spc” (space) key on the numeric keypad. Save change

=,
at numeric keypad and press i@l to save configuration and return to Run

Screen.

Ethernet Manu

DHCP

Enable DHCP if you are using the serial to ethernet device only for 5400 email
alarming and not for AquaManager remote TCP/IP access.

Notes:
- When DHCP is enabled, the 5400 IP address is not updated at the IP address
menu.
- With DHCP is enabled, the serial to ethernet device acquires SMTP and DNS
addresses during initialization.

@ - AquaManager requires a static IP address; therefore, DHCP must be disabled
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when using AquaManager. Consult the network administrator to obtain a
static IP address.
- Power cycle the 5400 whenever DHCP is enabled.
IP Address
Menus > System > Communications > Ethernet > IP Address

The IP address can only be configured when DHCP is disabled.

Notes:
@ - AquaManager users should program the Gateway address either by force se-

rial port in the AquaManager Communication menu or locally at the 5400.
Poll node using RS232 communication to upload configuration information
including: static IP, port, subnet, and gateway addresses.

- When DHCP is enabled, the IP address is not updated at the IP address
menu.

- Power cycle the 5400 whenever a new IP address is configured.

Subnet Mask
Menus > System > Communications > Ethernet > Subnet Mask

A Subnet mask address can only be configured when DHCP is disabled. The subnet
mask number helps to define the relationship between the host (computers, rout-
ers, switches, etc.) and the rest of the network. Consult the network administrator
when configuring this menu.

Notes:
- When DHCP is enabled, the Subnet Mask address is not updated at the Subnet
Mask menu.

@ - AquaManager users should program the Subnet mask either by force serial port
in the AquaManager Communication menu or locally at the 5400. Poll node
using RS232 communication to upload configuration information including:
static IP, port, subnet, and gateway addresses.

Gateway
Menus > System > Communications > Ethernet > Gateway

The Gateway address can only be configured when DHCP is disabled. A gateway IP
refers to a device on a network which sends local network traffic to other networks.
Consult the network administrator when configuring this menu.

Notes:
- When DHCP is enabled, the Gateway address is not updated at the Gateway
menu.
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@ - AquaManager users should program the Gateway address either by force
serial port in the AquaManager Communication menu or locally at the 5400.
Poll node using RS232 communication to upload configuration information
including: static IP, port, subnet, and gateway addresses.
Port
Menus > System > Communications > Ethernet > Port

The default port number for the ethernet module is 10001. Consult the network
administrator when configuring this menu.

Note:

@ - AquaManager users should program the port number either by force serial port
in the AquaManager Communication menu or locally at the 5400. Poll node
using RS232 communication to upload configuration information including:
static IP, port, subnet, and gateway addresses.

DNS Address
Menus > System > Communications > Ethernet > DNS

Domain Name Service (DNS) numbers are IP addresses that a workstation or server
uses to refer to specific servers that resolve domain names to IP addresses.

Notes:
- With DHCP is enabled, the serial to ethernet device will acquire SMTP and
DNS addresses during initialization.
- When DHCP is enabled, the DNS address is not updated at the IP address
menu.

Email Addresses
Menus > System > Communications > Ethernet > Email Address
-> Email Address
- Email Address
> CC/Email Address

Up to four email addresses can be configured for 5400 emails. At a minimum, the
first email address and the CC/email address must be configured. If the CC/email
address is not configured, 5400 email alarms will contain no alarm information.
The email ‘from’ address will be the email address entered in the first Email Ad-
dress menu.
Notes:

- See Send Test Email Msg - page 94 to verify proper configuration of ethernet

menus.
- On a network, both master and slave alarm emails are sent to the configured
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email addresses in the master.

- Test the alarm email delivery by creating an alarm condition at the 5400 and
verify the email(s) is received.

- The CC/Email address must be configured when using 5400 email alarming.
Specific alarm system information will not be sent if the CC/Email address
menu is not configured with a valid email address.

- Use AquaManager to easily configure email addresses using the PC keyboard.
See AquaManager on line help.

- If Autopoller is being used for AquaManager email alarming on a TCP/IP
connection, it is strongly recommended that the 5400 email alarming using
the serial to ethernet device be disabled. When the ethernet device sends
email alarms, all Autopoller SMS communication is suspended. This could
potentially delay any AquaManager alarm emails from being sent.

- To disable the serial to ethernet device from sending alarms, clear all four
email addresses from the Communication > Ethernet menus. Clear the email
addresses by using the “Spc” (space) key on the numeric keypad. Save change

_ N

at numeric keypad and press Gllll&l to save configuration and return to Run

Screen.

Ethernet Module Error Message

At power up, the serial to ethernet device will generate an error message if it cannot
properly handshake with the 5400 hardware. If this error occurs, communication
(AquaManager and 5400 alarm emails) will not work via TCP/IP. The error could be
aresult of incorrect serial to ethernet device installation or a faulty ethernet device.
The error message will appear in the event log.

Fuant| nne

11/20/2008 09:14:06 AM
1l Svstem:
1 GeneralAlarm
Sub System:
Ethernet
M Event:
M Failed Tolnitialize

SMS Messaging with Ethernet Module

SMS (Short Message Service) or text messaging is a service for sending messages to
your cell phone or mobile device. To use SMS messaging, enter the email address
in the Menus > System > Communications-> Ethernet >Email address. See Ap-
pendix 6 SMS - page 213 for a list of cellular and mobile companies that support
sending text messages.
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Node Network

Menus > System -> Communications > Network

Configuring the 5400

A node network includes multiple 5200A and/or 5400 instruments. The devices
are physically hardwired together using RS485 protocol. Node networks are con-
figured with one master node and up to 31 slave nodes. The master continuously
queries enabled slaves on the network. The master is the access point for the entire
network. This includes AquaManager communication and sending of 5200A/5400
alarm emails. Slave nodes must be configured with a slave address.

Note:

@ - Multiple node networks communicating via direct connect (RS232) require
separate PC COM ports for simultaneous AquaManager mapping and auto-

polling.

Networking Menu

Master
Slave
Termination Relay (Enabled)

1. Wire 5400 network - page 57.

Enter Network menu

Menus > System -> Communications > Network

3. Press A

4. For master node: Press

5. For all slave nodes: Press
dress.

at master submenu.

at slave submenu.

and ¥ to scroll and highlight submenus.

Configure a slave ad-

The slave address appears as the slave subnode at node properties.

6. Disable the Termination Relay on all devices except the first and last
device on the network. Menus > System -> Communications > Network

- Termination Relay.

7. Verify that the Termination Relay is enabled on the first and last device OR

on the network.
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8.  For master node: Press at master submenu. At assign slaves menu,
select the slave address configured in step 5 above. Press enter. Enable

one slave at a time using Gl softkeys. See Testing Network

- page 62 for the required testing network wiring.

Assigh Slaves Menu

Slave 1({Disabled)

[Enabled)

Slave 3 (Disabled)
Slave 4 (Disabled)
Slawve 5 (Disabled)
Slave B (Disabled)
Slave 7 (Disabled)
Slawve 8 (Disabled)

-y

9.  Press Gl to save configuration and return to Run Screen.

10. Each slave must be tested one by one. Insert network termination strip
and apply power to the master and the last physical device on the net-
work. If the master is not the first or last physical device on the network,
apply power and insert network terminal strip on the master and on the
first and last physical devices on the network. Refer to network wiring
instructions for detailed testing information beginning on page 57. Test-
ing for proper wiring and configuration can be done of two ways:

A. After performing step 9, wait at least 30 seconds and then reenter the
Communication Master submenu. If serial number of the slave is displayed
next to the slave address number, the communication network is wired and
configured correctly.

Assign Slaves Menu

Slave 1(Disabled)
Slave 2 (Disabled)
Slawe 3 (Disabled)
Slave 4 (Enabled)(54-1234568)
Slave § (Disabled)
[ )
L )
l )

Slave B (Disahbled
Slave 7 (Disakled
Slave 8 (Disabled

B. After performing step 9, wait at least 30 seconds and then poll the slave
node using Aqua Manager. If the serial number of the slave is displayed
next to the slave number, the communication network is wired and config-
ured correctly.
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11.  Apply power. Insert network termination strip to 5200A/5400 units as
described in network wiring instructions beginning on page 57. Repeat
network configuration directions starting at step 8 until network wiring
for master and all slaves has been tested.

Notes:
- An Event and General Alarm (if enabled) will occur if, after ten queries, an
enabled slave does not respond to the Master.

4 12/03/2008 02:29:33 PM
4 System:

General Alarm

Sub Mode

1

Event

Slave Network Failure

- Configuring a 5400 as a Master overrides any slave configuration that had
been previously saved.

- Slave alarms (slave alarm at master and 5400 email alarms) will not occur if
slave node serial number is not recognized at master node at steps 10. A or
10. B above.

Termination Relay
Menus > System > Communications > Network >Termination Relay

The termination relay must be enabled on the first and last 5400 on a network. All
other devices should have the termination relay disabled.

Note:
- Install one 120Q) (ohm) resistor between T(+) and T(-) and one 120Q2 (ohm)
resistor between R(+) and R(-) on the master 5200. Resistors were included
with the 5200.

Send Test Email Msg

Menus > System > Communications > Send Test Email Msg

Send a test email to verify proper configuration of ethernet menus. Test emails are
only transmitted from configured master 5400s.

Note:
- Exit to Run Screen is required before the test email is sent.
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Example of a 5400 test email sent from ethernet device:

From: myname@xxx-Xxxx.com

Sent: Wed, Feb 04, 2010 3:49 pm

To: myname@xxx-Xxxx.com

CC: sweet49@xxxx.com

Subject: 02/04/10 03:50:05 PM YSI5400 Email Alarm Test Message

Email Retry Delay
Menus > System > Communications -> Email Retry Delay

Configure the Email Retry Delay for the time interval that emails should be retrans-
mitted after the initial alarm email is sent. The initial alarm email is sent immediately
after the general alarm hold off time or after the aux hold off time. Emails will be
retransmitted until one of the front panel softkeys is pressed, regardless if the alarm
condition still exists.

Notes:

- On a network, emails are retransmitted according to the slave retry delay
configuration of the slave in alarm and not the master’s email retry delay
configuration. Please note, a slave Email Retry Delay menu will display (Not
available) because of its slave configuration; however, this feature is available
and has a default value of 15 minutes that can be configured by the user.

- The Retry Delay should be configured at intervals > 15 minutes.

- AquaManager alarm emails are retransmitted based on 5400 slave(s) and

@ master email retry delay configuration.

Baud Rate RS232
Menus > System > Communications > Baud Rate

Configure the Baud rate (for RS232 connections only) in the 5400 to match the
baud rate configured in AquaManager. Use the default rate of 115200 for fastest
communication speed.
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1. Enter Network menu
Menus > System > Communications > Network >Baud Rate

Press A or ¥ to scroll and highlight a selection.
Press ¢! to confirm selection.

4.  Press Gl

@l to save configuration and return to Run Screen.

Force Serial Port

Menus > System > Communications > Force Serial Port

Enable the Force Serial Port when the 5400 is communicating via RS232 (direct) to
a PC and when the 5400 has a serial to ethernet device.

Communications Menu

Metwork (Master)

Send Test Email Msg (Not Available)

Email Retry Delay (Mot Available)
Time Units (Mot Available)

Baud Rate (115200)

Force Serial Port (Dizsahled)

D IR R R

1. Wire R§232 connection - page 63.
Enter Network menu
Menus > System > Communications - Force Serial Port

Enabled

Disabled

3. Usethe softkeys to configure off or on.

4. Press ¥ to save configuration and return to Run Screen.
Notes:
- RS232 connection is required to upload firmware using the Firmware Up-
dater.
- The RS232 icon == blinks at the Run Screen when in Force Serial Port
mode.

Non-Networked (Stand Alone) 5400s

Non-networked (stand alone) 5400s must have the termination relay enabled. In
addition, non-networked (stand alone) 5400s must be configured as a master in the
System Communication menu with no slave nodes enabled.
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Configure AUX

Menus > System > Configure Aux 1-6

The 5400 has six auxiliary (Aux) inputs. Aux inputs 1, 2, 3, 4, 5, and 6 can be con-
figured for digital or analog ( 0-1V,DC 0-5VDC, or 4-20 mA) inputs. In addition,
Aux 3, 4, 5, and 6 can be configured with a temperature sensor. Configure suffix,
minimum (Min), maximum (Max), and display format menus for the analog inputs.
Non temperature aux input’s control/alarm on condition, control/alarm relay, and
hold off time are configured in the Sensor Setup Menus > Sensor Setup Aux 1-6
menus. Temperature aux input’s set points, control, alarm, and relays are configured
in the Sensor Setup Menus -> Sensor Setup Aux 3-6 menus.

AUX 1Menu

FProbe Name (TGP
Input Type (4/20ma)
Suffix (mmHg)

Min {-400.0 mmHg)
Max (400.0 mmHg)
Display Format (0.0)

Probe Name

Menus > System > Configure Aux >Aux 1-6->Probe Name

Use the alpha/numeric keypad to name aux inputs. Configured name(s) appear
throughout menus and at Run Screen - figure 4.7, page 100.

Note:

- Aux names can also be configured at Menus > System > Name Devices/
Sensors.

Input Type

Menus > System > Configure Aux >Aux 1-6->Input Type

Select the input type for the device(s) wired to aux system(s). Aux Sensor Setup
menu selections are based on the aux input type configured at system menu.
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Digital
0-Tw
0-5v

Temperature

Digital
Menus > System > Configure Aux >Aux 1-6->Input Type->Digital

Use digital input when wiring an external device to control or alarm when the
contacts of an external switch open or close. A common application would be to

detect high or low water levels using a float switch.

Notes:
- Suffix, Min, Max, and Display Format are not available for digital inputs.

- In the 5400 sensor log, aux digital “closed” is logged as Aux 0.00. Aux digital

“open” is logged as Aux 1.00.

1. Wire aux digital devices - page 53.
Enter Aux menu
Menus > System > Configure Aux >Aux 1-6

A

3. Use® and 'Y toscroll and highlight submenus.

“
Press ™ to select.
Configure digital input type and name.

4
5
—
6. Press Gl to save configuration and return to Run Screen.
7. Go to Sensor Setup Menus > Sensor Setup Aux 1-2 - page 132 to enable

and configure control/alarm on condition, control/alarm relay, and
hold off time.

8. Press Gl to save configuration.

Analog Non Temperature
0-1vDC and 0-5VDC and 4-20 mA
Menus > System > Configure Aux >Aux 3-6->Input Type ~ >0-1V
>0-5V
>4/20ma

Select the analog input type based on the signal being sent from the device.

Configuring the 5400
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Notes:
- Itis normal to hear an on-board relay “click” when switching to or from the
4-20ma aux input type.
- Analog systems will not monitor, control, or alarm properly if a device that
operates outside the configured analog range is installed and configured.

Suffix

Menus > System > Configure Aux >Aux 1-6->Suffix

Enter the Suffix (up to 4 characters) to describe the input type or units. The suffix
is displayed at the Run Screen. The suffix is typically used to describe the input
signal type.

Example - when using a total dissolved gas pressure sensor “mmHg” could be used
as a suffix for measuring TGP (total dissolved gas pressure) - figure 4.7, page 100.

Min and Max values

Menus > System > Configure Aux >Aux 1-2 >Min
“>Max

Min and Max values are user defined. The range is -10000 to 10000. Min and Max
values are used for scaling the input value received from an analog aux input. The
min and max values may be configured to correspond to the minimum input level
(i.e. OVDC or 4mA) and maximum input level (i.e. IVDC, 5VDC, or 20mA). The
Min value must be less than Max value.

Example - when using a total dissolved gas pressure sensor (0-5VDC input type)
enter -400 for min value. The 5400 will display “-400” when the input value is OVDC.
Set the max value to correspond to the maximum input value as +400. The 5400
will display “400” when input value is 5VDC.

Notes:

- The 5400 will monitor and data log based on the “min” and “max” voltage or
current signal.

- To enter negative values, type the whole number then select
meric keypad.

- Whenever min and/or max values are changed, go to Menus > System -
Sensor Setup > Aux 1-6 > Control Low and Control High menu to verify
control/alarm values are correct for the application.

« »

on the nu-
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Display Format

Menus > System > Configure Aux >Aux 1-6>Display Format

Configure the Display format (0, 0.0, or 0.00) based on the resolution to be displayed
at the Run Screen.

Example - when using a total dissolved gas pressure sensor, configure the display
format as 0.0 - figure 4.7, on this page.

In the below screen shot, the Run Screen is displaying aux name “TGP,” suffix
“mmHg,” with display format “0.0”. The display value represents an input of 1.875
volts with 0-5VDC analog aux configuration. The min value = “-400”. The max value
= “+400” The control/alarm low is “-50” Alarms are enabled for this aux input.

gglgde5015. Am A
TGP
-100.4:
L g
A

figure 4.7

Notes:

- Values are displayed based on the display format resolution. Example - if the
display format is 0.0 and the min value configured is 1.88, then 1.9 will be the
value displayed in the min value menu.

- 5400 aux sensor logs record 0.00 resolution regardless of the selected resolu-
tion in the aux analog display format configuration.

1. Wire aux analog devices - page 53.
Enter Aux menu
Menus > System > Configure Aux >Aux 1-6

A

3. Use ® and 'Y toscroll and highlight submenus.

i
Press to select.

4
o
5. Press Gl to save configuration.
6.  Goto Sensor Setup Menus > Sensor Setup Aux 1-2 - page 132 to enable
and configure set points, control, alarm, relays, and hold off time.

-
7.  Press Gl to save configuration.
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Note:
- The alarm low value must be > the min value. The alarm high value must be
< the max value.

Analog Temperature (Available Aux 3, 4, 5, 6)

Menus > System > Configure Aux ->Aux 3-6->Input Type->Temperature

Subject: 02/04/10 03:50:05 PM YSI5400 Email Alarm Test Message

A temperature sensor can be configured as an Aux input on Aux systems 3, 4, 5, and
6. Temperature sensors can be configured in conjunction with one of the DO (dis-
solved oxygen) systems or as an independent temperature system at any location.

1. Wire temperature sensors - page 50.
Enter Aux menu
Menus > System -> Configure Aux >Aux 3-6

eAY

3. Us to scroll and highlight submenus.

|
Press = to select.
Configure temperature input type and name.

4
5
—
6.  Press Gl to save settings and return to Run Screen.
7. Goto Sensor Setup Menus -> Sensor Setup Aux 3-6 - page 127 to enable
and configure set points, control, alarm, and relays.

8. Press

S
Sl to save settings and return to Run Screen.

Notes:

- The Configure Aux menu will display temperature configured channels as
“disabled”. This is because aux systems configured as temperature channels
no longer function as analog aux channels, but rather function as a sensor
system.

- The Sensor Setup menu - page 138 is automatically enabled when an aux
channel is configured for temperature.

Configure AUX Menu Sensor Setup

ALK 1 (Disabled) AKX 1 (Disabled)(4/20ma)
A Dizabled) AUX 2 (Disahled)id/20ma)
A Disahbled) AR 3 (Temperature)
ALK 4 (Disahbled) AUX 4 (Disabled){4/20ma)
AUX 5 (Disabled) AUX & (Dizabled)(4/20ma)
ALK B (Disahled) AUX G (Disabled){4/20ma)
DO -1(Disghled)

DO -2 (A&A)Enabled)

L.T T .. igf.T T T.1
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Data Logging
Menus - System >Data Logging

The 5400 saves information in the calibration, sensor, and event logs. Press

Configuring the 5400

at the Run Screen to view the 25 most recent records for each log. The 5400 sensor
log can stores 1000 records. The calibration log can store 500 records. The event log
can store 1250 records. Once a 5400 log is full, it will begin overwriting the oldest

records with new records (data wrapping).

Data Logging Menu

Data Logging (Enabled)i] Hours)
Event Logging (Enabled)
Clear Logs

Notes:

@_
@_

Use AquaManager to store and analyze 5400 logs. To avoid gaps in data, use
polling intervals based on the user defined data logging configuration. Set
the data log interval so that analyzing the data is meaningful.

AquaManager users can view Configuration events in the Configuration log.
Configuration events are created when certain 5400 configuration changes are
made. The configuration log is not accessible at the 5400. See AquaManager
Online Help for additional information.

Data Logging
Menus - System >Data Logging->Data Logging

The 5400 sensor log stores records for sensors and aux systems. Sensor logs are time
and date stamped based on the user configured logging interval (1-255 minutes/

hours).
1. Enter Data Logging menu
Menus > System >Data Logging->Data Logging

2. Use® ¥ toscroll and highlight submenus.
-

3. Press™  toselect.

4.  Enable and configure submenus.
- N

5. Press Gl to save setting and return to Run Screen.

to view the 25 most recent sensor logs
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Notes:

Data Logging Menu

Diata Logging (Enabled)

Logging Interval {1Hours)

Temperature values are stored in °C regardless of display format.

Aux digital “closed” is logged as Aux 0.00. Aux digital “open” is logged as
Aux 1.00.

The 5400 sensor log records 0.00 resolution for aux analog inputs regardless
of the selected display format.

DO values are stored in mg/l & %Sat regardless of selected display format.
Sensor logs record the default system name and not the user configured
system name.

Aux temperature values are not accessible at the 5400. Temperature values
can only be obtained using AquaManager. Values will be shown in the Aqua-
Manager data log in °C regardless of the selected display format. Temperature
values are only available and stored for temperature systems assigned to a
DO system.

Changes to the data logging interval take effect after the expiration of the
interval being changed. Example - if the interval is changed from one hour to
one minute, one minute logging will begin after the expiration of the current
one hour interval. Power cycle the 5400 to make a change to the data logging
interval occur immediately.

E—
Menu configurations are saved to the system by pressing Glllildl to return
to the Run Screen and not when the change is made in the menu. Excep-
tion - Date and time and clear data logs are updated immediately to the

system, not when Gl is pressed.

The sensor log contains values for all sensor and aux systems regardless if the
system is disabled.

5400 sensor log values for disabled systems and systems without sensors are
not valid.

4 12/18/2008 10:22:07 AM
Time Units (Hours) DOT8.15 mol. 38.49 %
DO2: 7.82 mgl, 94.59 %
DO3: 7.82 mgl. 94.66 %%
DO4: 3,80 mgl. 46.00 %%
AX1-5.01AX2:-6.01
AX3:0.00 AXd: nan

4 AX5 nanAXE: nan

-1 [ .- T T T 1

In the above sensor log screen shot Aux 3 is assigned as temperature for DO 1. DO
4 and Aux 1, 2, 4, 5, & 6 are disabled.
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Event Logging

Menus > System > Data Logging > Event Logging

Control, Alarm, and Timer relays assigned to 5400 systems create events when they
turn on and off. In addition, AC power failures, ethernet device error messages,
and slave network failures are create events. These events are stored in the Event
Log. Event logs identify the 5400 system, are time and date stamped, and record
relay the action (“on” or “off”).

1. Enter Event Logging menu
Menus - System > Data Logging > Event Logging

A

2. Use ¥ to scroll and highlight submenus.

|
3. Press”  to select.

4 Press Disabled|@Enabled

to turn off or on.

5. Press

@l¥ to save setting and return to Run Screen.

to view 25 most recent event logs.

I to view active (“on”) non timer events. See Control Menu - pagel52
for additional information.

Notes:

- The General Alarm does not create an event whether a general alarm relay is
enabled or not.

- Events are not recorded when relays de-energize due to system-wide events.
System-wide events include calibration, Svr Hold, factory resets, power cycle,
30 second sensor system reset, relay test, and disabling systems.

- Event logs record the default system name not user configured system
name.

- Eventlogs do not record relay number or user configured relay name.

- Auxanalog (non temperature) events will always display “alarm” regardless if
alarms are enabled, see below screen shot on left.

- Auxdigital events will never display “alarm” regardless if alarms are enabled,
see below screen shot on right.
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Fuvantl| nne

Felay Off Felay Off

i 0:
0f 03/25/2010 10:07:49 AM 0F 03/25/2010 12:18:2TFM
o Swstem: nf System:
o] AUKE o] AuUxZ
i Sub System: 0 Sub System:
Alarm Low Digital
Y Event: 0y Event:
0 i
0

Clear Logs

Menus > System > Data Logging > Clear Logs

Use the Clear Log option to permanently delete all event and/or sensor log records
from the 5400.

Before permanently deleting sensor and event logs, poll all data using AquaManager.
AquaManager will store all logs in PC database.

Ml Events
Data and Events

1.  Enter Clear Log menu
Menus > System > Data Logging > Clear Logs

A

2. Use and \/ to scroll submenu.

!

3. Press  toselect.

4. The instrument will prompt, “Are You Sure?” Press one of the following
softkeys to confirm: EEI

5.  Selecting “Yes” automatically deletes logs and then returns to the Run
Screen after approximately three seconds.

6.  Selecting “No” or “Cancel” does not delete logs and returns to the Data
Logging menu.

@ o save setting and return to Run Screen.
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@ Notes:

Logs cannot be deleted from the 5400 instrument using AquaManager.
Calibration and Configuration logs cannot be cleared from 5400.

Date/Time
Menus - System -> Date/Time

It is important to configure the correct date and time in the 5400. Four 10-event
daily timers and four feed timer run based on the 5400 date and time. Logs record
events based on the 5400 clock. Date and time display formats are user defined.

Date/Time Menu

Set Date Farmat (DD}

Set Date (10/01/2007)

Set Time Format (12 Hour)
Set Time (07:06:35 PM)

1. Enter Date/Time menu
Menus - System > Date/Time

2. Verify 5400 current date and time.

3. Ifnecessary, use A and 'Y toscroll and highlight submenus.
4. Press = to select.

5.  Configure submenus.

-y
6. Press Gl to save setting and return to Run Screen or press
to System menu.

Notes:

Changes to Date and Time menus take place immediately and are saved prior

to .

Configured date and time formats are carried throughout menus and logs.
Any active (with energized relay) timer system, including 10-event daily tim-
ers, feed timers, and/or dosing timers, are NOT recalculated when the 5400
time and/or date is changed. Once a timer relay has been energized, it runs
for the duration and does not reset based on changes to the 5400 date and
time. Example - timer 1, event 1 is configured to come on at 9:00am for 10
minutes. Timer relay energizes at 9:00am. At 9:05am the 5400 time is changed
to 10:05am (for daylight savings adjustment). The timer relay will de-energize
after five additional minutes. The 5400 time will be 10:10am. The event log will
reflect the configured 5400 time when the event occurred. In this example,
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9:00am for the start and 10:10am for the end.

- The time must be manually changed for daylight savings time adjustments.
Daylight savings note: Sensor data log records are not overwritten when the
clock is changed unless the instrument is power cycled after changing the
data and time. Example - the data log interval is set to 15 minutes. Current
instrument time is 6:00 am. The clock is adjusted to 5:00 am for daylight
savings time. The 5400 sensor log contains four 15 minute interval records
from 5:00 am to 6:00 am from prior to time change. Sensor data logs are not
overwritten with new values for the repeat of 5:00 am to 6:00 am 15 minute
intervals unless the instrument is power cycled.

—
- Menu configurations are saved to the system by pressing il to return to
the Run Screen and not when the change is made in the menu. Exception -
Date and time and clear data logs are updated immediately to the system, not

- N
Exit Menul

when is pressed.
Display Settings
Menus > System > Display Settings

Sensor and Aux conditions are displayed at the Run Screen. Use the Display Set-
tings menu to configure how many systems display on one page at the Run Screen.
Up to six systems can be displayed on one Run Screen page. Multiple Run Screen
pages scroll at user configured speed (1-65535 seconds).
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Display Settings Menu

1. Enter Display Settings menu
Menus > System - Display Settings >Display Format

2. Use ® and ¥ toscroll and highlight submenus.

i
3. Press to select.
4,

" .
Sl to save configuration and return to Run Screen

Notes:

- At 1x2 & 2x2 display settings, analog aux values over 7 digits will overlap on
to the adjoining sensor window. Adjust aux display format to lower resolu-

tion.

- Because of font limitations, 1X2 and 2X3 display formats do not show all
20 characters of a 20 character name. Typically only 13 characters are dis-

played.
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Updating 5400 Firmware

@ Like all microprocessor based instruments, it may be necessary to upload revisions
to 5400 firmware. Download new firmware using the Firmware Updater utility
in AquaManager. A serial RS232 connection is necessary to run the Downloader
program.

The instrument firmware may become corrupted if any of the following occurs
during a 5400 firmware update:

- Firmware Updater utility is closed;

- AquaManager is closed;

- RS232 cable is removed from 5200A or PC com port;

- power is disconnected from 5200A.

If the 5400 firmware becomes corrupted and is not updated properly, the instrument
will need to be returned to YSI.

Firmware Updater Directions

1. Wire RS232 connection. See RS232 Communication - page 63. (Disregard
if already using RS232 connection.)
Note:
Connect RS232 directly into slaves in order to upload firmware to slaves.
Disable slaves at the master to avoid slave failure alarms when uploading
- Menus > System > Communications > Network >Master.

2. Enable the Force Serial Port on 5400s wired and configured with an
ethernet device - page 96.

3. Verify that the baud rate in 5400 Communications menu is configured
to 115200.

4. From the AquaManager Explorer window, access the Firmware Updater
utility from the pull down menu: Tools— Instrument tools—>Update
Firmware.
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Configure PC com port number (1-8) in Firmware Updater program.

o When using USB-Serial Adapter, verify that the port number as-
signed during driver installation is the same port configured when

Access the YSI web site Downloads page at www.ysi.com to get the latest
Locate the YSI 5400 Firmware and save the file to a temporary directory

Within the lower left box of the Firmware Updater Utility window,
browse to locate the firmware file on local PC and then import it into

Select “Program Device” The following Firmware Updater message

5.

Note:

using AquaManager Firmware Updater.

6.

version of the 5400 firmware code.
7.

on your computer.
8.

the utility.
9.  Click OK at the import complete confirmation window.
10.

appears.
11.

Select “Yes” and the following screens will appear.

Configuring the 5400
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On instrument:

YS15200A4/5400 Bootstap Loader

Wersion: 085
Compiled Date: Aug 23 2007
Compiled Time: 12:40:13

Yersion Information

On PC:

12.

13.
14.

15.

The 5400 will reboot (power cycle) when firmware upload is com-
plete.

Select “ok” when this window appears

Verify version information to confirm downloaded code:
Menus - System - Version

If applicable, disable Force Serial Port configuration.

Notes:

During upload, 5400 systems are placed into Service Hold which de-energizes
any active systems including energized relays. See SVR Hold Menu - page
124 for additional information. No “oft” event is created for system relays
that de-energize when 5400 is placed in downloader. Systems are reset when
power is cycled after downloader.

All logs and unit configuration are retained when 5400 firmware is updated.
Display board code loads first, followed by control board code. The display
board screen flickers when display board code is loading. The display stops
flickering when the control board code is loading. The Firmware Updater
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progress bar will complete two full scrolls during firmware updating. Directions to Force 5400 into Downloader
- Total download time is approximately nine minutes; eight minutes to up-
load display board firmware and about one minute to upload control board A 1.  WARNING: Disconnect external power to 5400. (AVERTISSEMENT :
firmware. déconnectez 'alimentation externe de l'unité.)
@ - Autopoll must be shut down when firmware is uploaded to 5400. 2. Open front panel - page 40 .
3. Depress reset button on I/O board (see figure below) and hold down the
Firmware Updater Messages enter key on the front panel. Use a paper clip or other sturdy piece of
wire to access the reset button through the I/O metal plate. Ensure that
The Firmware Updater program may respond with one of the following messages you are only touching the reset button on the I/O board and the enter
to indicate that the upload did not occur. key, then turn power on. The Downloader (bootstrap loader) screen

should appear on the instrument.
“Timed out” or “Could not find Unit” messages indicate a communication problem
between PC and 5400. Reconfirm Communication menu configuration, com port <_>
settings, and RS232 connections. (A power cycle will be required to access the

o . . « » o o @ e () 3
Communications menu.) Place 5400 in downloader mode again and select “yes” to c
retry at Firmware Updater error message window. If the upload is still unsuccessful, e 2
it is possible that the 5400 is not in downloader mode. See Force Downloader - on o g
this page. (] 1] £

o
(c] o g
g
8

when 5200A is powered. Serious damage can occur.

(>
(>

VAN

“Unit is Up-To-Date” indicates that the 5400 has most recent firmware and upload
is not necessary. 4.  Proceed with uploading firmware with Firmware Updater utility. See

Downloader - page 109.

General Alarm
Menus > System > General Alarm

The General Alarm triggers the buzzer, general alarm relay, general alarm icon, and
5400 emails. Sensor alarms, aux alarms, slave failure (networks), and low battery
alarms trigger the General Alarm when enabled. If individual system alarms are
not enabled, the General Alarm will not trigger.

Force Downloader

A status LED on the I/O Board must be visible to determine if the 5400 is in
downloader mode. The status LED flashes about 10 times in 5 seconds when in The General Alarm (buzzer, relay, emails, icon) remains active until one of the four

downloader mode. When not in downloader mode, the status LED flashes more

quickly about 15 flashes in 5 seconds. The led at the “status/reset” location of the SOﬁkeysw G QRN @R o, e front panelis pressed. Pressing one of

1/O Board indicates the current status of 5400 boards. the four softkeys while in the Run Screen stops the buzzer, de-energizes the General
Alarm relay, stops 5400 emails, and removes the General Alarm icon. Pressing one
of these keys also resets the sensor and aux alarm systems. If the alarm condition
still exists after Alarm Hold period(s), the General Alarm triggers again. Low bat-
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tery and slave failure alarms are not reset when softkeys are pressed.

Sensor alarm values set the acceptable control range. When a sensor reports a
value < low alarm value or > high alarm value, the alarm system becomes active
after the alarm hold off period. See Set Points, Control, and Alarms - page 128 for
additional information. If an alarm system is active and alarm relay is enabled, the
alarm relay energizes. See Aux Setup pagel32 for important aux control and alarm
system information.

Notes:

- The Run Screen must be displayed during normal operation. All alarm
functions (5400 email alarms, energizing of enabled alarm relays, alarm
icons, and buzzer) are suspended in 5400 menus. Alarm systems are reset
when menus are exited to Run Screen.

- The General Alarm system is disabled during system-wide events such as
service hold and downloader.

- Sensor and Aux alarms must be enabled to trigger the General Alarm.

Alarm Hold Off

Menus > System > General Alarm - Alarm Hold Off>Time Units

General Alarm Hold Off is the length of time the alarm condition must exist before
the General Alarm system becomes active.
Notes:
- To avoid alarms for spurious events set the Alarm Hold Off > than 0.
- Auxsystem alarms are triggered after the Aux hold off time, and not after the
General Alarm hold off time.
- Low battery alarm has a five (5) second hold off that is not user selectable.

Relay

Menus > System > General Alarm > Relay

The General Alarm relay can be wired and configured for any output device to
energize when the General Alarm system is active.

General Alarm Menu

General Alarm (Enabled)
Alarm Hold Off (15 Sec)

Time Units {Sec)
Relay (Enabled)(vYSN(Relay 1)
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Note:
- The General Alarm does not create an event log or control message regardless
if a General Alarm relay is enabled.

1.  Wire General Alarm devices - page 51.
Enter General Alarm Menu
Menus - System -> General Alarm

A

3. Use ¥ to scroll and highlight submenus.

!
Press ™ to select.
Enable and configure submenus.

—

Press Gl to save configuration and return to Run Screen.
Configure alarm, control values, and assign relays at Sensor Setup menus.
Menus > Sensor Setup - page 132.

NS U

Name Devices/Sensors

e

Menus - System > Name Devices/Sensors

Names can be user configured for the 5400 instrument, sensor, and aux systems,
and relays. System names are displayed at Run Screen, configuration, and control
messages menus. Relay and instrument names are displayed at configuration menus.
Default names are displayed when names are not user configured. 5400 default sys-
tem names are: DO1, DO2, DO3, DO4, Aux 1, Aux 2, Aux 3, Aux 4, Aux 5, Aux 6,
relay 1, relay 2, relay 3, and relay 4. Default names for Aux 2, 3, 4, 5, and 6 assigned
as temperature systems are Temp 1, Temp 2, Temp 3, and Temp 4.

Names can contain up to 20 characters.

Use AquaManager to easily configure names using the PC keyboard. See Aqua-
Manager On Line help.

Name Devices/Sensors Menu Name Devices/Sensors Menu
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=01 Al CATFISHNE

CATFISH NE po-z FLOW main pum

Alarm Low (Disabled)
Instrument (v 51)
& 1 D0

#

---x | Open
3

Menus

Control

1. Enter Name Devices/Sensors menu
Menus > System > Name Devices/Sensors
2. Use & ¥ toscrolland highlight submenus.
«
3. Press™  toselect.
()
4. Use keypad to configure name.
=

5. Press GllE to save configuration and return to Run Screen.
Notes:

User configured Aux system names only appear for aux non-temperature
systems. “Temp 1,” “Temp 2%, “Temp 3”, and “Temp 4” appear for aux 2, 3, 4,
5,and 6 when configured as temperature systems regardless if the aux channel
has a user configured name.

AquaManager users - Names uploaded in the temperature system name field
within the temperature system tab are displayed at the run screen, configura-
tion menus, and control messages menus.

Instrument, Aux & Sensor Names are not cleared at Reset to factory menus.
Relays names are cleared at “reset relays”, “reset all systems”, and “reset to fac-
tory/reset all” service menus.

The 5400 default system name is displayed at event, sensor, and calibration
logs, regardless if system name is user configured.

Press “Clear” at keypad and then press b to clear user configured
names.

Non temperature aux system names can also be configured at: Menus - System
> Configure Aux >Aux 1-6>Probe Name

Because of font limitations, 1X2 and 2X3 display formats do not show all
20 characters of a 20 character name. Typically only 13 characters are dis-
played.

The instrument name is not shown at Run Screen. The instrument name is
shown at relay enable menus.

Certain menus (i.e. configure aux) display up to 18 characters of the device

« »

name. “.” is shown at the menu if the name exceeds 18 characters.
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Password
Menus > System > Password

Enable and set the password in the password menu. Once the password is enabled
and saved, 5400 system menus are not accessible without first entering the correct
password at the Run Screen. The password can contain up to 12 characters.

Password Menu

1.  Enter Password menu
Menus > System > Password

A

2. Use® and 'Y toscroll and highlight submenus.

._|
3. Press™  toselect.
4. Enable and configure submenus.

o= .
5. Press Gl to save configuration and return to Run Screen.

Notes:

is not password protected.

displays at Run Screen when password is enabled.

Power Fail Menu
Menus > System > Power Fail

In the event of AC power failure, an AC version instrument’s power switches to
DC if properly wired. The switch from AC to DC power is automatic and does not
require 5400 configuration. Enable Power Fail AC Monitor to generate event when
AC power fails and is restored.
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Power FailMenu

Fower Fail System (Enabled)

Monitor (Enabled)
Low Battery Manitor (Enabled)
Low Battery Trigger (15.00 Volts)

Disabling the Power Fail System will disable AC power events and disable the General
Alarm in the event of low battery for DC power. Disable Power Fail AC Monitor
when powering 5400 by a DC power source.

Enable Low Battery Monitor to trigger General Alarm in the event DC voltage is
< to low battery trigger. The Low Battery Alarm Hold Off time is five (5) seconds
and cannot be user configured. Once the low battery general alarm has been
acknowledged by pressing one of the 4 softkeys, it is not reset. See General Alarm
- page 113.

11478/2008 09:25:00 AM
Swstem:

Fower Fail System
Ewvent:
AC Power Restored

1. Verify AC and DC power supplies are properly wired and powered
- page 43.
2. Enter Power Fail Alarm menu and submenus
Menus > System > Power Fail

3. Use & ¥ toscroll and highlight submenus.
._l
4. Press”  toselect.
5. Enable and configure submenus
6. Press Gl to save configuration and return to Run Screen.
Notes:

- Press to view AC power fail events.

- . icon at Run Screen indicates that the 5400 DC power is > Low Battery
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Tﬁger value with Low Battery Monitor enabled.

icon at Run Screen indicates DC voltage < the Low Battery Trigger when
Low Battery Monitor is enabled.
- Low battery alarm is not reset when front panel softkey is pressed.
- AC power fail does not generate a general alarm.

Serial Number
Menus > System > Serial Number

The serial number is displayed at the serial number menu. The serial number is
required when contacting YSI customer service. The serial number is also neces-
sary to configure AquaManager. 5400 serial numbers begin with “54-"followed by
seven digits. Serial numbers are generated at the factory and cannot be changed
by the user.

System Menu

General Alarm

Mame Devices/Sensors
Fassword

Fower Fail Alarm

Serial Number (53-11
Service

Service Hold (Disahbled)
Wersion

Service
Menus > System > Service

The Service menu includes submenus to configure and Reset Clean Probe timer,
Reset Systems to factory defaults, and test Relay(s).

Service Menu

Fieset Clean Probes
Feset To Factory
Relay Test

YSI 5400
119



Configuring the 5400

Reset Clean Probes

Menus > System -> Service-> Reset Clean Probes

Enable clean probe timer, configure the duration, and reset clean probe days remain-
ing from Reset Clean Probe menu. Selecting reset at this menu resets clean probe

timer to the user configured value. icon displays at Run Screen when the

clean probe timer expires.
Clean Prabes Menu

Duration (0 Days)
Feset

Reset Clean Probe timer at the menu or at the Reset Clean Probes menu.

Messages Menu

Calibration Logs (1)
EventLogs (0)
Sensor Logs (232)

Fieset Clean Probes

When prompted “Are you sure?”, select “Yes” to reset the clean probe timer to the
user configured number of days.

Reset To Factory

Menus - System -> Service-> Reset To Factory

The Reset to Factory menu allows resetting of some or all of 5400 systems to factory
defaults. Example - if Clean Probe Timer is user configured to 60 days, performing a
factory reset will reset the Clean Probe Timer to 90 days which is the factory default
setting and not the user configured value. See Appendix B Menu Maps - starting on
page 187 for factory default settings for all systems.
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Al

Fieset Sensars
Fieset Timers

Notes:

“Reset All” and “Reset All Systems” resets time format to 12 hour and date
format to MMDDYYYY.

- It is strongly recommended that user configuration be maintained in a log
by the user.

- Instrument, aux, sensor, and suffix names are not reset at any reset to factory
menus. Relay names are reset at “reset relays” and “reset all” menus.

- Control icons and control menu messages are displayed for 30 seconds after

pressing @y from reset to factory menus for any system that was active
(energized relay) prior to factory reset.

Reset All

Menus > System -> Service-> Reset To Factory> Reset All
Resets all systems, sensors, and timers to factory defaults.

A

1. Use® and 'Y toscrolland highlight submenus.

._|
2. Press”  toselect.
3. When prompted, “Are you sure?”, select one of the following to confirm,

4. Press Gl to save configuration and return to Run Screen.
Notes:
- Display contrast, backlight timer, and buzzer can only be reset to factory
defaults through this menu.
- Sensors will need calibrated after performing a factory Reset All and/or Reset
Sensor.
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Reset System

Menus - System - Service-> Reset To Factory-> Reset System

Specific systems or all systems in the Reset System menu can be reset to factory
defaults.

Reset System Meanu

Frohes
Feset Data Logger
Feset General Alarms
FiesetPassward
Reset Relay Names
Feset Service

A

1. Use® and 'Y toscrolland highlight submenus.

._|
2. Press™  toselect.
3. When prompted, “Are you sure?”, select one of the following to confirm,

4. Press Gl to save configuration and return to Run Screen.

Reset Sensors

Menus - System - Service> Reset To Factory-> Reset Sensors

Specific sensors, aux system, or all sensor and aux systems listed in the Reset Sensors
menu can be reset to factory default.

Reset Sensors Menu

Reset DO
FesetpH

Feset ORP

Reset Conductivity
Feset Temperature
Feset ALK

Feset AUX 2

A

1. Use® and ¥ toscroll and highlight submenus.

«
2. Press™  to select.
3. When prompted, “Are you sure?”, select one of the following to confirm,
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4. Press @l to save configuration and return to Run Screen.

Note:
- Perform a sensor calibration after resetting a sensor to factory default.

Reset Timers

Menus - System > Service-> Reset To Factory> Reset Timers

A specific timer, feed timer, or all timers listed in the Reset Timers menu can be
reset to factory defaults.

Reset Timers Menu

FesetAll Timers
Reset Timer 1
Reszet Timer 2
Feset Timer 3
Feset Timer 4
Reset Feed Timar 1

A

1. Use® and 'Y toscrolland highlight submenus.

«
2. Press”  toselect.
3. When prompted, “Are you sure?”, select one of the following to confirm,

4.  Press @il to save configuration and return to Run Screen.

Relay Test

Menus > System > Service-> Relay Test

Use the Relay Test menu to verify peripheral devices are wired correctly. Entering
this menu turns off any active relays and disables any sensor, aux, and timer system
relays from energizing regardless of value or condition. Systems are not reset when
the Relay Test menu is exited. To reset systems after exiting the Relay Test menu,
power cycle the 5400. Example - an energized conductivity low control relay (nor-
mal mode) is de-energized when entering the Relay Test menu. If the conductivity
value is in control low range when the Relay Test menu is exited, the relay will not
re-energize until the system has a change of condition. The conductivity system
must reach setpoint and then fall in low control range again before the control low
relay is energized. Itis strongly recommended to turn the power off, then on, at the
5400 after exiting the Relay Test menu.
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Relay Test

Fel 1(0n)|
Relay 2 (Off)
Relay 3 (Dff)
Relay 4 (0ff)

o
1. Press™ totoggle relay on.

s
2. Press”  totoggle relay off.

- N
3. Press Gl to save configuration and return to Run Screen.
Note:

- Timer and control icon(s) remain at the Run Screen until the system is reset.
Example - the timer icon remains at systemwide location until the end of
the timer cycle that was stopped when the relay test menu was entered even
though the relay is not energized. To reset systems after exiting the Relay Test
menu, power cycle the 5400.

Service Hold

Menus > System > Service Hold

Pressing at the Run Screen puts the 5400 into Service Hold. The Service
Hold time is user selectable (1-255 sec, min, or hours). Service Hold turns off any
active relays and disables any sensor, aux, and timer system relays from energizing
regardless of value or condition. 5400 alarm emails are not sent during service hold.
After the service hold time expires or is cancelled, the sensor systems are reset after
30 seconds. Timer systems are not reset. See Service Hold Menu - on this page for
additional information.

Service Hold Menu

Servic
Time Units (Min)

1. Use® and 'Y toscrolland highlight submenus.
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e
2. Press”  toselect.
3. Enable and configure submenus.

4.  Press

WP to save configuration and return to Run Screen.

Version

Menus > System ->Version

The Version menu contains information about the 5400 including: display and
control board firmware code version, control board temperature, and AC and DC
voltage.

Notes:

- Firmware version information is required when contacting YSI support.

- The clock chip temperature range starts at 0°C. Values < 0°C are not valid
numbers.

- Firmware date and time compilation are displayed below the version number
information.

- The normal operating range temperature will be a few degrees above ambi-
ent.

- AC powered units will run at a higher temperature than DC powered units.

Erit Menu

- To view current AC and DC power values to return to the Run

Screen and then return to menu. Power information does not refresh when
version menu is open.

Display Board 0.35
Contral Board 0.35
Compiled Date Aug 23 2007
Compiled Time 12:51:05
Unit Temp 36.0 C (36.80 F)
Fower 0.72v
Battery 13.27v

AquaManager and the System Menu

AquaManager users can configure most 5400 system menus from a PC. After polling
the 5400, use “Systems Management” from the node window to view and upload
5400 configuration. System menus are configured at the Setup and Input tabs.
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Notes:

il

@ -

Always manually poll the 5400 after uploading configuration changes and
verify uploaded information is retained. When configuration changes are
uploaded using AquaManager at the same time configuration changes are being
made by a user in the menus on a 5400 instrument, the AquaManager uploads
may not be saved depending on the timing of keystrokes at the 5400.

The Run Screen must be displayed during normal operation. If the 5400

is not at the run screen during AquaManager uploading, pressing
the 5400 will only save certain configuration changes.
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See Chapter 5 AquaManager - page 160 and AquaManager online help for additional
information.

Sensor Setup

Menus - Sensor Setup > Aux 1-6
> DO 14

Aux, DO, and temperature system set points, control, alarm, and relays are configured
in the Sensor Setup menu. Configure control and alarm values based on conditions
to maintain desirable water quality for your water system.

Aux non temperature systems operate differently than aux temperature and DO sen-
sor systems. See information beginning on page 132 regarding aux systems setup.

Sensor Setup Sensar Setup

ALK 3 (Dizabled)(4/20ma)

A

{ )

) ALY 4 (Disabled)(4/20ma)

AlUX 3 (Disabled){4/20ma) ALY 5 (Disabled)(4/20ma)

AU 4 (Disabled)(4/20ma) AU 6 (Disabled)(4/20ma)
AUX 5 (Disahled)(4/20ma) DO-1(Enahled)
AU 6 (Disablad)(4/20ma) DO- 2 (Enahbled)

DO - 1(Enabled)

DO - 3 (Enahbled)
DO - 2 (Enabled) )

Values and conditions at sensor and aux device locations are processed by the 5400.
Systems (alarm and/or control) become active and inactive based on user configura-
tion. Eight onboard relays can be assigned for control and alarm devices. Enabled
relays energize when a control or alarm system is active. Example - DO sensor (input)
reports a 5.4 mg/L value and relay #3 (output) is enabled for DO range low 2 when
value is < 5.5 mg/L. An aerator is wired to relay #3. The aerator wired to relay #3
energizes until the 5400 receives a DO sensor reading > set point value.

Notes:

- For normal operation, the 5400 must be at the Run Screen. Alarm func-
tionality (email alarms, activation of assigned alarm relays, alarm icons,
and buzzer) is suspended when 5400 is not at Run Screen.

- Sensor system must be enabled in order to display values at Run Screen.
Control and/or alarm relays will not energize regardless of value if the
sensor system is disabled.

- Thereis a 30 second delay at power up before control, timer, and alarm systems
become active.

- There is a 30 second sensor system hold off when sensor configuration is
changed. See 30 Second Sensor System Hold Off - page 131.
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- Calibrate sensor prior to use. See Calibration - page 77.

- “Over” and “Under” readings are displayed at the run screen when DO sensor
is measuring outside it's operating range - see DO range specification - page
14. DO control and alarm functions including relays are suspended when a
sensor is reading “Over” or “Under”

- “Over” and “Under” are not displayed for aux temperature systems when tem-
perature values are outside the temperature operating range - see Temperature
Range Specification - page 15. Temperature system controls and alarms will not
operate correctly when values are outside the temperature operating range.

- DO “Over” and “Under” readings most likely indicate that the sensor needs
serviced or replaced, or a bad probe/cable connection.

- See Menu maps - page 187 for system defaults and ranges.

- One relay can be assigned to multiple systems. It is essential that the relay
configuration be verified in order to avoid conflict of operation of wired relay
devices. Assigning one relay to multiple systems can result in invalid operation
of 5400 if set points and alarm values are not properly setup.

Set Points, Controls, and Alarms

Understanding how Set Point, Control, Alarm, and Alarm Hold Off values are
processed by the 5400 is necessary to properly configure the instrument.

Set Points

Configure the Set point (DO and temperature systems) to the ideal value the system
sensor should operate at.

Control Values

Range low and Range high values set the acceptable sensor reading range for the water
system. Control system(s) do not become active when value(s) are within acceptable
control range. See figure 4.8 - page 130. Enabled control relays energize when the
sensor reports a value < the range low control value or > range high control value.
Control relays are typically wired to devices used to raise or lower water conditions
to meet control ranges for a particular sensor reading, i.e. DO. Control relays remain
energized until the sensor reports a value < low control set point or > high control
set point value. Exception - See timed mode for temperature high control.

Sensor low control range starts at -1 significant digit below set point value. High
control range starts at +1 significant digit above set point value.

Notes:
- DO systems have two control ranges. They are referred to as range Range Low
1 & 2 and Range High 1 & 2.
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- Control systems remain active when the user is in 5400 menus.
- Control icons display at the Run Screen when relays are energized - see Icons
- page 71.

- Press at Run Screen to display active sensor and aux system relays.

- Press at Run Screen to display events created by control and alarm
relays - see Event Log - page 104.

- Control relays are not energized if the 5400 DO sensor value reads “Over”
or “Under”

- “Over” and “Under” are not displayed for aux temperature systems when tem-
perature values are outside the temperature operating range - see temperature
range specification - page 15. Temperature system controls will not operate
correctly when values are outside the temperature operating range.

- See Wire Relays - page51 for information on wiring control output devices.

Alarm Values

Alarm values set the acceptable control range. Alarm system(s) do not become
active when values are within acceptable control range. See figure 4.8 - page 130.
Alarm system(s) becomes active when value is < low alarm value or > high alarm
value. Enabled alarm relays energize if alarm condition exists for the general
alarm hold off time. Alarm relays are energized until one of the four softkeys

) G @ GEm pressed regardless of sensor value. Pressing one

of four softkeys resets the alarm system. Alarm systems become active again if, after
the alarm hold off period has passed, the alarm condition still exists. Alarm hold
off is configured in the General Alarm menu.

When the General Alarm is enabled, (with or without enabled relay), the general
alarm system becomes active when any system alarm is active. See General Alarm
- page 113.

Sensor low alarm range starts at -1 significant digit below low control value. High
alarm range starts at +1 significant digit above high control value.

Notes:

- Itisimportant to keep the 5400 at the Run Screen during normal operation.
Alarm functionality (email alarms, activation of enabled alarm relays, alarm
icons, and buzzer) is suspended when 5400 is not at Run Screen.

- Alarm icon(s) display at the Run Screen when alarm condition(s) exists for
longer than the general alarm hold off time. See Icons - page 71.

- Press at Run Screen to display active sensor and aux system relays.

to display events created by control and alarm relays - see Event Log
- page 104.
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- Alarm relays are not energized if the 5400 DO sensor value reads “Over” or
“Under”

- “Over” and “Under” are not displayed for aux temperature systems when tem-
perature values are outside the temperature range specification - see tempera-
ture range specification - page 15. Temperature system alarms will not operate
correctly when values are outside the temperature range specification.

- See Wire Relays - page 51 for information on wiring alarm output devices.

Figure4.8 shows how the 5400 operates based on a sensor setup configuration
example. DO range low 1 and range low 2 devices will energize at < 5.0 and <4.0
respectively. The alarm low system becomes active at <3.5.

Temperature have 1 Control Range
DO has 2 Control Ranges

DO Range #:
Range #1
Acceptable
[~ Operating™ | i
Low Range High
Alarm \ / \ Alarm ]
Lower ON ON Higher
Parameter Parameter
Values | Values
Low Low Low  optimal  High  High High
Alarm Range#2 Range#1 Setpoint Range #1Range #2 Alarm
Setpoint ON ON Value ON ON Setpoint
3.5mg/I 4.0 5.0 8.1 85 87 8.9

Figure 4.8

Validation Error and Autofix

When an invalid value is entered at the numeric keypad a Validation Error window
displays. An invalid value is either a value outside the range of the sensor system
or a value that breaches other settings within the sensor system. Autofix occurs
when a high or low control value is entered that breaches the set point value. See
the following examples

Low range control value must be < set point low value. High range control value
must be > set point high value. Low alarm value must be < low control value. High
alarm value must be > high control value.

Example 1 - entering “63” for DO set point results in validation error because the
valid range for the DO sensor system is 0.00 to 60.0 mg/l. User must configure
value within valid range. In addition, the value cannot breach respective control
and alarm system values.
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Example 2 - configuring set point value of 8.00 mg/L with range low value of 8.00
mg/] results in validation error. Valid set point range is displayed at validation error

display. Press to return to numeric keypad to enter valid value.

N 1kdann
ValidationErr

4 Thevalue entered (8.00)is out
of Range. It should be between
8.01and 60.00

Autofix occurs when a high or low control value is entered that breaches the set point
value. Autofix changes the high or low control value by one least significant digit
away from the set point value. The set point value is never adjusted.

Example 3 - Entering 8.00 mg/L as the range low value when the set point value is
8.00 mg/L results in an auto fix of the control value. The invalid control value is

displayed at the sensor setup menu. Pressing ¥ is not an option after saving

avalue at numeric keypad. Press from the sensor setup menu to continue
with the autofix. A validation error window is displayed to show that the autofix has

occurred. Press to return to sensor setup menu. Verify that the autofixed
values are configured for user’s specific application and reconfigure as necessary.

30 Second Aux and Sensor System Hold Off

Exiting aux and sensor menus after making certain configuration changes places the
system in a 30 second hold. During the 30 second sensor hold, control and alarm
systems are not active. System(s) becomes active, if, after 30 seconds, the values are
reported in control or alarm range. This 30 second hold off allows sensors time to
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stabilize before control and/or alarm systems become active.

Example - DO sensor menu is entered and the control high set point value is changed

while a control relay is energized. When ¥ is pressed to return to the Run
Screen, the DO control relay de-energizes regardless of sensor value. The control
relay re-energizes if, after the 30 second hold, the value is still in control range.

Reconfiguration of the following does not place the system in 30 second hold off:
- All systems - enable/disable alarms;
- DO systems - display format, probe type, membrane type, ppt, elevation, temp
source, temp display format, low alarm set point;
- Temperature system - display format, chiller on time, chiller on time units,
chiller hold off time, chiller hold off time units , set points, enable/disable
control relays.

Notes:

- Configuration changes place only the system that has been reconfigured on
30 second hold.

- No “oft” event log is created when energized system relays de-energize due
to 30 second sensor hold off.

- Control icons and control messages continue to display during the 30 second
sensor system hold at the Run Screen regardless if relays are energized.

- Enabling certain control/alarm functions when system value is in control/alarm
range requires that the 5400 be power cycled in order to reset the system to
properly control/alarm for current condition.

Non Temperature Aux Setup

Menus > Sensor Setup > Aux 1-6

Aux systems control/alarm on (digital), control/alarm high, control/alarm low (ana-
log), hold off, and relay settings are configured in the Sensor Setup menu. Before
configuring Aux Sensor Setup menus, configure the Aux input type at the system
menu. See Configure Aux - page 97 Menus > System > Aux Configuration 1-6
menu. Aux Sensor Setup menu selections are based on Aux input type configured
at system menu.

Notes:

- For normal operation the 5400 must be at the Run Screen. Alarm func-
tionality (email alarms, activation of assigned alarm relays, alarm icons,
and buzzer) is suspended when 5400 is not at Run Screen.

- Thereis a 30 second delay at power up before control, timer, and alarm systems
become active.
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- There is a 30 second sensor system hold off when a sensor configuration is
changed. See 30 second sensor system hold off - page 131
- See Menu maps - page 187 for system defaults and ranges.

Aux Relay

Aux systems work differently than other sensors in regard to control and alarm
functionality because only one relay can be assigned to aux systems. In addition,
there is no set point for non temperature analog aux systems. Eight onboard relays
can be assigned for either aux control or alarm devices.

Notes:

- The menu will display energized aux relay only when alarms are
enabled.

- Analarm icon is displayed at the Run Screen only when alarms are enabled.
If alarms are disabled and an aux relay is energized, there is no icon at the aux
system on the Run Screen.

- Onerelay can be assigned to multiple 5400 systems. It is essential that the relay
configuration be verified in order to avoid conflict of operation of wired relay
devices. If not configured properly, assigning one relay to multiple systems
can result in invalid operation of 5400.

- Eventlogs are created when an aux relay energizes and de-energizes regardless
if alarms are enabled.

- Aux alarms must be enabled to trigger General Alarm.

- General Alarm may still be active even though aux system is no longer in alarm.
See aux relay information below and General Alarm - page 113.

Aux Hold Off

Aux Hold Off (user configured) is the length of time the control or alarm condition
must exist before the Aux relay energizes.

Notes:
- To avoid control or alarm for spurious events, configure the Alarm Hold Off
> than 0.
- If General Alarm is enabled, it is triggered after the Aux hold off time and not
the general alarm hold off time.

Digital

Configure digital control/alarm (open/closed), relay, alarms, and hold off in the Aux
1 - Aux 6 Sensor Setup Menu. Use digital input type for triggering relay to energize
based on either a switch open or switch closed condition. Enabled relay will energize
based on the condition configured in the control/alarm on menu.
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Aux Relay Digital

When enabled, Aux digital relay energizes when configured control/alarm on condi-
tion occurs. Aux relay energizes after configured aux hold off time. When alarms
are disabled and as long as control/alarm on condition exists, the relay remains
energized including when menus are entered. Relay de-energizes when the non
control/alarm condition is processed by the 5400 regardless if alarms are enabled.
If alarms are enabled, the relay also de-energizes when one of the four front panel

softkeys D G @ G pressed. Pressing one of four softkeys

resets the alarm system. The Alarm system becomes active again if, after the aux
hold off period, the alarm condition still exists.

Aux digital events (event log) are identified by aux number, input type (digital),
relay condition (on/off), and do not identify digital condition (open, or closed).
Aux digital events are not identified as control or alarm events regardless if alarms
are enabled.

Configure Aux 1-6 digital input type:

AUX 1Menu

Frobe (Enahbled)
Alarm On (Closed)
Alarm (Enabled)
Hold Off (15 Sec)
Time Units (Sec)
Alarm Low (Not Available)
Alarm High (Mot Available)
Felay (Enabled)(Local Machine)(Rel...

Directions to Configure Aux (digital)

1.  Wire Aux digital devices - page 53.
2. Configure “digital” at Menus > System > Configure Aux >Input Type
3. Enter Aux 1-6 in Sensor Setup menu

Menus - System - Sensor Setup > Aux 1-6

eAY

4. Us to scroll and highlight submenus.

«
5. Press ™ to select.
6. Enable and configure submenus.

_ N
7. Press Gl to save configuration and return to Run Screen.
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Notes:

- At sensor log Aux (1:1.00 ) is reporting open condition. Aux (1: 0.00) is re-
porting closed condition.

- When in menus, an aux digital relay will energize when alarms are enabled
if in menus longer than the aux alarm hold off time and the control/alarm
condition is processed from an existing non control/alarm condition. The
general alarm will not trigger until the user exits to run screen, the control/
alarm condition is reset by processing a non control/alarm condition, AND
then a control/alarm condition is reproduced.

- Do not enable aux digital alarms when the sensor is in the control/alarm con-
dition. Enabling aux digital alarms when sensor is in control/alarm condition
can result in aux system not properly processing existing alarm condition.

Analog (0-1VDC, 0-5VDC, and 4-20mA)

Configure control/alarm low, control/alarm high values, relay, alarms, and hold off
time in the Sensor Setup Menu.

Aux Relay Analog

When enabled, the Aux analog relay energizes when either the control/alarm high
OR the control/alarm low value is processed by the 5400. The aux relay energizes
after the configured aux hold off time. When alarms are disabled and as long as
a value < the control/alarm low value OR a value > the control/alarm high value
is processed by the 5400, the relay remains energized including when menus are
entered. The relay de-energizes when a value > control/alarm low value OR a value
< control/alarm high value is processed by the 5400 regardless if alarms are enabled.
If alarms are enabled, the relay also de-energizes when one of the four front panel

softkeys () G @ G pressed. Pressing one of the softkeys

resets the alarm system. The Alarm system becomes active again if, after the aux
hold off period, the alarm condition still exists.

Non temperature aux analog events (event logs) are identified by aux number, relay
state (on/off) and report “alarm high’, or “alarm low” condition regardless if alarms
are enabled.

@ AquaManager identifies Aux analog events as control or alarm based on node

configuration.
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AUX 2 Menu

Frobe (Enabled)
Alarm On (Mot Available)
Alarm (Enabled)
Hold Off {15 Sec)
Time Units (Sec)
Alarm Low (B)
Alarm High (18]
F [Enabled)(Local Machinel(Rel

Directions to Configure Aux (analog)

1. Wire Aux analog devices - page 53.
Select “0-1v7, “0-5v”, or “4/20ma” input type at Menus > System -
Configure Aux >Input Type
3. Enter Aux 1-6 in Sensor Setup menu
Menus - System -> Sensor Setup->Aux 1-6

AV
e

4. Us to scroll and highlight submenus.

!
5. Press™  to select.
6. Configure submenus.

7. Press ¥ to save configuration and return to Run Screen.
Notes:

- Control/alarm high value must be < Max value. Control/alarm low value
must be > Min value. Min & Max values are configured in Menus -> System
> Configure Aux >Aux 1-6>Min/Max menu.

- Do not enable aux analog alarms when the sensor is in the control/alarm con-
dition. Enabling aux analog alarms when sensor is in control/alarm condition
can result in aux system not properly processing existing alarm condition.

Aux 3-6 (Temperature)

Menus - Sensor Setup->Aux 3-6

See Set Points, Control, and Alarms - page 128 before configuring temperature system.
Since most heaters and chillers have their own thermostats, their thermostats can
be used as a backup temperature control system. Set the heater thermostat control
several degrees above the desired temperature and the chiller thermostat control
several degrees below the desired temperature.
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Range High Timed and Normal Control

Temperature high control can operate in two different modes: normal or timed.
Temperature low control operates in normal mode only. In the normal mode, the
control relay is energized until the set point value is reached. For normal control,
configure chiller on time to 0. The chiller off time will be ignored.

In temperature high control timed mode, the control relay is energized for the
chiller on time, regardless if the sensor value has returned to the set point value.
Chiller off time is user selectable. To avoid chiller compressor damage, configure
the chiller hold off time to a value of eight (8) minutes or more. After the chiller
on time expires, the control relay de-energizes for the configured chiller off time.
After the chiller off time expires, the control relay will reenergize if the value is still
in control range. A chiller off time must be configured in the timed mode or the
control relay will never de-energize.

Notes:

- The Configure Aux menu will display temperature configured channels as
“disabled”. This is because aux systems configured as temperature channels
no longer function as analog aux channels, but rather function as a sensor
system.

- The Sensor Setup menu - page 138 is automatically enabled when an aux
channel is configured for temperature.

- Aux temperature readings are not accessible at the 5400. Temperature read-
ings can only be obtained using AquaManager. Readings will be shown in
the AquaManager datalog in either °C or °F based on the user configured
temperature display format.

- The Celsius temperature set point, control, and alarm values are configured to
the 10ths place. Fahrenheit values are configured to the 100ths place; however,
fahrenheit display values and temperature system operation are based on values
truncated to the 10ths digit.

- See 30 Second Sensor Hold Off - pagel31.

- Active sensor control timers are reset after systemwide events. Systemwide
events de-energize relays. Example - chiller on time is configured for an eight
(8) minute on time. Energized chiller (control down) relay de-energizes when
5400 goes into Svr Hold. The chiller on relay had been energized for three (3)
minutes before the Svr Hold occurred. The Svr Hold time is one (1) minute. If
the sensor is reporting control low condition after the service hold time period,
the chiller on time will be for eight (8) minutes and not the remaining five (5)
minutes of the chiller on time prior to entering Svr Hold.

- Temperature display format (°C or °F) is user selectable. Changing the tem-
perature units automatically adjusts set points to new temperature units.

- Temperature readings are stored in the sensor data log in °C regardless of
display format.
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- Temperature values affect DO readings. It is important that the temperature
sensor is reporting accurately.

- Control down relay (chiller) energizes for original “on time” if chiller “on
time” is reconfigured when relay is energized.

- When disabling an aux 3-6 that has been assigned to a DO channel as the
temperature source, be sure to reconfigure the user defined temp source or
enable another aux temperature source for that DO system.

Configuring the 5400

DO 1-4
Menus - Sensor Setup->DO 1-4

See Set Points, Control, and Alarms - page 128 before configuring the DO system.

Salinity and Temperature Compensation for DO Measurements

Configure AUX Menu

Al 1(Disabled)
AUX 2 (Dizabled)
41 isabled)
ALK 4 (Disabled)
AUX S (Dizabled)
AUXE (Dizabled)

Display Faormat (Celsius)
Chiller On {10 Min)
Time Units (Min)
Chiller Hald Off (& Min)
Time Units (Min)
Alarms (Disabled)
Alarm Low (23 5c)

Sensor Setup

AUX 1 (Disabled)(4/20ma)
AU 2 (Disahbled){4/20ma)
Temperature)
AUX A (Disabled){d/20ma)
AU 5 (Disahled){4/20ma)
AUX B (Disabled)(4/20ma)
DO-1(Disghled)
DO -2 (AAA)Enahled)

Relay (Disabled)
Range Low [24.0c)

Relay (Disabled)
Set Paoint (26.0c)
Fiange High (26.0c)

Relay (Disabled)
Alarm High (26.5c)

R 2

Directions to Configure Temperature System

In order to report accurate DO values, the salinity and temperature of the water
system must be known and compensated for. Each DO channel uses the temperature
value from the configured temperature sensor or from a user defined value entered
in the DO temperature source menu. For accurate DO mg/L readings, the salinity
value of the water being monitored should be entered as a ppt (parts per thousand)
value in the DO salinity menu.

Notes:
- Changes to salinity affect DO mg/L value.
- Changes to salinity do not affect DO % sat values.
- Itisnecessary to assign a temperature source or enter a user defined value for
each enabled DO system. Verify that the configured temperature value or as-
signed temperature sensor is accurate for the water system being monitored.

Two Range Controls for DO

Each 5400 DO sensor input has two low and two high control ranges. This dual range
allows for more control over oxygen levels in the water system. Example - DO range
low control one becomes active causing the air injection system wired/configured
to relay #1 to energize. DO levels continue to fall, activating range low control two.
The pure oxygen injection system wired/configured to relay #2 to energize.

1. Wire temperature sensor to 5400 I/O Board - page 47.
Configure “temperature” input type at
Menus > System > Configure Aux >Input Type
3. Enter Aux 3-6 in Sensor Setup menu to configure temperature sensor
setup
Menus - System - Sensor Setup->Aux 3-6
4. Use A 'V to scroll and highlight submenus.

«
5. Press ™ to select.
6. Configure submenus.

=
7. Press GUMEE to save settings and return to Run Screen.
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NE Catfish

Alarms (Disabled)

Frobe Type (PolarGraphic)
Membrane Type (Tetlon 1.0mil (Black)
Dizplay Format (mgfl and Sat)
Salinity (0 ppt)

Elevation (0 Feet)

Temp Source (User Defined)25.0c

NE Catfish

Temp Display Format (Celsius)
Alarm Low (3.50 mg/l)

Relay (Enabled)(YS[(Relay &)
Fange Low 2 (4.00 ma/l)

Relay (Disabled)
Fange Low (5.00 mg/l)
Relay (Enabled)(YS(Relay 7)

Set Paoint (800 mofl)
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NE Catfish

Relay (Enabled)(YS(Relay 7)
Set Point (B.00mg/l)
Fange High (8.50 mag/l)

Felay (Enabled)(YSi(Relay 6)
Fange High 2 (.70 mg/l)

Relay (Disabled)
Alarm High (9.00

nahle

Directions to Configure DO Systems

1. Install and wire DO probe(s) and membrane - page 47.
Enter DO 1-4 Sensor Setup menu and submenus to set up
Menus - System -> Sensor Setup>DO 1-4
3. Use A 'V to scroll and highlight submenus.

4. Press = to select.
5. Configure submenus.
Note:
- Verify temperature source or user defined temperature value accurately reports
the temperature for the DO sensor location - page 33.

6. Press Gl to save settings and return to Run Screen.

AquaManager and the Sensor Setup Menu

@ All Sensor Setup menus can be configured using AquaManager. After polling the
5400 node, use “Systems Management” to view and upload 5400 configuration.
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Notes
@ - Always manually poll the 5400 after uploading configuration changes and
verify that the uploaded information is retained. When configuration changes
are uploaded using AquaManager at the same time configuration changes are
being made by a user in the menus on the 5400, AquaManager uploads may
not be saved depending on the timing of keystrokes at the 5400.
@ - The Run Screen must be displayed during normal operation. If the 5400

is not at the run screen during AquaManager uploading, pressing
the 5400 will only save certain configuration changes.

See Chapter 5 AquaManager - page 160 and AquaManager online help for additional
information.

Timers

The 5400 has four daily ten event timers. Timers can be configured to control various
hardware devices. In addition, there are four Feed Smart™ feed timers.

Notes:

- Timer system must be enabled in order to energize the configured timer
relay.

- Ifatimer is active (relay energized), the timer is NOT recalculated when the
5400 time and/or date is changed. Once a timer has been turned on, it runs
for it’s configured duration and does not reset it’s run time based on changes
made to 5400 time. Example - Timer 1, event 1 is configured to come on at
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9:00am for 10 minutes. Timer relay energizes at 9:00am. At 9:05am, the 5400
unit time is changed to 10:05am (for daylight savings adjustment). The timer
relay will de-energize after five additional minutes. Unit time will be 10:10am.
The event log will reflect the unit time when the event occurred. In this ex-
ample, 9:00am for the start time and 10:10am for the end time.

If a timer is active (relay energized) and 5400 is put on service hold, the relay
will not reenergize after service hold expires regardless if timer time has not
expired. There is only one “on” time for all timers. Turn the 5400 off, then on,
to reset the timer system. A timer relay will energize for the configured time
duration and not for the remainder of time prior to service hold. Example -
timer relay 1 is configured to start at 11:00 am for one hour. Service hold is
enabled and configured for 5 minutes. The timer relay energizes at 11:00 am.
At 11:15 am, the 5400 is put into service hold. Timer relay 1 de-energizes.
At 11:20 am, the service hold time expires. The 5400 is power cycled and the
timer relay energizes after 30 seconds. The timer relay de-energizes at 12:20
pm and not at 12:00 pm which would have been the original off time if the
unit had not been placed in service hold.

Energized timer relays de-energize at downloader. The relay will reenergize
after a power cycle following the downloader if the timer system is still active.
Timer relay will energize for entire configured duration time and not for the
remainder of time prior to being placed in downloader. There is only one “on”
time for all timers. Example - timer relay 1 is configured to start at 11:00 am
for one hour. The timer relay energizes at 11:00 am. At 11:15 am the 5400 is
put into downloader. Timer 1 relay de-energizes. Timer 1 relay re-energizes
30 seconds after a power cycle following the downloader (at approximately
11:24 am). The timer relay de-energizes at 12:24 pm and not at 12:00 pm
which would have been the original off time if the unit had not been placed
in downloader.

If power fails when a timer is energized and the power is restored when the
timer system is still active, the timer relay will energize for the timer dura-
tion and not for the remaining original timer cycle. Example - timer one is
configured to start at 10:40 for one hour. The power fails at 11:30. Power is
restored at 11:35. The timer will energize for one hour, not the remaining 5
minutes of the original timer cycle.

When the timer relay is energized after the timer duration is changed, the timer
relay de-energizes and reenergizes for the newly configured duration and not
for the remaining original timer duration. Example - timer one is configured
to turn on at 8:30 am for 10 minute duration. Timer one relay energizes at
8:30 am. At 8:35 am, timer one duration is changed to 20 minute. Timer one
relay de-energizes at 8:35 am and re-energizes for the newly configured 20
minute duration.

When the timer start time and duration are reconfigured and fall within the
current 5400 unit time, the relay energizes for the entire duration. Example
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- The 5400 unit time is 8:30 am. Timer one is configured to turn on at 8:00
am for one hour. The timer relay will energize at exit to run screen and will
remain energized for one hour. The 5400 does not use the system clock to
calculate duration in this case. The following day, the relay will energize at
8:00 am, and de-energize at 9:00 am.

There is a 30 second delay at power up before timers become active.

Timer relay off times drift by < .2%. when duration is longer than 5 minutes.
The drift increases the relay ‘on’ time.

Timers 1-4
Menus > Timers->Timer 1-4

Configure up to 40 daily timer events using the 10 events of Daily Timer systems
1-4. Timer events occur on a daily basis until either the start time is cleared, the
timer system is disabled, or the relay is disabled. Timer icon displays at Run Screen
when timer relay is active. See Icons - page 71.

Configure Timer 1-4:

Timers Menu

Timer 2 (Enabled)
Timer 3 (Disabled)
Timer 4 (Disabled)

Timer 2 Menu

d) Timers (Enahled)
Relay (Enabled)(YE)(Relay &)

0 Min)|
Event 2 (11:00:00 AM)(15 Sec)

[
Feed Timer 1{Disabled) Ewent 3 (11:10:10 AM)(10 Min)
Feed Timer 2 (Disabled) Ewent 4 (12:00:00 PM)(20 Min)
Feed Timer 3 (Disabled) Ewent 5 (12:03:00 PM)(1Hours)
Feed Timer 4 (Disabled) Ewent 6 (00:00:00 AM)(15 Sec)

o Uk

.1 T . .- T T T 1

Install and wire timer devices - page 51.
Enter Timer 1-4 menu
Menus >Timers

A

Use & and ¥ to scroll and highlight submenus.

!
Press™  to select.
Enable and configure submenus.

-
Press Gl to save configuration and return to Run Screen.

Notes:

Press to display timer events.
Timer events with overlapping times occur as follows. Example - event 1 starts
at 10:15 for 25 minutes, event 2 starts at 10:25 for 25 minutes; relay turns on at
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10:15, relay turns off at 10:25, relay turns on at 10:25, relay turns off at 10:50. Feed Mode
- Configure “0” duration time to disable any of the 10 timer events.
- Timers configured over 86399 seconds (seconds in a day) are not valid. Continuous

Menus > Timers>Feed Smart Timer->Feeder->Feed Mode >Continuous

Feed Smart™ Timers 1-4

Menus = Timers->Feed Smart™ Timer 1-4 When the feed timer is configured for continuous feed mode, feedings occur through-
out the day. Feed duration and interval are determined by the daily total weight of
The 5400 has four feed timers. In order to configure feed timer(s) correctly, it is food, number of feedings, and test calibration data. Optional Sensor control and
important to understand how the 5400 operates based on the feed timer configura- FCR configuration can also effect feed duration.
tion. The Feed Smart™ Timer system must be calibrated prior to use. For proper
operation, the Feed Timer System requires the user to enter the total amount of Example of Feed Timer Configuration and Test Calibration Data:
food to be dispensed, number of feedings to dispense the food, and a defined time test callbration
. o 1s . . . Feed Mode data
period WIth_m which the feedings will occur. . Continuous (86500 seconds in 24 hours), daily weight daily feedings |10 units per 30
The Feed Timer can be set to operate for any or all days of the week and includes feed timer sensor control is disabled 500 units 100 seconds
continuous or timed feeding modes, FCR (feed conversion ratio), and sensor op- The 5200A determines feed duration and feed interval for the above feed cycle as follows:
tions. units fed per feeding: 500 + 100 = 5 units per feed
if 10 units feed in 30 seconds, then 5 units will feed in
The following definitions are used in regard to the Feed Smart™ Timer system: 15 seconds
- feed cycle - amount of time that all feeds occur in: feed time duration for each feeding: 30x5+10=15
- continuous - feedings occur 24 hours/day determine total time feed relay will be '
- timed - length of time between start and end time energized over 24 hour period: ;Zsuor:)ltsfszzo f:z:;; 15033§c(°ndsb Freeds) =540
. . . . - = += numboper ot reeds) =
- feed duration - length of time feeder relay 18 energlzed; determine feed interval: seconds, 60 = 14.15 minutes, or 14 minutes and 9
- feed interval - length of time between feedings.
Optional Sensor control reduces the amount of food dispensed if DO or temperature Notes:
measurements are “out of range” per user defined configuration. The FCR (feed - Once Continuous feed has been configured, the 5400 determines any remain-
conversion ratio) feature automatically computes and increases the daily amount ing feeds for the 24 hour period ending at 23:59. In continuous feed mode,
of food dispensed per FCR configuration. the feed cycle always begins at 00:00 (midnight). Start and End time fields
are not available for Continuous feed mode.
Notes: - In continuous feed mode, feeding(s) will end after the last completed feeding
- Itisimportant that the 5400 be configured with valid data. The feeder system that ends prior to 11:59 pm (23:59) of an enabled day when crossing midnight
will not operate properly if, for example, the daily weight of food is greater to a disabled day. Feeding(s) will resume at 12:00 am (00:00) for the next
than can be dispensed in the defined feed cycle. enabled day.
- Disable the feed timer system when changing configuration and/or when
performing a calibration. Enable the feed timer system after configuration Timed
changes and/or calibration has been done. The feed timer system recalculates Menus >Timers>Feed Smart Timer->Feeder>Feed Mode >Timed

duration and interval times based on the new configuration. Press
after disabling the feed timer system and before making configuration/cali-
bration changes.

Feedings occur only during the start and end times on “enabled” days of the week.
In timed mode, the 1st feeding occurs at the start time of the feed cycle. The last
feeding completes by the end time. Feed duration and interval are determined by
the daily total weight of food, number of feedings, and test calibration data. Optional
Sensor control and FCR configuration also effect feed duration.
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Example of Feed Timer Configuration and Test Calibration Data:

test calibration
Feed Mode data
Timed, Start Time: 8 am, End Time: 10A daily weight daily feedings |10 units per 30
feed timer sensor control is disabled 500 units 5 seconds
The 5200A determines feed duration and feed interval for the above feed cycle as follows:
units fed per feeding: 500 + 5 = 100 units per feed

FCR

Menus >Timers>Feed Smart™ Timer>Feeder>FCR

The optional FCR (feed conversion ratio) feature automatically increases the amount
of food dispensed over a feed cycle. The increase in the amount of food is based on
the user configured increase in biomass over a 24 hour period. Biomass and daily

if 10 units feed in 30 seconds, then 100 units will feed
in 300 seconds

feed time duration for each feeding: 30x10 = 300

Total feed duration over 2 hour period 300 seconds X 5 feeds = 1500 seconds

7200 seconds (seconds in 2 hours) - 1500 (feed
duration seconds for 2 hour) = 1140 seconds + 60 = 19

determine feed interval: minute intervals

Notes:

- If a timed feed cycle includes feed times that cross midnight, the feed cycle
ends prior to 11:59 pm (23:59) of the enabled day when crossing midnight
to a disabled day. Feeding(s) will resume on next enabled day. Example - if
Tues through Sat are enabled days and the start time is configured for 10:00
pm (23:00) and the end time is configured for 01:00. On a Saturday, the feed
cycle would start at 10:00 pm (23:00). The last feed occurs by 11:59 pm (23:59)
on Saturday since Sunday is a disabled day. The next feed occurs at 12:00 am
(0:00) on Tuesday. This feed cycle would end at 01:00 on Tuesday. No feeding
occurs Monday, because Monday is a disabled day.

- The Feed timer will not operate properly if the start date is set prior to Janu-
ary 1, 2007.

Daily Weight

Menus >Timers->Feed Smart™ Timer->Feeder->Daily Weight

The daily feed amount is the total weight of food that will be dispensed over the
feeding cycle. The value is user selectable from 1 to 100000. The Feed Timer system
divides the total daily feed amount by the number of daily feedings and uses the
calibration/test data to determine feed duration and interval times.

Daily Feedings

Menus >Timers>Feed Smart™ Timer>Feeder->Daily Feedings

Configure the number of feedings to occur in feed cycle. The value is user select-
able 1-255.
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(feed) weight amounts are adjusted by the 5400 prior to the 1st feed “on” time of a
scheduled feed cycle occurring after midnight.

Notes:
- With FCR enabled and properly configured an event occurs when the 5400
time crosses midnight. See below.

Feed Timer 1Menu

04 04/25/2008 12:00:00 A Biomass (.00 nz)

04 Bystam: Feed % Biomass (0.00 %)

0 EFeetdSmarl(tijlmeH Daily Waight {(-nan az)
vent: o

M Biomass FCR Factor (0.03 %)

04

04

]

Biomass

Menus >Timers->Feed Smart™ Timer>Feeder>FCR->Biomass

Enter the total weight of livestock being fed at the time FCR is enabled. The value
is user selectable 1 to 100000.

Feed % (of) Biomass
Menus >Timers->Feed Smart Timer->Feeder>FCR->Feed % Biomass

Enter the percentage of the total livestock weight (biomass) that will be used to
determine the daily feed weight. The value is user selectable 0.0-99.9%.

Daily (Feed) Weight
Menus >Timers->Feed Smart Timer->Feeder->FCR->Daily Weight

Configure the initial daily feed weight by multiplying the biomass amount by the Feed
% Biomass percentage (the 5400 will not calculate the initial amount). Example—
if the biomass is 1000 and the feed % biomass is 3%, the initial daily feed weight
amount is 30. On each following day, the 5400 will use the biomass value along with
the feed % biomass to calculate the new daily feed weight amount.

YSI 5400
147



Configuring the 5400

Note:
- The initial daily weight value must be calculated as described above. Config-
uring an invalid initial daily weight will result in incorrect biomass and daily
weight calculations when the 5400 crosses midnight.

FCR Factor
Menus >Timers>Feed Smart Timer->Feeder>FCR->FCR Factor

Enter the ratio of the amount of food required versus the corresponding increase
in fish weight (biomass). This value is used to automatically increase the biomass
amount—as shown in the example below.

FCR example

Day 1 Day2 Day 3 Day 4 Day 5 Day 6 Day 7
Biomass 1000 1020 1040 1061 1082 1104 1126
Feed % Biomass 3% 3% 3% 3% 3% 3% 3%
Daily Feed Amount 30 30.6 31.2 31.8 32,5 33.1 33.8
FCR Factor 1.5 15 1.5 1.5 1.5 15 1.5
1/FCRX Feed Amount 20 20.4 20.8 21.2 21.6 22.1 22.5
New Biomass 1020 1040 1061 1082 1104 1126 1149

Sensors
Menus >Timers>Feed Smart Timer->Feeder>Sensors
->Disabled/Enabled

>DO Low/High/DO % Change
>pH Low/High/pH % Change
>Temp Low/High/Temp % Change

Changes in water conditions affect the amount of food fish eat which in turn affects
fish growth. With the sensor feature enabled, the feed timer system will verify that
DO and temperature values are within user configured ranges. This verification is
done immediately prior to starting each feed duration in a feed cycle. If values are
reported that fall outside acceptable configured ranges, the feed timer relay energizes
for a shorter period (user configured percentage) thereby reducing the amount of
food that is dispensed. Feed timer sensor ranges are independent of sensor setup
configuration ranges. For timed feed cycles, feed interval for the entire feed cycle
is determined by the duration of the first feed.
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Feed Timer Sensor Menu

Feed Timer Sensor Menu

DO High (8.00 mo/l)
DO Change (2.00 %)
pH Low (6.00 pH)
pH High (8.00 pH)
pHChange [2.50 %)
Temp Low (23.0c)
Temp High {27.0c)
Temp Change (

DO Low (B.00 mg/l)
DO High (8.00 mg/l)
DO Change (2.00 %)
pH Low (6.00 pH)
pHHigh (8.00 pH)
pH Change (2.50 %)
TempLow (23.0c)

Example - The feed timer is configured as follows: sensor temperature low value
is 25.1°C, feed timer temperature change is 9%, timed feed mode, six feeds, daily
weight 2 units start time 8A, end time 9A, six 9.999 second feeds of .3333 units
each to occur at 9 minute 50 second intervals without sensor reduction. Prior
to 8A feed cycle, the start temperature value is reading 24.9°C. Feed duration of
9.999 seconds will be reduced by approximately 1 second (9%) because of the “out
of range” temperature value.

DO Low/Temp Low

Enter the lower limit of the sensor range where no feed reduction will take place.
DO High/Temp High

Enter the high limit of the sensor range where no feed reduction will take place.
DO Change/Temp Change

Enter the percent reduction in feed weight that will occur for “out of range” enabled
feed timer sensors. Results from all out of range sensors are added. To disable a
sensor value from affecting feed duration configure 0.0% as the % change for that
Sensor.

Calibrate
Menus >Timers>Feed Smart™ Timer->Feeder->Calibrate

Calibrating the feeder is essential for proper operation of the feed timer system.
Feed timer calibration is required to establish the amount of food dispensed over
a certain period of time. The 5400 will base feed cycle duration times on the last
saved calibration value.
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Feed Timer 1Menu

Feed Timer (Disabled)
FCR (Disahled)
Feeder

Sensors (Disabled)
Relay (Mot Available)
Units {oz)

Calibrate (0)(0 oz)

Calibrate Feed Smart™ Timer

1.
2.

3.

4.

5.

Install and wire feed timer device - page 51.

Enable Feed Timer.

Menus > Timers->Feed Smart™ Timer >Feed Timer >Enabled
Assign feed timer relay.

Menus > Timers->Feed Smart™ Timer >Relay

Calibrate feeder.

Menus > Timers->Feed Smart™ Timer >Calibrate

At numeric keypad, enter test run time the feeder relay will energize.

6. Press for feed timer relay to energize for configured run test
time. Countdown of relay “on” time is displayed.
7. When run time expires, the relay de-energizes. Enter the amount of
food dispensed at the Measured Weight screen.
=
8. Press Gl to save settings and return to Run Screen.
Notes:

Since feeders and food size vary, run several calibrations and enter the aver-
age weight at the last calibration. If feeder or feed type is changed, recalibrate

the feeder.

If no test/calibration has been performed or if the results have not been saved,
the 5400 will be unable to perform any feeding(s) because there will be no
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reference to determine the rate at which feeding(s) will occur.

Stored calibration data is available from the AquaManager program.

If feed timer units change, the feeder must be recalibrated.

If an incorrect value is entered and saved, another calibration must be per-
formed.

Disable feed timer system when performing feed timer calibration, de-ener-
gizing any active feed timer relay.

After calibration is complete, press & to Run Screen. The Feed timer
system resets based on new calibration configuration.
Feed Timer calibration cannot be done using AquaManager.

AquaManager and the Timer Menu

Most Timer menus can be configured using AquaManager. After polling the 5400
node, use “Systems Management” to view and upload 5400 configurations. Select
the Timers/Feeder tabs to view and change configuration.
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Notes
- Always manually poll the 5400 after uploading configuration changes and
verify that the uploaded information is retained. When configuration changes
are uploaded using AquaManager at the same time configuration changes are
being made by a user in the menus at the 5400, AquaManager uploads may
not be saved depending on the timing of keystrokes at the 5400.
- The Run Screen must be displayed during normal operation. If the 5400

— N
is not at the run screen during AquaManager uploading, pressing kRl
the 5400 will only save certain configuration changes.

See Chapter 5 AquaManager - page 160 and AquaManager Online Help for ad-
ditional information.

Control Menu

Press Al at the Run Screen to display a list of energized sensor and aux 5400
system relays. The Control menu identifies the active sensor or aux system and
control and/or alarm condition. See Set Points, Controls, and Alarms - page 128 for
additional information.
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Am A

Do-1 0o-3 AU — T

727t | 543¢ 487 aC

93.8% o F55% ’ DO-3Control Range Laow

28.6c By 250c
ALK 2 Temp 4
Closed| 28.7.
A 23

Notes:

- Press to display time stamped detail of control and alarm relay(s).

- Alarm message appears at the Control menu for aux and sensor systems when
alarms are enabled regardless if an alarm relay is assigned.

- Active timer (10 event timer and feed timer) systems are not displayed at
control menu.

- General alarm systems are not displayed at the Control menu regardless if
general alarm relay is enabled.

- Use A ¥ toscroll list when scroll bar appears at menu.

When no 5400 control or alarm system(s) are active, the below screen is dis-
played.

Thereis nothing to Report

Msg’s Menu

Calibration, Sensor, and Event logs contain 5400 system information. The 5400
Sensor log stores 1000 records. The Calibration log stores 500 records. The Event
log stores 1250 records. Once the log memory is full, the oldest records are over-
written with more recent records. The number shown in ( ) at the Msg’s menu
reflects the total number of records in the log. The 25 most recent records for each

|
log are displayed at the menu. Use A W toscroll and press = to view

time stamped detail record.
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E Use AquaManager to capture all records from 5400 logs and store them to a PC

database. Polling times should be determined by logging intervals. Example - if the :
sensor log is recording values every minute and the sensor log holds 1000 records, 05/03/ 2008 03:30°27 P
polling should occur at least every 27 hours. This would allow for all records to be ggig;ﬁggg PRI m
saved to the PC before being overwritten on the 5400. Set the data log interval so
that analyzing data based on the configured interval will be helpful. Poll at intervals

that don't result in gaps in data.

Messages Menu Messages Menu

EventLDgs(S) EventLDgs(]U)

alibration Log
08/08/2008
02:46:04 PM
Sys:DO-1
Mode: Sat

Certain calibration data is not available at the 5400. Use AquaManager to view and

Sensor Logs (61) Sensor Logs (16) save calibration data to a PC. In addition to sensor system, time, date, and calibra-
Reset Clean Probes tion method, AquaManager calibration logs include user input 1, user input 2, and

the original and new slope/offset information when applicable.

D I R €N | | 61D (IR (B O | FventLogs

Control, Alarm, and Timer relays assigned to 5400 systems create events when
they energize and de-energize. In addition, AC power fail and ethernet failure to
initialize errors create events. These events are recorded in the Event log. Events
identify the 5400 system, are time stamped, and record relay on and off times. The

General Alarm does not create an event or control message unless a General Alarm
.
relay is enabled.

Calibration Logs (1)

EventLogs (0)
Sensar Logs (232) EventLogs

A Reset Clean Probe message will appear at the Msg’s Menu if the clean probe timer
expires. Selecting “Yes” at “Are you sure?” resets the clean probe timer to the user
configured number of days.

Fuant| nns

Feset Clean Probes

08/26/2007 10:34:07 AM
08/26/2007 10:33:16 AM
08/26/2007 10:30:33 AM
08/26/2007 10:30:00 AM

Sub System:
Control Range Low
Ewvent:

Note: .1 ¥ I ifr- 1T 1Tl

- User configured sensor and relay names do not appear in log menus.

Note:
Calibration Logs - Enable event logging in the System menu. See Event Logging - page 104 for

additional information.
Calibration logs store sensor calibration data. Calibration logs are date and time

stamped and contain sensor and calibration information for completed calibra- Sensor Logs
tions.

Enabled systems record sensor data based on data logging menu configuration.
Sensor logs identify sensor system, are date and time stamped, and record sensor
value at user configured intervals.
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09/03/2008 04:19:08 PM
09/03/2008 04:09:08 P
09/03/200803:59:07 PM
( (7 F i
09/03/2008 03:39:06 PM
09/03/2008 03:29:05 PM
09/03/2008 03:19:05 PM
09/03/2008 03:09:04 PM

SensorLogs

09/03/2008 04:19:08 PM
09/03/2008 04:09:08 P
09/03/200803:59:07 PM
Jif: 07 F M|
09/03/2008 03:39:06 PM
09/03/2008 03:29:05 PM
09/03/2008 03:19:05 PM
09/03/2008 03:09:04 PM

r-I T T -1

Notes:

- Data logging must be enabled in the System Menu. See Data Logging - page

r-I T T -1

102 for additional information.

Svr Hold Menu

When servicing sensors or doing tank maintenance, it may be necessary to shut
off all systems (including relays) because sensor values will not be accurate. Press

Hold

at the 5400.

Press

at Run Screen to enter Service Hold menu. When in Service hold, all relays
are de-energized until the Service Hold time expires. The Service Hold time is user
selectable. Enable and configure service hold time at Menus > System->Service
Hold. After service hold time expires or is cancelled, sensor and aux systems are
reset causing relays to energize/de-energize based on the system value/condition.
Timer systems are not reset. To reset timer systems, turn power off and then on

Ml to exit Service Hold. Go to Menus > System > Service Hold

to enable and configure service hold time - page 124.

The Run Screen displays a clock count down of the Service Hold remaining time.

System Hold
: 2 3
I L}
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Notes:

If a timer is active (relay energized) at service hold, the relay will not reenergize
after service hold expires regardless if timer time has not expired. There is
only one “on” time for all timer systems.

Entering Downloader mode places 5400 into Service Hold.

AquaManager polling, autopoller (including mapping), and email alarms
continue to function during Service Hold. Stop or pause the AquaManager
Autopoller during a Service Hold to avoid seeing erroneous data in AquaMan-
ager and to avoid receiving alarm emails during sensor service.

5400 alarm emails are not sent during service hold.
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Installing AquaManager

AquaManager provides data logging, graphing, autopolling, mapping, system con-
figuration control, and displays near real-time sensor and aux input values* at the
desktop PC. AquaManager is a valuable tool for remote and local access applications.
An extensive online Help system is provided with AquaManager.

*Near real-time - The AquaManager map is updated several times a minute as
AquaManager constantly communicates with the nodes during Autopolling using
SMS commands. This results in displaying near real-time sensor and aux input
values on the map.

One copy of AquaManager per machine is required.

PC requirements and features

System requirements:

- PC capable of running Windows 2000

- Microsoft Windows 2000/XP/Vista/7 compatible

- VGA display card

- CD-ROM Drive

- Total RAM installed 16 Megs or greater

- 100 MB of free hard-disk space

- Internet Explorer 7.0, or higher

- Adobe Flash 10B or higher

- Administrator privileges on PC where application is being installed

- In addition Vista users must enable UAC properties prior to AquaManager
registration. Go to AquaManager.exe file properties in the program file folder
and check the box ‘Run with Administrator Privileges.

YSI 5400
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Recommendations:

Total RAM installed 64 Megs or greater
300 MB of free hard-disk space
latest versions of Microsoft including O/S and Internet Explorer.

Software Installation

Run AquaManager.exe on the CDROM and follow the instructions in
the installation setup.

Refer to the README.txt file on the CDROM for additional information
on installation and use of AquaManager application.

Getting started

Open application and register. The registration number code is located on the back
of CD case.

See AquaManager Online Help for detailed application configuration information.
Before the node can be accessed using AquaManager, perform the following:

1.
2.
3.

Create, or Open network;

Insert group;

Insert node(s);

A. Determine communication method;

B. Obtain 5200A and/or 5400 serial number(s);

Poll node to obtain current node configuration;

Complete configuration of node and Aquamanager features for your
application.
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AquaManager Windows

Use the Explorer and Node Screens to access configuration forms. Certain con-
figuration forms can be assessed in multiple ways. Access to configuration forms
is provided below.

Explorer Window

The Explorer Screen is displayed when AquaManager is launched. At the Explorer
Screen, the network tree is displayed. The tree includes network, group, and node
folder(s), along with node systems that are used for mapping. The tree is represented
in hierarchical format.

The following configuration and tasks are performed from the Explorer Screen:
- create, open, and export networks
- insert and configure nodes and groups
- edit and view map
- configure system wide properties
- print tree and printer setup
- exit program
- cut, copy, and find node(s)

YSI 5400
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delete node or group

sort nodes in group

expand and collapse tree view

access network log files

insert manual event and manual data into node
password administration

launch autopoller

generate reports

manual database maintenance

launch update firmware utility

configure window display format

access AquaManager Help

check for AquaManager software updates
AquaManager about information

Node (Graph) Window

Double click on a node in tree at the Explorer Screen to open a Node window. A
graph is displayed based on the sensor log data received from thelast poll. Use graph
management and Node Window options to configure the graph display.

The following configuration and tasks are performed from the Node Window:

view and configure node properties
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print graph and printer setup

close node window

copy graph to clipboard

insert manual event

graph management

customize graph settings

clear graph overlays

view data, calibration, event, & configuration event logs

restore Node Window size to include access to systems management and poll
node buttons

Systems Management access - viewing and uploading configuration to 5400
Graph Display options

Manually poll node button

Current data is displayed at the top of the graph during a manual poll

Systems Management

To open Systems Management, click on the Systems Management button located
to the right of the graph in the Node Window. Use the tabs to view and upload a
configuration to node. The node configuration displayed is based on last poll.

The following configuration and tasks are performed from Systems Management
forms:

view and configure node sensor and aux systems

view and configure node timer and feed timer systems
view and configure most node systems (5400 system menu)
configure node mapping icons
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Note:

Always manually poll the 5400 after uploading configuration changes and
verify that the uploaded information is retained. When configuration changes
are uploaded using AquaManager at the same time configuration changes are
being made by a user in the menus at the 5400, AquaManager uploads may
not be saved depending on the timing of keystrokes at the 5400.

The Run Screen must be displayed during normal operation. If the 5400

_——
is not at the run screen during AquaManager uploading, pressing ‘lRE
the 5400 will only save certain configuration changes.

Database Management

For optimal operation and safeguarding, compact and back up the AquaManager
database. Uncompacted Access database(s) may become > 1GB when polling large
networks and/or large data logs. Compact the database from the Explorer Win-
dow Tools>Database Maintenance>Compact Database or from the System Wide
Properties>Gen. Settings tab.

Configure an automatic weekly backup from the System Wide Properties>Database
Backup tab.

Note:

Database Auto-Compaction must be enabled in order to access the Backup
enable box.
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Autopoller

Autopoller is designed to poll node(s) at an interval specified by the user. When the
node(s) is polled, new log records and the configuration are saved to the AquaMan-
ager database. Autopoll must be running for the AquaManager email and mapping
functions to operate.

Launch Autopoll at the Explorer Window>Tools>Launch Autopoller.

= AquaManager: new3dec0B \LHE”E\
File Edit “iew Insert BN Window Help
—=m Password Administration F
@-CI manl Mapping 3 |

- ‘ fukoaler ] EETEITZER

™ =0 Reports 3 Clear AutaPaller Tags

= B Database Maintenance  # Set autoPoller Tags

1] o Instrument Tools 3

Updating DE 11:57:07 AM

An Autopoller Window opens when Autopoller is launched.

Mapping

Create a network map to display current conditions* for 5200A and 5400 nodes at
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the AquaManager PC. Map icons are configured to represent nodes, node systems,
and relays. Map icon images change based on system condition(s). For example,
one icon is displayed when DO-1 is in acceptable operating range, a second icon is
displayed when DO-1 system is in control range (when enabled), and a third icon
is displayed when DO-1 system is in alarm range. This provides a quick visual of
system conditions at the PC.

*Near real-time - Map is updated several times a minute as AquaManager constantly
communicates with nodes during Autopolling.

Node mapping is available for direct and TCP/IP node communication types.

The following figure is an example of an AquaManager map.

AquaManager Alarm Emails

The PC running AquaManager can be configured to send an alarm email when data
received from the node is in alarm range. The alarm range or condition is based on
the node configuration. The node configuration is stored in the network database and
is verified and updated at each Autopoll SMS communication interval. Autopoller
must be running for AquaManager to generate alarm emails. Run Autopoller 24/7
to ensure that alarm emails are sent.

For the AquaManager alarm email to function properly, it may be necessary to send
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a test email to each email address configured in the Email Alarm List in the Node
Properties window. Test emails can be sent in the AquaManager Properties window

under the Autopoller tab. 6 M a| N te nNnance

-Sensor Calibration Checks
-Sensor Maintenance
-Sensor Storage

-Charging DC batteries
-AguaManager database
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Maintenance

It is important to remember that the quality of data is dependent on three factors
directly related to the probe:
- General maintenance at the physical deployment site of the probe.
- Awell-defined quality assurance program that is carried out on a regular basis
to ensure that the sensors are performing properly.
- Proper periodic calibration and maintenance of the specific sensors.

This chapter is designed to provide help in these important areas by providing
maintenance tips, help in implementing a quality assurance protocol, and suggested
service methods and intervals for the sensors.

Probe Maintenance at the Deployment Site
Algae and Debris

A common problem most likely to be encountered with regard to the overall probe
deployment is fouling from algae (and other debris). Algae will inevitably collect
on any object immersed in water and, unless periodically removed, it can inhibit
the sensor’s measurement. Once algae build-up occurs on the sensors and/or probe
guard, it isolates the sensor’s environment from the sample stream. To avoid or
minimize this problem, it is necessary to periodically remove the algae from the
probe guard and sensors.

Minimizing the Effect of Algae and Debris

The collection of algae on the probe and the frequency of cleaning can be minimized
by deploying the probe so that it is angled with (rather than against) the current of
the stream. This deployment method will maximize the chances of the algae being
swept free of the probe rather than collecting on it.

Remember that no matter what precautions are taken, debris will still collect on the
probe and the fouling will have to be removed by periodic cleaning. Cleaning will
be easier if the probe mounting method allows for easy removal and replacement
of the probe. A little extra time spent on implementing a good mounting arrange-
ment using the optional probe mounting kits will save a lot of time in subsequent
cleaning operations.

The frequency with which you will have to remove fouling from the probe varies
with the type of water being monitored and the physical deployment of the probe.
The need for cleaning can usually be ascertained by visual inspection. You can do
no harm by excess cleaning so it is best to remove and clean the probe if any sig-
nificant fouling is suspected.
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Calibration Checks

The sensors are of high quality and should exhibit excellent performance in excess
of the warranty period. However, the dissolved oxygen sensors will inevitably show
some drift during deployment due to physical changes of the electrodes, minor foul-
ing of the sensor surfaces, or both of these factors. Noisy dissolved oxygen readings
can signal the need for specific maintenance procedures. With these factors in mind,
it is imperative that you establish and carry out regular quality checks of the sensor
readings to ensure that they are within their specifications. The quality checks can
help determine when sensor maintenance or calibration is required.

Recommended Quality Assurance Protocol

This product has been designed and tested to provide trouble free service. However,
as with all microprocessor based products, there is potential for failure which could
cause loss of control functions. Proper QC (Quality Control) procedures can reduce
the potential for failure.

It is recommended that you carry out the following quality assurance program
weekly during the initial use of the 5400 system. After several weeks of this pro-
gram, you should be able to ascertain if this frequency is appropriate for your ap-
plication. If only minimal drift is observed, then the frequency of quality checks
can be decreased. The procedure is relatively simple and should take only about
20 minutes to complete.

1.  Take the following items to the deployment site:
- Bucket of clean water
- The calibration/storage cap (supplied with the 5422 probe)

Place the 5400 in Service Hold mode.

Remove the probe from the sample stream.

Remove the probe guard from the 5422 probe.

Manually remove any debris from the sensors and then rinse the sensor

carefully in a bucket of clean water, being very careful not to damage

the sensor or membrane.

6. Inspect the dissolved oxygen membrane for obvious holes or tears. Do
not remove the membrane at this time.

7. Replace the probe guard on the 5422 probe.

8.  Place the sensor in its calibration environment, i.e. 100% water-satu-
rated air. This can be accomplished by placing the 5422 sensor in the
calibration/storage sleeve containing a moist sponge. For the 5420 or
5421 sensor, place the sensor in a cup containing a small amount (~1/8
inch (3 mm)) of water. Make sure that the dissolved oxygen sensor is

PSRN
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not immersed in the water and that there are no water droplets on the
membrane.

9. Wait about 5 minutes for temperature equilibration and then record
the dissolved oxygen reading in percent air saturation as shown on the
5400 display.

10. If the dissolved oxygen readings show minimal calibration drift (i.e.,
within about 5% of the correct value) and the readings are stable, pro-
ceed to Step #12. If excessive drift is noted or the readings are jumpy,
replace the membrane as described in the instruction sheet included in
the Membrane Kit.

11. After replacing the membrane, calibrate the DO sensor.

12. Place the probe back in the sample stream and continue monitoring.

13. Test all control and alarm relays for proper operation.

Maintenance

properly and treated with care. Erratic readings are a result of loose, wrinkled,
damaged, or fouled membranes, or from large (more than 1/8” diameter) air
bubbles in the electrolyte solution. If erratic readings or evidence of membrane
damage occurs, replace the membrane and the electrolyte solution.

- If the membrane is coated with oxygen consuming (e.g. bacteria) or oxygen
producing organisms (e.g. algae), erroneous readings may occur.

- Chlorine, sulfur dioxide, nitric oxide, and nitrous oxide can affect readings by
behaving like oxygen at the sensor. If you suspect erroneous readings, it may
be necessary to determine if these gases are the cause.

YSI 5422 Electrode Maintenance

The gold cathode and silver anode require cleaning about once or twice per year.
Perform the following cleaning procedures if, after a DO membrane change, the DO

Alternative Quality Assurance Protocol (quick check and
adjustment)

readings are erratic and/or a good calibration can not be performed.

Silver Anode Cleaning

An alternative protocol, complementary to the quality assurance program described
above, can be carried out by comparing the current dissolved oxygen reading shown
on the 5400 with those taken by a recently calibrated hand held instrument. For
dissolved oxygen, the probe of a handheld DO instrument can be placed in the
stream near the 5400 probe. If a comparison of the readings from the recently
calibrated DO instrument and the 5400 indicates calibration drift, the 5400 can be
recalibrated. Note - this comparison should only be used to determine if a calibra-
tion is necessary once the 5400 probe has been cleaned of all algae and other debris.
If a gross variation is observed between the two instruments (> 1 mg/L), it is likely
that maintenance is required on the 5200 DO sensor.

Sensor Care and Maintenance

Periodic DO sensor electrode cleaning and membrane changes are required.

DO Sensor

The DO sensor requires periodic membrane changes and electrode cleaning. For
best results, YSI recommends that the electrolyte solution and the membrane cap
be changed at least once every 30-90. Refer to the instruction sheet included with
the membrane kit for specific instructions on changing a membrane.

Notes
- Membrane life depends on usage. Membranes will last a long time if installed
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After extended use, a thick layer of AgCl builds up on the silver anode reducing the
sensitivity of the sensor. The anode must be cleaned about once or twice per year
(depending on use) to remove this layer and restore proper performance.

The cleaning can be chemical and/or mechanical:

Chemical Cleaning: Remove the membrane cap and soak the electrodes in a 14%
ammonium hydroxide solution for 2 to 3 minutes, followed by a thorough rinsing
with clean water. The anode should then be thoroughly wiped with a wet, lint free
cloth to remove the residual layer from the anode.

Mechanical Cleaning: Sand off the dark layer from the silver anode with 400 grit
wet/dry sandpaper. Wrap the sandpaper around the anode and twist the sensor.
Rinse the anode with clean water after sanding, followed by wiping thoroughly with
a wet lint free cloth.

Note - After cleaning, install a new membrane cap with fresh electrolyte and then
perform a calibration. Refer to the instruction sheet included with the Membrane
kit for instruction on how to replace a membrane.

Turn the instrument on and allow the system to stabilize for at least 30 minutes. If, af-
ter several hours, you are still unable to calibrate, contact YSI Customer Service.
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Gold Cathode Cleaning

For correct sensor operation, the gold cathode must be textured properly. It can
become tarnished or plated with silver after extended use. The gold cathode can
be cleaned by using 400 grit wet/dry sand paper. This should be done about once
or twice per year.

Using the sand paper provided in the YSI 5238 Probe Reconditioning Kit, wet sand
the gold with a twisting motion about 3 times or until all silver deposits are removed
and the gold appears to have a matte finish. Rinse the cathode with clean water after
sanding, followed by wiping thoroughly with a wet, lint free cloth. If the cathode
remains tarnished, contact YSI Customer Service.

Note - After cleaning, install a new membrane cap with fresh electrolyte and then
perform a calibration. Refer to the instruction sheet included with the Membrane
kit for instruction on how to replace a membrane.

YSI 5420 and 5421 Sensor Maintenance

Perform the following to periodically clean the 5420 and 5421 electrodes.

1. Unscrew the lower body from the upper body.

Figure 6.1

2. Safely dispose of the electrolyte that is a special molarity, reagent grade
Sodium Chloride solution (salt water).
3. Using the Membrane Tool, unscrew the Membrane Lock in the lower

body.

Maintenance
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Figure 6.2
4.
5.

10.

Note
fresh

Membrane tool

Membrane lock

Spacer
Membrane

o-ring

Remove and dispose of the membrane and its O-Ring as shown above.
Using a toothbrush, dish washing powder, and clean water, clean the
cathode, anode, and plastic between them. Rinse all components
thoroughly.

In order, install a new O-Ring into the lower body, then a new membrane,
and then the spacer. Using the Membrane Tool, screw the Membrane
Lock on top of the spacer as shown in the figure on previous page.
Inspect the membrane for wrinkles. Replace if it is wrinkled.

Pour some water into the lower body and look for leakage around the
membrane. Replace the membrane if there is leakage. If no leakage,
dispose of the water.

Fill the lower body to its rim with fresh electrolyte as shown.

Screw the lower body onto the upper body. Excess electrolyte will leak
out at the joint between the sensor’s lower and upper body.

- Perform a calibration after cleaning and installing a new membrane with

electrolyte.
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Recommended Cleaning of the 5400 and Accesso-
ries
Clean the 5400 monitor and accessories as needed. Dampen a cloth with warm
water and wipe the outside of the unit. You may use mild detergent with water

if necessary. Do not use acid-based, alkali-based, or other organic solvent-based
solvents (e.g., acetone, alcohol, etc.).

Storage
Proper storage between periods of usage will not only extend the life of the sensors,

but will also ensure that the unit will be ready to use as quickly as possible for your
next application.

Short Term Storage
Short term storage is defined as a period of time < 30 days. For short term storage,
itis important to keep the sensor in a moist environment without actually immers-
ing it in liquid.
For short term storage, place the 5422 in the calibration/storage sleeve containing

a moist sponge. For the 5420 or 5421 sensor, place the sensor in a cup containing
a small amount (~1/8 inch (3 mm)) of water.

Long Term Storage
Long term storage is defined as a period of time > 30 days.

The DO sensor should be stored dry with a dry membrane installed to protect it
dust, dirt, and grit.

1. Remove the used membrane.

2. Rinse the DO sensor with distilled or deionized water.
3. Dry the DO sensor and install a new, dry membrane cap.

Sensor Replacement

The 5422 DO sensor is user replaceable. Refer to the instruction sheet provided
with the replacement sensor for detailed instructions.
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Charging DC batteries

The 5400 does not charge batteries. Quality assurance maintenance procedures
should be established if batteries are to be fully powered when used as back-up
power source.

AquaManager Database Maintenance

See AquaManager Database Maintenance - page 165 and AquaManager online Help
for additional information.

Replacement Parts & Accessories

See www.YSI.com for replacement part and accessory information and Appendix
5 of this manual - page 210.
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Unpacking and Inspection

Appendix 1 - Unpacking and Inspection

Inspect the outside of the shipping carton for damage. If damage is detected, contact
the carrier immediately. Remove the instrument from the shipping container. Be
careful not to discard any parts or supplies. Confirm that all items on the packing
list are present. Inspect all assemblies and components for damage. Save the original
packing carton. Carriers typically require proof of damage due to mishandling.

The following components are included with the purchase of the 5400 instru-
ment:

5400 instrument

006515 Flange Mounting Kit

006506 Desiccant Kit

605877 Instruction Manual

605230 Compression Plugs, 2 each

605229 Compression Plugs, 2 each

605804 Compression Plugs, 4 each

605898 Compression Plugs, 3 each

655384 Dual Male RJ-45 Cable Assembly

655383 Adapter, DB-9 to RJ-45

605880 AC Power Cord, 155 VAC U.S. Plug (AC version only)

605944UL Pluggable Socket Connector for AC Power, 3 pole (AC version only)
506939UL Pluggable Socket Connector for 12 VDC Power, 2 pole

605941UL Pluggable Socket Connector for RS-485, 5 pole

605943UL Pluggable Socket Connector for relays, 12 pole, 2 each

605940UL Pluggable Socket Connector for Auxiliary Inputs, 3 Pole

605942UL Pluggable Socket Connector for DO and AUX inputs, 8 Pole, 2 each

If any parts are damaged or missing, contact YSI or your YSI representative im-
mediately.

YSI 5400
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Troubleshooting

Appendix 2 - Troubleshooting

Sensor Troubleshooting
- When troubleshooting sensors, disable the control/alarm relays.
- Verify 5400 wiring and configuration.

Issue

possible cause

possible solution

inaccurate or fluctuating
sensor values

improper placement of probe
assembly

See Location Considerations
- Step 2 Locate and Install
Probe Assembly - page 34.

improper placement of 5400

See Location considerations
- Step 1 Install 5400 - page
27

bad sensor
bad DO membrane

recalibrate, change mem-
brane, clean sensor, test
sensor outside system
stream in solution of
known value, replace sensor

sensor out of calibration

See Calibration - page 76..

DO elevation configuration
incorrect

Correct DO elevation at
Menus - System - Sensor
Setup>DO-Elevation
menu

DO values are affected by
temperature. If DO values
are incorrect, verify that
the temperature source is
accurate and reporting cor-
rect values or that the user
defined temperature value
is correct for the DO sensor
location. If the temperature
sensor is reporting incorrect
values, the DO mg/L values
are not reliable.

See DO and temperature -
pagel39.

DO-galvanic or polaro-
graphic inaccurate values

DO sensor wires are termi-
nated incorrectly

see Wire DO sensors -page
48.

probe assembly ground wire
or temp sensor wires (if not

in use) are causing interfer-

ence)

cut back unused wires to
cable sheathing to avoid
shorting
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Troubleshooting

Sensor Troubleshooting continued

Troubleshooting

Issue

possible cause

possible solution

“over/under” sensor
readings

bad sensor
bad membrane

clean sensor, replace
membrane, calibrate sensor,
test sensor outside system
stream in solution of
known value,

replace sensor

Relay (Outputs) Troubleshooting

- Disable control, alarm, and timer relays when troubleshooting relay out-

puts.

- Verify 5400 wiring and configuration.

Issue

possible cause

possible solution

relay does not energize

incorrect sensor configura-
tion

See Set Points, Controls, and
Alarm - page 128.
relay not enabled

no sensor value on
screen

sensor not enabled

See Sensor Setup - page 127.

incorrect timer configuration

See Timers - page 141.

display setting configuration
set for multiple Run Screens

See Display Setting -
pagel07

30 second delay at power up
and/or sensor configuration
change

30 seconds delay - see page
127 and pagel31.

“check probe” message at
sensor calibration

improper placement of probe
assembly, incorrect sensor
wire connection(s), improper
placement of 5400, bad sen-
sor, and/or bad membrane

See Location Considerations
Probe Assembly - page 34
See Connect Probe Assembly
- page 47.

See Location Consider-
ations 5400 - page 27.

clean sensor, calibrate,

test sensor outside system
stream in solution of
known value, replace mem-
brane and/or replace sensor
if necessary

peripheral device is wired
incorrectly

See Wire Relays - page 51.
The device is incorrectly
wired to NO or NC pins.

relays are not enabled for
control/alarm/timer system

Verify menu configuration
(relay enable) for control/
alarm/timer system.

See sensor system enable -
pagel27.

See timer system enable
-pagel4l.

Analog aux value is
overlapping to adjoining
sensor window

1X1 & 2X2 display format
setting cannot display values
over 7 digits in aux sensor
window

Adjust aux display format
to lower resolution i.e. from
0.00 format to 0 format.

See also Notes: Display
Screen Limitations - page
108.

temp (high) does not de-
energize when set point
value is read

sensor is configured for
timed control

Verify setpoint and control
configuration values - on
page 128

Email Alarm Troubleshooting

Issue

possible cause

possible solution

no 5400 email alarm
message received

5400 display is not at Run
Screen - all alarming is sus-
pended when in menus

exit to run screen to reset
alarm email alarm system

Serial to ethernet device did
not initialize properly. Check
the event log for “unable to
initialize error”.

disconnect power to 5400,
verify installation of serial
to ethernet device on lower
board and repower

faulty ethernet serial to eth-
ernet device

replace serial to ethernet
device
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Troubleshooting

Email Alarm Troubleshooting continued

Troubleshooting

5400 Systems Troubleshooting

Issue

possible cause

possible solution

Issue

possible cause

possible solution

Are the alarms enabled in
sensor menu? Is the general
alarm enabled?

see Sensor Setup Alarms
Values - page 129.

see General Alarm - page
113.

time and date lost at
power up

bad lithium battery

replace lithium battery

no email alarm received
for slave alarm condition

Are slaves enabled on net-
work?

enable slaves at Menus >
System > Communications
- Network >Master

no events in event log

event logging not enabled

See Event Logging -
pagel04.

no data in data log

data log interval time has not
passed

See Data Logging - page
102.

no test email alarm mes-
sage received

exit to run screen from com-
munication menu not done

exit to run screen to process
test email request

Network Troubleshooting

cannot view specific data
log records at 5400

Data log record has older
date and time-stamp than
the 25 most current data
log records available at 5400
sensor log.

See Data Logging - page
102.

Issue

possible cause

possible solution

no communication to
networked unit(s)

Are master/slave menus
properly configured?

See Networking - page 92.

Firmware Updater Troubleshooting

Is termination relay en-
abled in 1st & last 5400 on
network?

See Termination Relay -
page 94.

Issue

possible cause

possible solution

Device “timed out” error

incorrect configuration in
5400 communication menu

See Device Timed Out er-
ror - page 112

Is proper communication
method configured and
wired properly?

See Networking - page 92.
See Wire Communication
Equipment - page 62.

incorrect wiring of RS232
connection

See Device Timed Out er-
ror - page 112

Are slaves enabled and recog-
nized at master?

enable slaves at Menus >
System - Communications
-> Network >Master

more than one device is
configured as a master

verify configuration at
Menus > System > Com-
munications > Network
~>Master/Slave menus on
all nodes.

5400 does not go into
downloader mode when
“program device” is
selected at Firmware
Updater

Manually put 5400 in
downloader and retry firm-
ware updater upload.
Menus - System > Down-
loader

See Force downloader -
page 112.

unit does not upload new
code at downloader

unit is not in downloader
mode

See Downloader - page 109.

slow network perfor-
mance

nicked wires;
improper wiring

Verify network wiring -
See Wire Network - page 57

RS232 connection is incor-
rect

See Wire Communications -
RS232 - page 63.
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Troubleshooting

Feed Timer Troubleshooting

Issue Understanding how the 5400 calculates sensor reduction
time

Sensor reduction % is The 5400 displays temperature sensor values to the 10ths and

not accurate based on DO values to 100ths. In reality the 5400 temperature and

display sensor value(s). | DO sensor system values are stored at a much greater resolu-

tion (out to 64 bits). It is the stored values, not the displayed
values, that are used to calculate the feed timer sensor reduc-
tion.

AquaManager Troubleshooting

Refer to AquaManager online Help for all AquaManager operation and troubleshooting
information.
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Appendix 3 - Menu Maps

This Appendix contains the menu structure for the 5400. The menu maps contain
all submenus, factory defaults, and user selectable ranges of the 5400 firmware.
Menu maps are presented in hierarchal format. All menus are accessed by pressing

at the Run Screen. Menu maps are provided in the following order:

Calibration menu
System menu
Sensor Setup menu
Timers menu

1.
2.
3.
4.

The example below shows how to navigate the menu maps in this manual.

1. Find the menu you want to configure. For example, IP address for the
serial to ethernet device.

2. Follow the path highlighted at the top of menu. Then, follow the path
under and to the right of the menu heading to access submenu.

Run Screen - Menus - System Menu - Communication

Communication
Ethernet

DHCP (Enable

P Address (192.168.1.100)
0.0.0.0 to 255.255.255.255

Key strokes to enter IP address as depicted above.

From the Run Screen, press the softkey below
Enter the System menu.

Enter the Communication menu.

Enter the Ethernet menu.

Enter the IP Address menu - a numeric keypad is displayed.
Configure the IP address using numeric keypad.

S e
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Menu Maps Menu Maps

Menu Map Key
The following conventions are used in menu maps:

- Factory defaults are contained in (). If blank, no default value is loaded for
this menu. In certain menus, the user configuration will appear in () once the
menu is configured.

- System range (if applicable) are in italics. “*” displayed after the range indi-
cates that the range is based on another system configuration i.e. set point
submenus.

- (Not Available) indicates hardware is not installed.

The following graphics are used in menu maps:

- - Input is required at numeric or alpha/numeric keypad.

- G GRS - One of these softkey entries is required.

- 'V _ Make a selection from a pull down menu.

- ® - Use three front panel key to proceed; (only used at adjust contrast
menu).

The menu map on the following page depicts how the menu map conventions and
graphics are used for configuring the DO alarm low value and enabling the DO
system alarms.
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Menu Maps

Menu Maps

Run Screen—>Menus—Calibration

Calibration

DO-1 (Enabled)
DO-2 (Enabled)
DO-3 (Enabled)
DO-4 (Enabled)

SAT
mg/I

User Cal Value
0.1to 60

Run Screen -> Menus - System Menu = Adjust Contrast/Buzzer/Communication (modem)

Adjust Contrast

Buzzer (Enabled

BackLight Timer (Enabled

Time (30 Sec)
1-255

Time Units (Sec)

Run Screen - Menus - System Menu - Communication

Communication

Ethernet (Not Available)

Network (Master)

DHCP (Enabled)

IP Address (192.168.1.100)
0.0.0.0 to 255.255.255.255

Subnet Mask (255.255.255.0)

Gateway (192.168.168.1)
0.0.0.0 to 255.255.255.255

Port (10001)
1-65535

DNS Address (192.168.1.1)

Email Address ( )

Email Address ( )

Email Address ( )

Email Address CC ( )

Master

Slave
1-31

Compatibility Mode
1-31

Termination Relay (Enabled)

EE@ ﬁﬁﬁﬁ@ﬁﬁﬁﬁg
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Menu Maps

Send Test Email Msg (Not Available)

|"Emai| test has been placed in the queue"

Menu Maps

Email Retry Delay (Not Available) (15)
1-255

Time Units (Not Available)

v Sec
Min
Hours

Baud Rate (115200)

v Default Baud Rate
9600
14400
19200
38400
57600
115200

Force Serial Port (Disabled)

e G

Run Screen - Menus - System -> Configure Aux

Configure AUX

Aux 1 - 2 (Disabled) (Name)

Aux 3 - 6 (Disabled) (Name)

Probe Name ( )

Input Type (4/20ma)
v Digital
0-v
0-5v
4/20ma
Suffix ()
Min (0)
-10000 to 10000
Max (20)
-10000 to 10000
Display Format (0)
VYo
0.0
0.00
Probe Name ( )
Input Type (4/20ma)
v Digital
0-v
0-5v
4/20ma
Suffix ()
Min (0)
-10000 to 10000
|
Max (20)
-10000 to 10000
Display Format (0)
VYo
0.0
0.00
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Menu Maps

Menu Maps

Run Screen - Menus - System -> Data Logging

Data Logging

Data Logging

Data Logging (Enabled) (1 Hour)

Logging Interval

Time units

Event Logging (Enabled)

Dissbiealf Ensbled

Clear Logs

V Data

Events
Data and Events

"Are You Sure?"

Run Screen - Menus - System -> Date/Time

Date/Time

Set Date Format (MM/DD/YY)

Set Date (1/1/2007)

DD/MM/YYYY
MM/DD/YYYY
DD/MM/YY
MM/DD/YY
DD/YYYY/MM
YYYY/DD/MM
DD/YY/MM
YY/DD/MM
YY/MM/DD
MM/YY/DD
MM/YYYY/DD
YYYY/MM/DD

Year (2007)
2007 to 2099

Month (January)

=

YSI 5400
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v January
February
March
April
May
June
July
August
September
October
November
December
Day (1)
1to31
=
Set Time Format (12 Hour)
v 12 Hour
24 Hour
Set Time
Hours (7)
|
Minutes (0)
=
Seconds (47)
|
Mode (PM)
V¥V aw
PM
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Menu Maps

Menu Maps

|DisE|a¥ Settings

Display Format (1x1)

Run Screen - Menus - System -> Display Settings

Page Change Speed (10 Sec)
1-65535

v 1x1
1x2
2x2
2x3

Downloader
"Are You Sure?"

Run Screen - Menus - System - Downloader
-> General Alarm

General Alarm

General Alarm (Enabled)

Alarm Hold Off (15 Sec)

Relay (Disabled)

1-255
Time Units
V Sec
Min
Hours

General Alarm (Disabled)

Instrument (Local Machine)

Run Screen > Menus = System - Name Devices/Sensors

Name Devices/
Sensors

Instrument Name ( )

Aux1-6 ()

Conductivity ( )

DO 1-4 ( )

Name Relays

v Relay 1

Relay 2
Relay 3
Relay 4

Run Screen - Menus - System - Password

Password

Password (Disabled)

Set Password

Run Screen - Menus - System - Power Fail

|Power Fail Alarm

Power Fail System (Disabled)

Power Fail AC Monitor (Not Available)

Low Battery Monitor (Not Available)

Disabled

Enabled I

Low Battery Trigger (Not Available)
9-15

Relay (Relay 1)
v Relay 1
Relay 2
Relay 3
Relay 4
YSI 5400
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Run Screen - Menus - System - Serial Number

Serial Number (53-
1122330)

[serial Number (53-1122330)
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Menu Maps

Menu Maps

Run Screen - Menus - System - Service

Service

Reset Clean Probes

Reset To Factory

Clean Probes (Enabled) (90 Days Left)

Duration (90 Days)

Relay Test

Reset System

1-365
Reset

"Are You Sure?"
Reset All

"Are You Sure?"

Reset All Systems
Reset Clean Probes
Reset Data Logger
Reset General Alarms

Reset Password

Reset Relay Names

Reset Service

"Are You Sure?"

Reset Sensors

Reset All Sensors

Reset DO1 - DO4

Reset Aux 1 - Aux6

"Are You Sure?"

Reset Timers

Reset All Timers

Reset Timer 1 -4

Reset Feed Timer 1-4

"Are You Sure?"

Relay 1 - 4 (Off)

Relays 1-4 (Off/On)

Run Screen - Menus - System — Version

Version

Display Board 0.55

Control Board 0.55
Compiled Date Nov 29 2007
Compiled Time 10:35:10
Unit Temp 25.5 C (77.90 F)
Power 0.30v

Battery 13.44v

Run Screen - Menus - System - Service Hold

Service Hold (Disabled)

Service Hold (Enabled)

Service Hold Off (5 Min)
1to 255

Time Units (Min )

Hours

YSI 5400
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Aux 1-2 (Name) (Enabled) ( Digital)

Run Screen - Menus - Sensor Setup - Aux

Probe (Disabled)

Control/Alarm On - digital only

| Disabled

|

Alarm (Disabled)

Hold Off (15 Sec)

|

Time Units (Sec)

v Sec
Min
Hours
Control/Alarm Low () (Suffix) - analog only
Contorl/Alarm High () (Suffix) - analog only

Relay (Disabled)

Aux 1-2 (Disabled)

Instrument (Local Machine)

Relay (Relay 1)

V Relay 1

Relay 2
Relay 3
Relay 4
Relay 5
Relay 6
Relay 7
Relay 8
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Menu Maps

Menu Maps

Run Screen—>Menus—>Sensor Setup—>AUxX (temperature)

IAux 3-6 (Name) (Enabled)
(Temperature)

emperature (Enabled)

ITemperature (Enabled)

Display Format (Celsius)

V Fahrenheit

Celsius
IChiller On (10 Min)
11-255
Time Units

Min
Hours
IChiller Hold Off (8 Min)
1-255
Time Units

V Sec
Min
Hours

IAlarms (Disabled)

IAlarm Low (23.5c)
1.1to44.0 c*

Relay (Disabled)

|Alarm Low (Disabled)

; )

Instrument (Local Machine)

Relay (Relay 1)

v Relayl

Relay2
Relay 3
Relay 4
Relay 5
Relay 6
Relay 7
Relay 8

Relay (Disabled)

[Set Point (25.0 c)
5.5 c to 44.0 c*

Range Low (Disabled)

Instrument (Local Machine)

Relay (Relay 1)

Range High (26.0 c)
3.8 cto44.0 c*

v Relayl

Relay2
Relay 3
Relay 4
Relay 5
Relay 6
Relay 7
Relay 8

Relay (Disabled)

IAlarm High (26.5c)
3.3 cto44.0 c*

Range High (Disabled)

Instrument (Local Machine)

Relay (Relay 1)

Relay (Disabled)

v Relayl

Relay2
Relay 3
Relay 4
Relay 5
Relay 6
Relay 7
Relay 8

Range Low (22 c)
4.7c to 44.0c*

I continued next page

IAlarm High (Disabled)

Instrument (Local Machine)

Relay (Relay 1)

v Relayl

Relay2
Relay 3
Relay 4
Relay 5
Relay 6
Relay 7

Relay 8
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Menu Maps

DO (Name) (Enabled)

DO (Enabled)

IAlarms (Disabled)

Probe Type

Run Screen—>Menus—>Sensor Setup—)DO

Dissbieal] Ensbiea

Dissbleal] Ensbled

Membrane Type ( )

Display Format (mg/I)

Salinity (0 ppt)
I0-50 ppt

Elevation (O Feet)
10-200X100ft

IAlarm Low (3.50 mg/I)
0.0 - 60.0 mg/I*

Relay (Disabled)

Range Low 2 (4.00 mg/l)
13.5 - 60.00 mg/I*

vGaIvanic

PolaroGraphic

vTeﬂon 2.0mil (Gray)
PE 2.0mil (Blue)

vmg/l

Sat

mg/l and Sat
mg/l and Temp
Sat and Temp

IAlarm Low (Disabled)

Instrument (Local Ma-
chine)

Relay (Relay 1)

mg/|, Sat and Temp

I

v Relayl

Relay2
Relay 3
Relay 4
Relay 5
Relay 6
Relay 7
Relay 8

I continued next page

Menu Maps

Relay (Disabled)

Range Low (5.00 mg/I)
14.00 - 60 mg/I*

Range Low 2 (Disabled)

Instrument (Local Ma-
Ichine)

Relay (Relay 1)

V Relayl

Relay2
Relay 3
Relay 4
Relay 5
Relay 6
Relay 7
Relay 8

Relay (Disabled)

Set Point (8.00 mg/l)
5.0-60.00 mg/I*

Range Low (Disabled)

Instrument (Local Ma-
Ichine)

Relay (Relay 1)

v Relayl

Relay2
Relay 3
Relay 4
Relay 5
Relay 6
Relay 7
Relay 8

Range High (8.50 mg/)
8.0 to 60.0 mg/I*
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Menu Maps

Menu Maps

Relay (Disabled)

Range High (Disabled)

Disable: tiea
Instrument (Local Ma-
chine)
Relay (Relay 1)
V Relayl
Relay2
Relay 3
Relay 4
Relay 5
Relay 6
Relay 7
Relay 8
Range High 2 (8.70 mg/I)
8.5 to 60.00 mg/I*
Relay (Disabled)
Range High 2 (Disabled)
Oicabledl Enatied
Instrument (Local Ma-
Ichine)
Relay (Relay 1)
V Relayl
Relay2
Relay 3
Relay 4
Relay 5
Relay 6
Relay 7
Relay 8
IAlarm High (9.00 mg/1)
8.7 to 60.0 mg/I*
Relay (Disabled)
IAlarm High (Disabled)
sbieg
Instrument (Local Ma-
Ichine)
Relay (Relay 1)
v Relayl
Relay2
Relay 3
Relay 4
Relay 5
Relay 6
Relay 7
Relay 8

Run Screen - Menus - Timers - Timers 1-4

Timer 1 - 4 (Disabled)
Timer 1 - 4 (Disabled

Relay (Disabled)

Alarm High (Disabled)

Instrument (Local Machine)

Relay (Relay 1)

Event 1 - 10 (12:00:00
AM) (0 Sec)

Start Time (12:00:00 AM)

Duration (0 Sec)
1-255

V Relay 1
Relay 2
Relay 3
Relay 4
Hours (12)
1-12
Minutes (0)
0-59
Seconds (0)
0-59
Mode
V AM
PM

Time Units

Hour
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Menu Maps

Run Screen - Menus - Timers - FeedSmart Timer

FeedSmart "™ Timer 1-4

Feed Timer (Disabled)

FCR (Disabled)

Feeder

Biomass (0 oz)
1 to 100000

Feed % Biomass (0.00%)
0.01-99.90%

Daily Weight (0 0z)
1 to 100000

FCR Factor (0.03%)
0.01 to 100.00

(e

Feed Mode

Daily Weight (0 0z)
1 to 100000

Daily Feedings (3) 1-255

v Timed

Continuous

()

Start Date (01/01/2007)

Start Time (12:00:00 AM)

Year (2007)
2007-2099

Month (January)

Day (1)
1-31

Hours (12)
1-12

=

V January

February
March
April

May

June

July
August
September
October
November

Minutes (0)
1-59

Seconds (0)
1-59

Mode (AM)

v AM

PM

Menu Maps

Sensors(Disabled)

End Date (01/01/2007)

End Time (12:00:00 AM)

Year (2007)
2007-2099

Month (January)

=

Sun-Sat (Disabled)

Relay (Disabled)

Sensors (Disabled)

DO Low (0.00 mg/I)
0 to 60.00

Disabled|lEnabled

Dicabled|l Enabled

DO High (0.00 mg/)
0to 60.00

DO Change (0.01%)
0.00 to 9.9%

Temp Low (0.0 )
Icto44.0c

Temp High (0.0 ¢)
1cto44.0c

Temp Change (0.01%)
0.00 to 9.9%

v January
February
March
April
May
June
July
August
September
October
November
December
Day (1)
1-31
Hours (12)
1-12
Minutes (0)
1-59
Seconds (0)
1-59
Mode (AM)
v AM
PM

Units (oz,

Calibrate (180) (0 oz)

Feed Smart Timer (Disabled)

Instrument (Local Machine)

Relay (Relay 1)
V Relay 1
Relay 2
Relay 3
Relay 4
v

Feed Timer Test Run Time
Feed Timer Test Weight

p—
I 7 continued next page
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Declaration of Conformity

Declaration of Conformity

Appendix 4 - Declaration of Conformity

The undersigned hereby declares on behalf of the named manufacturer under our
sole responsibility that the listed product conforms to the requirements for the listed

European Council Directive(s).

Manufacturer: YSI Incorporated
1725 Brannum Lane
Yellow Springs, OH 45387
USA
Product Name: Multi-parameter Monitoring and Control Instrument
Model Numbers: 5400
Conforms to the following:
Directives: RoHS 2002/95/EC
WEEE 2002/96/EC

Harmonized Standards:

IEC61010-1:2001

EN61326-1:2006
EN61000-3-2:2000/A-2-2005
EN61000-3-3:1995/A1-2001, A2-2005
CISPR11

Authorized EU
Representative

YSI Hydrodata Ltd
2 Focal Point, Lacerta Court, Works Road
Letchworth, Hertfordshire, SG6 1F] UK

Signed: Lisa M. Abel
Title: Director of Quality

Date: 21 May 2010
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FCC Required Notice

The Federal Communications Commission defines this product as a computing
device and requires the following notice.

This equipment generates and uses radio frequency energy and if not installed and
used properly, may cause interference to radio and television reception. It has been
type tested and found to comply with the limits for a Class A or Class B computing
device in accordance with the specification in Subpart ] of Part 15 of FCC Rules,
which are designed to provide reasonable protection against such interference in
a residential installation. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio
or television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one or more of the
following measures:

- Reorient the receiving antenna

- Relocate the computer with respect to the receiver

- Move the computer away from the receiver

- Plugthe computer into a different outlet so that the computer and receiver
are on different branch circuits.

If necessary, the user should consult the dealer or an experienced radio/television
technician for additional suggestions. The user may find the following booklet,
prepared by the Federal Communications Commission, helpful: “How to Identify
and Resolve Radio-TV Interference Problems”. This booklet is available from the
U.S. Government Printing Office, Washington, D.C. 20402, Stock No.0004-000-
00345-4.
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Parts & accessories

Parts & Accessories

Appendix 5 Parts and Accessories

Replacement Part

Part Number and Description

Replacement Part |

Part Number and Description

Other

Galvanic probe/cable assemblies

cable lengths available: 4m, 10m, 20m, 30m, and custom to 100 m

AC Power cord, 115 VAC, USA plug

605880, for AC version only, included with
AC version

p/n 5420 DO (galvanic)
p/n 5421 DO (galvanic) and temperature

Adapter, DB-9 to RJ-45

655383, included with instrument

Polarographic probe/cable assemblies

cable lengths available: 4m, 10m, 20m, 30m, and custom to 100 m

AquaManager Software, single and
network use

655363

p/n 5422 - cable, includes DO (polarographic)
and temperature.

Compression Plugs, Large

605230, 2 each included with instrument

Compression Plugs, Large

605229, 2 each included with instrument

Polarographic replacement sensor

Compression Plugs, Medium

605898, 3 each included with instrument

p/n 605203 - installs on 5422 cables

Compression Plugs, Small

605804, 4 each included with instrument

DO Membranes for Galvanic DO Sensor

Conduit fittings

065926UL - For optional conduit mount,
industrial encapsulant required

2 mil Teflon

5405-5 membrane kit contains:
-5 membrane
-electrolyte solution

Conduit Sealer

065921, industrial encapsulant require for
above item

2 mil Teflon

5405-25 membrane kit contains:
-25 membranes
-electrolyte solution

Desiccant pack replacement

006506, included with instrument

DO (Galvanic) sensor reconditioning
kit

5407

Electrolyte solution

5406, 1 pint

DO Membranes and electrolyte solution

for Polarographic sensor

DO (Polarographic) sensor recondi-
tioning kit

052380, includes 400 grit sanding discs and
sanding tool.

2 mil PE (blue)

605307 membrane kit contains:
-6 cap membranes

-electrolyte solution

-sanding disk

-3 gaskets

Dual Male, RJ-45 Cable Assembly

655384, included with instrument

Flange Mounting Kit

006515, included with instrument

Grounding Screws

605889, included with instrument

Pluggable Socket Connector for AC
power, 3 pole

605944 UL, for AC version only, included with
AC version

2 mil Teflon (gray)

605204 membrane kit contains:
-6 cap membranes

-Probe electrolyte

-sanding disk

-3 gaskets

Pluggable Socket Connector for Auxil-
iary Inputs, 3 pole

605940UL, included with instrument

Pluggable Socket Connector for Aux
and DO inputs, 8 pole

605942UL, included with instrument

Installation Mounting kits

Panel mount kit

006510 - for mounting 5200A instrument to
a panel.

Pluggable Socket Connector for relays,
12 pole

605943UL, 2 each included with instrument

Rail mount kit

006509 - for mounting a 5200A instrument to
arail.

Pluggable Socket Connector for RS-
485, 5 pole

605941UL, included with instrument

Weather shield kit

006505

Pluggable Socket Connector for 12
VDC power, 2 pole

506939UL, included with instrument

RS-232 Opto Isolator, DB-9 to RJ-45

605285
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Replacement Part

Part Number and Description

Serial to Ethernet device kit

5402

User Manual

605878, included with instrument

12-volt power supply, 115 VAC input

605227UL

12-volt power supply, 230 VAC input | 655478UL
230 VAC power cord, European (AC 606100
version only)
230 VAC power cord, UK (AC version | 606101
only)
230 VAC power cord, Australia (AC 606102
version only)
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Appendix 6 - SMS messaging

SMS (Short Message Service) or text messaging is a service for sending messages to your
Cell phone or Pager (mobile device). Using the optional xPort Ethernet solution, you can
redirect your alarm messages to your mobile device.

Under the Service->Communications->Ethernet menu you will find a menu item called
Email Address. Using the format from your carrier, see list below, replace your email ad-
dress with this information. Example: Your Cell phone number is 858-555-1212 and your
carrier is Sprint PCS, your email address would be 8585551212@messaging.sprintpcs.com.
Note the maximum size of your email address or cell phone information is 49 characters.
This should be large enough to cover most email addresses.

Below is a list of major USA Cellular and Pager companies that support sending Text
messages to a Cell Phone or pager device via email (xPort Ethernet solution). If your
carrier is international or is not listed here, please visit http://www.notepage.net/smtp.htm
for a more comprehensive list or contact your service provider for information on how to
send a SMS or Email message to your mobile device.

Company Name SMTP Format

Alltel [10-digit phone number]@message.alltel.com
AT&T (formerly Cingular) [10-digit phone number]@txt.att.net

Boost Mobile [10-digit phone number]@myboostmobile.com
Nextel (now Sprint Nextel) [10-digit telephone number]@messaging.nextel.

[10-digit phone number]@vzwpix.com (MMS)
[10-digit phone number]@vmobl.com

com
Sprint PCS (now Sprint Nextel) [10-digit phone number]@messaging.sprintpcs.
com
[10-digit phone number]@pm.sprint.com (MMS)
T-Mobile [10-digit phone number]@tmomail.net
US Cellular [10-digit phone number]email.uscc.net (SMS)
[10-digit phone number]@mms.uscc.net (MMS)
Verizon [10-digit phone number]@vtext.com
]
]

Virgin Mobile USA
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Appendix 7 - Alpha “A” curve
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Appendix 8 - Warranty

The YSI 5400 instrument is warranted by YSI for two years from date of purchase by
the end user against defects in materials and workmanship (excluding components
and materials for the YSI 5400 which are separately warranted below). All YSI cables,
probe modules, and sensors for the YSI 5400 are warranted by YSI for one year from
date of purchase by the end user against defects in material and workmanship. Within
the applicable warranty period, YSI will repair or replace, at its sole discretion, free of
charge, any product that YSI determines to be covered by this warranty.

To exercise this warranty, call your local YSI representative, or contact YSI customer
service in Yellow Springs, Ohio at +1 937 767-7241. Send the product and proof of pur-
chase, transportation prepaid, to the Authorized Service Center selected by YSI. Repair
or replacement will be made and the product returned, transportation prepaid. Repaired
or replaced products are warranted for the balance of the original warranty period, or
at least 90 days from date of repair or replacement. The end user making a claim under
any of these warranties is responsible for all product removal and reinstallation costs
related to any product repair or replacement under any such warranty.

Limitation of Warranty

This warranty does not apply to any YSI product damage or failure caused by:

1. failure to install, operate or use the product in accordance with YSI’s written
instructions;

2. abuse or misuse of the product;

3. failure to maintain the product in accordance with YSI’s written instructions
or standard industry procedure;

4. any improper, incorrect or substandard repairs to the product not performed
by YSI;

5. usebyanyone (other than YSI) of any defective or improper component or part
in servicing or repairing the product;

6. modification of the product in any way not expressly authorized by YSI.

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. YSI'S LIABILITY UNDER THIS WARRANTY IS
LIMITED TO REPAIR OR REPLACEMENT OF THE PRODUCT, AND THIS SHALL
BE THE SOLE AND EXCLUSIVE REMEDY FOR ANY DEFECTIVE PRODUCT
COVERED BY THIS WARRANTY. INNO EVENT SHALL YSI BE LIABLE FOR ANY
SPECIAL, INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULT-
ING FROM OR CAUSED BY ANY DEFECTIVE PRODUCT COVERED BY THIS
WARRANTY.
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Appendix 9 - Contact Us Appendix 10 - Recycling

Ordering and Technical Support Recycling

Please visit www.ysi.com for a list of YSI's locations worldwide along with additional
contact information.

YSI, Inc. Corporate Headquarters:
Telephone: 800 897 4151 (US)

+1 937 767 7241 (Globally)
Monday through Friday, 8:00 AM to 5:00 ET

Fax: +1 937 767 9353 (orders)

+1 937 767 1058 (technical support)
Email: environmental@ysi.com
Mail: YSI Incorporated

1725 Brannum Lane
Yellow Springs, OH 45387 USA
Web Site: Www.ysi.com

When placing an order please have the following available:
1.) YSI account number (if available)

2.) Name and phone number

3.) Purchase Order or Credit Card

4.) Model Number or brief description

5.) Billing and shipping addresses

6.) Quantity

Service Information

YSI has authorized service centers throughout the United States and Internation-
ally. For the nearest service center information, please visit www.ysi.com and click
‘Support’ or contact YSI Technical Support directly at +1 937-767-7241.

When returning a product for service, include the Product Return form with clean-
ing certification. The form must be completely filled out for a YSI Service Center to
accept the instrument for service. The form may be downloaded from www.ysi.com
by clicking on the ‘Support” tab, then the Product Return Form button..
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YSI is committed to reducing the environmental footprint in the course of doing
business. Even though materials reduction is the ultimate goal, we know there
must be a concerted effort to responsibly deal with materials after they've served
a long, productive life-cycle. YSI's recycling program ensures that old equipment
is processed in an environmentally friendly way, reducing the amount of material
going to landfills.

- Printed Circuit Boards are sent to facilities that process and reclaim as much
material for recycling as possible.

- Plastics enter a material recycling process and are not incinerated or sent to
landfills.

- Batteries are removed and sent to battery recyclers for dedicated metals.

When the time comes for you to recycle, follow the easy steps outlined at
Www.ysi.com.

Battery Disposal

The circuit board in this instrument contains a manganese dioxide lithium “coin
cell” battery that must be in place for continuity of power to memory devices on
the board. This battery is not user serviceable or replaceable. When appropriate,
an authorized YSI service center will remove this battery and properly dispose of
it, per service and repair policies
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Index Index

probe name 97
I n d ex suffix 99
control/alarm low and high. See sensor setup analog (aux non temperature)
control/alarm on open or closed. See sensor setup (aux) digital

Symbols

30 second power up delay 71, 127
30 second sensor system hold off 131
5400 Configuration chapter 67

A

Adjust contrast menu 82
Alarms
alarm hold off 114
alarm value 129
general alarm 113
AquaManager 159
and data logging 102, 105, 166
and sensor setup menu 140
and system menu 125
and timer menu 151
autopoller 166
alarm emails 167
mapping 166
database management 165
getting started 161
installation 160
PC requirements 160
Windows 162
explorer window 162
node (graph) window 163
systems management 164
Autofix 130
Auxiliary (Aux) systems
configure 96
display format 100
input type 97
analog (non temperature) 98
analog (temperature) 101
digital 98
min/max values 99
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sensor setup (non temperature) 132
analog (non temperature) 135
hold off 133
relay 133

sensor setup (temperature) 136

wiring
analog (non temperature) 56
digital 56
temperature sensor 49

B

Backlight timer menu 83
Baud rate (RS232) 95
Biomass (feed timer) 147
Bulkhead fittings 38

rubber grommets 38
Buzzer menu 84

C

Calibration
calibration menu 76
DO mg/l 80
DO % sat 78
feed timer 149
getting ready to calibrate DO sensor 77
log 77
Sensors
“check probe” 76
temperature sensor 76
Chiller hold off time (temperature control high) 137
Circuit Boards. See PCBs
Clean probe timer 120
Clear Logs 105
Communication hardware wiring 62
Communication menu 84
email alarming 85
email retry delay 95
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Index

Index

ethernet 87
SMS messaging 91

force serial port 96

Network 92

RS232 baud rate 95

send test email 94
Configuration log 102
contactor. See Wiring contactor
Contact Us 216
Control board 41
Control menu 152
Control value 128

D

Daily feedings (Feed Smart timer) 146
Daily weight (Feed Smart timer fcr) 147
Daily weight (Feed Smart timer-non fcr) 146
Data Logging menu
clear logs 105
event log 104
sensor log (data log) 102
Date and Time menu 106
Declaration of conformity 208
Defaults. See Factory defaults
device time out error. See Firmware Updater
DHCP (ethernet menu) 88
Display format (analog aux non temperature) 100
Display Settings menu 107
DNS address (ethernet menu) 90
DO sensor calibration mg/l 80
DO sensor calibration % sat 78
DO sensor setup 139

E

Email addresses (ethernet menu) 90
Email alarming 85

5400 email 85

AguaManager email 85

email retry delay 95

send test email 94
Ethernet menu 87
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DHCP 88

DNS address 90

email addresses 90

gateway 89

IP address 89

port 90

subnet mask 89
Ethernet module

configure communications ethernet menu 87

installation 65
SMS messaging 91
Event logging 104
Event log view 155
Explorer window - AquaManager 162

F

Factory defaults 187
fer (feed timer) 147
Feed Smart Timer
biomass 147
calibrate 149
daily feedings 146
daily weight 147
fer
biomass 147
daily weight 147
fcr factor 148
feed % biomass 147
feed mode
continuous 145
timed 145
sensors 148

DO and temperature low/high % change 149

Firmware Updater
could not find unit error 112
device timed out error 112
force downloader 112
Unit is Up-To-Date message 112

Force serial port (communications menu) 96

Front panel
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Index

keys 68
open 40

run screen 70
softkeys 69

G

Gateway (ethernet menu) 89
General Alarm menu 113
hold off 114
relay 114
Grounding
5400 42
tanks 42

H

Hardware
bulkhead fittings 38
ethernet module 64
installation and wiring chapter 25
lower board assembly 41
PCBs 37

Icons 71
Input type (aux) 97
Installation 26-35. See also Wiring
5400 location considerations 27
Installation and wiring chapter 25
mounting 5400
panel 29
rail 28
surface 28
weather shield 32
qualified installer 12, 21
Sensors
DO 5420 & 5421 galvanic 36
DO 5422 polarographic 35
location considerations 34
temperature 37
system schematic (sample) 26

Index
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I/0 Board 38
accessing 39
IP address (ethernet menu) 89

K

keys. See Front panel

L

Lanyard 31, 39
Lightning and Surge Protection 65
Logs

calibration 77

clear logs 105

configuration log 102

event log 104

sensor log (data log) 102

M

Maintenance
AguaManager database maintenance 177
DC batteries 177
Menus
Calibration 76
DO
mg/l 80
%sat 78
Control 152
Hierarchy 73
Menu maps 187
aux (temperature) sensor setup menu 200
calibration 190
DO sensor setup menu 202
menu map key 188
Msg’s menu 153
Sensor setup 127
Aux
analog 0-1V, 0-5V, 4/20ma 135
temperature 136
DO 139
Service hold menu 156
Submenu screen types
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Index

Index

alpha/numeric 74
numeric 74
pull-down 74
Systems menu 82-121
adjust contrast 82
backlight timer 83
buzzer 84
communication 84
email alarming 85
ethernet 87
network 92
configure aux 96
input type 97
name 97
data logging
clear logs 105
data log (sensor log) 102
event logging 104
date/time 106
display settings 107
general alarm 113
name devices/sensors 115
password 117
serial number 119
service 119
service hold (enable and hold off) 124
version 125
Timers menu
Feed Smart timer 144
Timers 1-4 (10 daily event) 143
Min/max values (analog aux non temperature) 99
mounting 5400. See Installation

N

Name devices/sensors menu 115
Network
node network (master/slave) 92
non-networked 5400s 96
termination relay 94
wiring
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loops 61
stars 61
stub 57, 60

O
“over”. See sensors “over” and “under” values
P

Panel mount 5400 29
Password menu 117
PCBs (printed circuit boards) 37
Port (ethernet menu) 90
Power (wire) 43
AC 44
DC and backup 45
specifications 16
view current power 125
Probes
calibration 76
DO 5420 and 5421 galvanic 36
DO 5422 polarographic DO/temperature 35
locate and install 33
name probe (sensor) system 115
probe (sensor) setup. See Sensor setup menu

R

Rail mount 5400 28
Recycling 217
Relays

relay test 123

wiring 51

wiring a contactor 52

Reset to factory

resetall 121

reset clean probe timer 120

reset sensors 122

reset system(s) 122

reset timers 123
RS232

PC connection 63
rubber grommets. See Bulkhead fittings
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Index

Index

Run Screen 70
run screen icons 71

S

Safety
cautions 23
warnings 21
Sensor (data) log
view 155
Sensor log setup. See Data Logging menu
Sensors
and Feed Smart timer 148
“check probe” 76
guard 36
name 115
“over” and “under” values 128
wire 47
DO sensors 48
temperature sensors 49
Sensor setup menu 127
30 second sensor system hold off 131
aux (non temperature) 132
analog 135
relay 135
digital 133
relay 134
relay 133
aux (temperature) 136
DO 139
set points, controls, alarms 128
Serial number 119
Service hold 156
configure service hold 124
Service menu 119. See also Reset to factory
Set point value 128
SMS messaging 91
SMS messaging formats 213
Softkeys 70
Specifications
environmental 13
inputs
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aux (non temperature) 14
DO 14
temperature 15
systems (non input)
AgquaManager 17
communication 16
ethernet module 16
RS232 16
firmware 16
hardware 15
leds 15
power 16
relays 15
Stub (network wiring) 57, 60
Submenu screen types 74
Subnet mask (ethernet menu) 89
Suffix (analog non temperature) 99
Surface mount 5400 28
Surge and lightning protection 65
Systemwide event 104

T

Technical Support 216
Temperature 136
aux input (configure input type) 101
temperature conversion table Alpha “A” curve 214
Termination relay
and networks 94
and non-networked 5400s 96
Timers 141
clean probe timer 120
daily 10 event timers (4) 143
Feed Smart timer 144
calibrate feeder 149
daily feedings 146
daily weight 147
fcr 147
biomass 147
daily weight 147
feed % biomass 147
feed mode
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Index Index

continuous 145 relay outputs 51
timed 145 sensor 47
sensors 148 DO 48

Troubleshooting 181-187 temperature 49

AquaManager 186
email alarming 183
Feed Smart timer 186
firmware updater 185
network 184

other 5400 systems 185
relays 183

sensors 181

U

“under”. See Sensors “over” and “under” values
Unpacking and inspection 180

\Y

Validation error 130
Version (firmware) 125

W

Warranty 215
Weather shield 32
Wiring 37-59
accessing 1/0 board 39
aux (non temperature) 53
analog instrument 56
digital instrument 56
bulkhead fittings 38
communication equipment 62
ethernet module 64
rs232 63
contactor 52
control board 41
grounding 5400 42
PCBs 37
power 43
AC 44
DC and backup power 45
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